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Chapter - 1 INTRODUCTION 

 

1 Hardware configuration 

Work station  

Operating system  

 Windows Vista, 32 bits 

 Windows 7, 32 bits 

 Windows 7, 64 bits 

 Windows 8, 32 bits 

 Windows 8, 64 bits 

 Windows 10, 32 bits 

 Windows 10, 64 bits 

  

Minimal hardware configuration 

 4 GB of RAM 

 CD-ROM player (only if installation by CD) 

 
200 MB available to install QLEVER (excluding the data 
measured by the loggers) 

 NTFS partition for the TDB QLEVER data management 

 RS232 serial ports for old RS232 TMI-Orion interfaces 

 USB ports for TMI-Orion USB interfaces 

 Screen resolution: 1024 x 768 

  

Server  

Operating system  

 Microsoft Windows server® 

 If LDAP option then Microsoft Windows Active Directory® 

Minimal hardware 
configuration 

 

 Free disk space: 40 GB (No cloud) 
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Work station  

  

2 Installation and update 

Prerequisites: 

• Qlever must have the following access rights to all files located in the Qlever Database Files 
(TDB) folder (Qlever installation folder named Qlever files): read, write, modify and delete. 
 
• The same access rights must be granted to the Microsoft Windows ™ user's local 
temporary directory. 

2.1 First installation 

1. If you are using a USB type TMI-Orion Interface, you should install the drivers 
prior to using QLEVER software so the communication ports are later set up 
automatically. 

2. Insert the supplied the USB drive (or the CD-ROM containing QLEVER software). 

▪ open the CD-ROM folder. 

▪ double click on the “setup – QLEVER x.x.x.x.exe” file (“x.x.x.x” the 
version number of the software). Same procedure in case you 
downloaded the software through the internet. 

3. Select the language. 

4. Click “Next”. 

5. Read the software license contract. If you agree with the terms, check the box 
“I understand and I accept the terms of the license contract” then click “Next”. 

6. If you want to change the folder where the software will be installed, click 
“Browse” and select the target folder then click “Next”. 

7. Check the box to create a tab on your “Desktop” and/or in the “Fast launching” 
bar then click “Next”. 

8. Click “Install” to start installing the software. 

9. Click “Finish”, the software will run. 

10. Set the directories used by the software (cf. 1.2 Directories Management).  

11. For a first install, type your QLEVER license key and validate. 

12. If your version of QLEVER includes the Secure mode (FDA 21CFR part 11 
compliance), you should set the Administrator account and create at least one 
User account. Then log out from the Administrator account and log onto the 
newly created User account. 
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13. Add the configuration files of the loggers (cf. 2.1 CET/CEX configurations files 
installation). 

14. Set the units (cf. 1.5 Units). 

15. Set the communication ports (cf. 1.3 Communication ports). 
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2.2 Update 
 

1. Double click on the “setup – QLEVER x.x.x.x.exe” file (“x.x.x.x” the version 
number of the software). Same procedure in case you downloaded the 
software through the internet. 

2. Select the language. 

3. Click “Next”. 

4. Read the software license contract. If you agree with the terms, check the box 
“I understand and I accept the terms of the license contract” then click “Next”. 

5. Do not change the folder where the software will be installed, click “Next”.  

6. Check the box to create a tab on your “Desktop” and/or in the “Fast launching” 
bar then click “Next”. 

7. Click “Install” to start installing the software. 

8. Click “Finish”, the software will run. 

3 QLEVER and QLEVER Lite 

There are two versions of QLEVER: 
  

· QLEVER Lite: 

o List of the functions that are not available with the QLEVER Lite version: 

• Merge the open files 

• Merge the table of the current file 

• Data analysis (like Min. / Max. / Avg. & slope calculations)  

• Library of calculations and automatic calculations 

• From the reading loggers window, creating a single files and the 
merge of the tables of the current file. 

• Use of the Multi-logger interface (only the MONO-USB is 
visible, no Radio, no FullRadio, no wired real time) 

• 21CFR or other options. 

· QLEVER: 

• This version allows every functions and options according to 
the license you get. 
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4 Quick Start Guide 

1. Connect the interface to the computer. 

2. Connect a logger to the interface. 

3. Select the “Configuration > Communication ports configuration” menu. 

4. In the tab “Wired communication”, select the port where the interface has been 
installed. 

5. Save to close the window. 

6. Open the “Configuration > Managing configuration file” menu. 

7. Insert the USB drive or the CD-ROM containing the logger configuration files. 

8. Click on “Install”, click on “Install from TMI-Orion USB drive” or “Install from CD”. 

9. Close the window. 

10. Click on “Identification” from the tool bar. 

11. This window displays information from the connected logger including status and the 
real time reading. 

12. Close the window. 

13. Click “program” from the tool bar. 

14. A default programming will allow you to program the logger for one minute with one 
acquisition every second. 

15. Click “program”, close the window giving you the programming status then close the 
window. 

16. Click on “Start”. 

17. Click “Start all the loggers”. Close the window giving the starting status then close the 
window. 

18. By default, the logger would start recording straightaway. 

19. Wait for at least one minute before the logger has finished recording. 

20. Click on “read again” from the tool bar. 

21. Make sure that “save separately the data of each logger” and “automatically open 
the created files” are checked then click on “read the selection again”. 

22. Close the window giving the reading status. 

23. The file containing all data is now automatically open. 
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Chapter - 2 Standard features  

1 Software configuration 

1.1 Languages 

It is possible to change the language of the software in the menu “? > Languages” or by clicking 
on the language currently used in the software message bar. 

Just click on the desired language from the list. 

1.2 Directories Management 

The software uses different directories to work. These directories can be set by clicking on 
“Configuration > directory management”. 

The software would use two types of data systems: 

1.2.1 QLEVER Data Management System: TMI Data Base (TDB) 

This is a secured database managed by the software called TMI Data Base (TDB). It is used by 
default when creating and opening recordings. It is possible to create up to 10 different TDB’s. 

1.2.2 TDB Directory 

The Directory management TDB tab allows you to set the directories where: 

• Configuration files will be installed. 

• Data from the loggers will be saved by default. 

• The setup, process and report will be saved. 

• User’s accounts will be saved. 

Remove a TDB: 

• Exit Qlever 

• Delete (or rename) the unwanted TDB directory by Microsoft Windows™ 

• Run Qlever 

 C:\ProgramData\tdb\ is the TDB default directory 

 The user must have Microsoft Windows rights on this folder 

 Please, don’t synchronize the TDB directory!  
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1.2.3 External files 

It is also possible to save or read recorded data to or from files not belonging to the TDB. 
Meaning, save or read to or from a USB drive or any other drive. 

The External file tab allows you to set the directories where:  

• Configuration files will be installed or exported (cet, cetx files). 

•  Data from the loggers will be saved to external files (qle files). 

The user must have Microsoft Windows rights on these folders. 

 

1.2.4 TDB Administration 

• See section 6 Administration, Backup and Restore of the entire TDB database. 

• “Save the QLE file” for a compatibility with TMI Xvacq, Valivac Software 

1.3 Communication ports 

In order to communicate with the loggers, you should set the communication port where the 
communication interface is installed. 

To access the settings, you should select “Configuration > Communication ports 
configuration”: 

• Interface management: the table from the first tab allows you to select the ports 
where the communication interfaces are connected. 

• Real time communication: the table from the second tab allows you to select the ports 
where the radio receiver antennas are connected. 

o “Not configured”: means that you must add and configure this radio receptor 
in “Radio network configuration” (“Configuration” menu and “Radio 
Network”).  

If you connect an interface on a USB port only after opening such window, you would need to 
click on “Communication ports update” to refresh the screen and see this interface in the list. 

FullRadio: 

• Before using FullRadio loggers, one radio receiver should be installed and 
selected as a communication interface in Interface management tab. 

• Before using FullRadio loggers in real time communication, one radio receiver 
should be installed and selected as a real time communication interface and 
configure in “Radio Network” menu. 

Display All: display all ports and calibration Jofra® equipment (display only) 

The metrology equipment must not be checked because it’s not TMI-ORION interface. 
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1.4 Radio network configuration (Fullradio) 

1.4.1 Pre requisite 

• Communication ports selection including at least one radio receiver selected 
as an interface 

• FullRadio loggers configuration files installation 

The installation generates an automatic configuration for your Radio Network, but some 
parameters can be changed by clicking on “Configuration” menu and “Radio Network”.  

Radio network tab 

A radio network includes several loggers with the same radio transmission settings for real 
time data reception. 

▪ The left part of the screen shows the status of the configured items, each network is 
composed of: 

o An editable name, e.g. “Autoclave 1” 

o One or several Radio receiver(s) (one dedicated to each computer) 

o One or several FullRadio logger(s) 

o A configuration including a radio transmission channel, an address and a 
PanID, to avoid possible radio interference between various networks or radio 
devices in your premises. 

▪ The right part of the screen shows the hardware to be configured. 

▪ COM “Not used”: means that Port COM has not been checked in "Communication 
Port Management" / "Real Time Communication". In this case, go to this screen to 
check if you want to use it to receive the data in real time. 

Add a receiver or a logger: click on the “<” button or drag-and-drop on the selected network. 

Delete a network, a receiver or a logger: click on “–” in the first left column. 

Create a new radio network: click on “New network” (you can create up to 100 different 
networks). 

Configuration tab 

• Automatic search of FullRadio loggers (standard mode only) (cf. 1.4.2 Fullradio 
logger menu). 

• Automatic search of FullRadio loggers (setup mode only) (cf. 1.4.2 Fullradio 
logger menu). 

• Read running loggers (cf. 2.5 Read the loggers). 

 
Remove all FullRadio loggers: remove all current Fullradio loggers. 
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Save the modifications: click on “Save”. 

 Do not mistake the radio network configuration for the list of the loggers you will use. 

1.4.2 Fullradio logger menu 

FullRadio loggers are loggers designed with a “wireless” radio transmission and reception. 
As with traditional Radio loggers, real time data transmission may be activated according to 
the selected programming.  

Some FullRadio logger setting menus can be found in every logger management screen (right 
click). 

• Configure a Radio Network for FullRadio loggers 

o Network configuration [cf. 1.4 Radio network configuration (Fullradio)]. 

• Configure the FullRadio loggers beep emission. 

o The radio receiver will -or will not- beep during radio transmission.  

• Automatic search of FullRadio loggers  

o The automatic search mode is the default mode. It enables the automatic 
communication with every selected logger.  

Yet a non-automatic search mode may be recommended for numerous 
FullRadio loggers use: it would prevent you from waiting until all loggers 
are detected to add, delete or modify their configuration. 

“+” and “–” columns are displayed on the right side of every FullRadio logger management 

list.  

• Click on “+” button to reach the FullRadio loggers list (sorted by network 

name), add a FullRadio logger and start to communicate.  

• Click on “–” button to delete a FullRadio logger from the list and stop the 

communication. 

Those menus will not appear if neither Radio reception interface nor FullRadio logger has 
been installed. 

1.5 Units 

This software allows you to set the display of the physical parameters (temperature, 
pressure…) in terms of units. 

To access the unit’s settings, select the “Configuration > Unit management” menu. 

A list would let you to select the right unit for each physical parameter. 
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1.6 Library of calculation 

This software allows you to set automatic calculations (cf. 3.3.4 Calculated columns) that apply 
automatically when loggers are read (except in setup mode). 

To reach the library of calculation settings, select the “Configuration > Library of calculation” 
menu. 

In the calculation list: 

• Check the box to apply the calculation to the next reading operation. 

• Name and number of the calculation. 

• Calculation type (Offset, F0…). 

• Calculation settings. 

• Other fields: Created by, on, Modified by, on. 

You can Delete, Add or modify a calculation, it’s also possible to add a calculation from each 
calculated column. 

 

1.7 User preferences 

Files: 

▪ When an external file is opened, ask whether it should be imported: each time an 
external file is opened (e.g. on E:\mes_qle), QLEVER asks whether it should be 

imported (in TDB) or not. 

▪ Display the preview in the file manager: if unchecked, the TDB response time is 
optimized because the graph previews are not loaded in QLEVER file manager. 

Interface & loggers: 

▪ Display the interface serial number (checked as default): uncheck this box if interface 
serial number display is not required. It will be removed from On-Screen 
Information. 

▪ Display: “Programming will erase the memory of the logger” (checked as default): 
allow to display or not such message when programming loggers with the standard 
mode or starting (and programming) a setup with the setup mode). 

▪ Starting loggers: 

o Display the channel value (checked as default): display the value of each 
connected loggers in the “Starting loggers” windows (also shows the type of 
thermocouple for the universal thermocouple logger). 

o Battery status (default is unchecked): The lowest battery voltage recorded 
when using the logger (and not only since the start of the last recording). 
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o Memory status:  

▪ Memory used: This window displays the memory level already used 
by the logger.  

▪ The memory level used for this programming. 

Some options will not be possible if “Automatic search of FullRadio loggers” 
is deactivated. 

Parameters: 

• Date format (default is automatic): 

• Automatic: according to the language. 

• Day/mouth/year format. 

• Mouth/day/year format. 

• Year/day/mouth format. 

 

 

 

2 Logger management 

2.1 CET/CETX Configuration files installation 

To be able to use a logger, the corresponding configuration file needs to be installed in the 
software. This installation is done by copying the corresponding CET or CETX extension file in 
the TDB directory. 

To access the configuration files installation, select the “Configuration > Configuration files 
management” menu. 

From the list, for every logger the following information would be displayed: 

• The serial number  

• The configuration CET or CETX file version 

• If it’s a FullRadio logger or not 

• The configuration date (calibration date) 

• An information symbol shows the validity of the date of every configuration file. 

• The status of the configuration files as follows: 

• Imported: following installation of configuration files within the TDB 

• Restored: following the restore of configuration files within the TDB 
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• Adjusted: following the adjustment of logger using QLEVER with calibration mode 
(display in green) 

• The user who and the date when one of the three above actions was performed. 

 

Installation of configuration files: 

If the CET / CETX configuration files are: 

o On the TMI-Orion USB drive, click on “Install” button, choose the “Install from 
TMI-Orion USB drive” menu to directly install files contained on the drive. 

o On the TMI-ORION CD, click on “Install” button, choose the “Install from 
folder” menu to select to the Window explorer any files located on the PC. 

o On a folder, click “Install from a folder” button allow to select a directory 
located on the PC. 

The “Delete” button allows you to delete files corresponding to the lines selected in the chart. 

The “Export” button allows you to export the selected configuration files from the TDB to any 
directory of the PC or external drive. 

Right click on one or more loggers to view the history of the logger recorded in the TBD 
database. 

Once the FullRadio loggers are installed, the radio network configuration window is 
displayed to enable the network configuration for real time data reception. 

 The default directory can be specified by the “Configuration, Directory management” 
Menu. 

 Note that with the Secure mode (21 CFR part 11), only an “Approval” account would be 
allowed to manage the configuration files. 

 

2.1.1 Updating a CET/CETX Configuration file in a logger 

• Connect the logger (only this logger) to the interface 

• Click on “Configuration/managing configuration files” menu 

• Click on “Install from a folder” button, select the import directory, and select the 
cet file 

• Select the cet line 

• Click on “Restore” button 

• Select the imported cet 

• Click on “Restore” button 

• Click on “Apply” button 
 

 Note that with the Secure mode (21 CFR part 11), only an “Approval” account would be 
allowed to manage the configuration files. 
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2.1.2 Installation of coefficients files for universal thermocouples 

To access the configuration files installation, select the “Configuration > Configuration files 
management” menu. 

• Click on “Install from a folder” button, select the import directory, and select the 
file .qcfgcoeff 

 

2.1.3 Installation of cfgcet configuration files for the calibration 
expert mode 

To access the configuration files installation, select the “Configuration > Configuration files 
management” menu. 

• Click on “Install from a folder” button, select the import directory, and select the 
file .cfgcet 
 

 

2.2 Hardware identification 

2.2.1 Prerequisite 

• Communication ports selection 

• Configuration files installation 

 

With the version QLEVER Lite only MONO-USB interfaces are visible. 

2.2.2 Description 

If you want to know the status of the loggers or interfaces connected to the PC, use the 
“Identification” window. 

To access this screen, click on “Identification” button from the software tool bar 

The “Menu” button allows you to access a menu to: 

•  See the logger history 

• Change the used serial port 

•  Search the connected loggers 

•  Modify a Radio Network for FullRadio loggers 

•  Configure RF Receiver beep for FullRadio loggers 
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• For all selected loggers: 

o Erase memory 

o Battery replacement 

• Select all logger (CTRL-A) 

 

The upper part of the window displays the serial ports used, connected interfaces and loggers. 
By clicking on a logger from this list, the lower part of the window is refreshed with the 
following information:  

1. Identity: This window gives information on the logger electronic part. The “Stop” button 
stops the logger if it was working. 

2. Channels (s): This window gives real time values of the selected loggers. A visual 
indicator shows if the display is in real time or stopped. 

3. Memory status: This window displays the memory level already used by the logger. The 
“erase memory” button erases all data stored in memory (or right click for all selected 
loggers). 

4. Battery status: This window displays statistics on the battery: 

• Real time voltage 

• The lowest battery voltage recorded 

• The minimum voltage value where the battery stops working until we replace 
it 

• If the battery pack needs to be replaced, first replace the battery pack inside 
the logger then click on “replace battery” button to reset all information back 
to zero (or right click for all selected loggers). 

• The elapsed battery life time (since the last replace battery). 

5. Configuration: This window shows the configuration file status. If the file is not installed, 
then just click on “install file” button to install it. 

2.3 Program the loggers 

2.3.1 Prerequisite 

•  Ports selection 

•  Configuration files installation 

2.3.2 Description 

To record data, the loggers need to be programmed first. 
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To access the programming screen, click on “Program” button from the tool bar. 

The upper part displays the existing programs and allows you to create new ones or to 
modify them. 

Once you have selected the right program for each logger click on “Program” button to 
program the loggers. 

The lower part of the screen displays information about the connected logger: 

• Check whether the logger configuration file was installed. 

• Status of the logger, stop or recording. 

• Battery status. 

• The different options of the logger 

• The selected program for the logger. This can be different for each logger.  

• The memory level used for this programming. 

• “+” and “–” allow to add or remove a Fullradio logger 

Remarks: 

• When programming a logger, all data previously recorded are erased from the memory. 
The display (or not) of the warning message can be configured from the user 
preferences. 

• Programming a logger does not mean you have started it. This is an additional step.  

2.3.3 Create a new programming 

To create a new program, click “Add programming” button. 

The open window shows two tabs 

“Programming” tab 

Type a name for the new program and check the options you would like to use for 
this program. Of course, such options are only possible when the logger includes 
them in the hardware. 

Depending on your loggers you will be able to use the following options: 

• Start on threshold: This option allows you to select a minimum 
temperature value before the recording starts. In this case the logger 
uses its first sampling rate to check if this temperature has been 
reached. 

• Stop on threshold: This option allows you to select a temperature value 
before the recording starts. In this case the logger uses its first sampling 
rate to check if this temperature has been reached. 

• Radio mode (only available for the radio loggers): The logger can emit 
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data through the radio, only record the data in the memory, or do both. 
It is also possible to select a temperature threshold. The logger would 
only emit above such temperature 

• Maximum acquisition frequency: According to their feature, some 
loggers have a frequency feature up to 4, 10 or 64 acquisitions per 
second (default frequency: 1 acquisition per second). You may select 
this option by checking the required mode. 

• Rotating memory: Some loggers can be programmed with a 
programming which requires more memory capacity than the one set in 
the logger. In this case, when the logger reaches the maximum capacity 
of its memory, it erases the first data and continues recording. 

• Rotation: This option must be checked when using a rotation logger 
and doesn’t take in consideration the other options. 

 

“Description” tab 

You can add a description and check the account(s) used for the creation or 
modification of the program including dates. 

 

Then click on “Validate” button. 

A new line appears in the programming table with the name you gave for this program. By 
clicking on the tab at the end of the line you can modify the parameters of the program. This 
can also be done by clicking on the “Modify” button on the right part of the window. 

“Save as…” button save the selected programming to a copy. 

Under the programming line, an extra line is automatically added. The figures with the light 
blue colored background show the required duration. The figures with the light yellow colored 
background show the acquisition rate. Just click on the line for modification. 

By clicking on the “+” and “–” tabs at the end of the line, you can add and remove a sequence 

for the program. The number of sequences depends on the loggers and the selected options. 

You can also set all the loggers with such program with a right click and selecting “apply the 
programming to all the loggers”. 

Besides such program can be automatically set by default by opening this window, do a right 
click and select “define as programming by default”. 

2.4 Start the loggers 

2.4.1 Prerequisite 

• Ports selection 
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• Files configuration installation 

• Loggers programmed 

2.4.2 Description 

The logger must first be started to begin recording. 

To access the window that allows you to start the loggers click on “Start” button from the tool 
bar. 

The table shows the connected loggers and interfaces as well as the status of all the loggers. 

It’s possible to display (see User preferences): 

• The channel values  

• The thermocouple type (only if universal thermocouple) 

• Battery information 

• Memory information 

 

In order to modify the time and date for a specific logger to start, click on the “Start” column 
in the corresponding line for the specific logger. 

In order to modify the time and date for all loggers to start, use the box below. 

Once the time and date for the logger(s) to start are set, click on “Start all loggers”. The loggers 
status is then modified from Stopped to Recording status. 

Remark: 

Some loggers can store several recordings in memory. To clear the memory, you have to 
program the logger and not only start it. You could also use the “Erase Memory” function from 
the “Identification” window or check “Erase the memory before starting”. 

2.5 Read the loggers 

2.5.1 Prerequisite 

• Ports selection 

• Configuration files installation 

• Loggers starting 

2.5.2 Description 

To select the window for downloading the data recorded by the logger click on “Read” from 
the software tool bar. 
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The table shows the loggers and the interfaces connected to your computer. For each 
connected logger you see the list of the recordings. 

You can modify the directory within the TDB and file name in which the recording will be 
saved, by clicking on the tab located at the end of the “Save under…” column on the line of a 
specific logger. 

If more than one logger is connected and/or if the loggers contain more than one recording, 
you can decide to create a single file merging data of several recordings and/or several 
loggers. To do so you must select one or more recordings from the table, then do a right-click 
and choose “add the selected recordings to the single file. A small tab will appear at the 
beginning of the selected lines. You must then check “create a single file with the recordings 
preceded by the symbol”.  

This feature is not available with the Version QLEVER Lite. 

Only the selected lines will be read. To select more lines, just press the “CTRL” key from the 
keyboard then click on the required recordings. 

If you wish to read everything, it is also possible to press the “CTRL + A” keys from the 
keyboard or right click, menu, “Select all”. All the recordings will then be selected. 

If some FullRadio loggers are running, a selection window will open and allow you to load 
the available running loggers list. You can deactivate this functionality in “Radio network” 
windows. If you don’t read some FullRadio loggers, they will automatically be excluded from 
the data file. 

Apply automatic calculations: this software allows you to set automatic calculations (cf. 
3.3.4 Calculated columns) that apply automatically when loggers are read (except in setup 
mode). To reach the library of calculation settings, click on “Calculator” button select the 
“Configuration > Library of calculation” menu. 
 This function is not available in Setup mode and calibration mode. 

Once you have completed your selection, click the “Read” button. 

 

2.6 Loggers History 

QLEVER records the different operations performed on every logger. 

This history is accessible by right clicking on the name of the logger from: 

• a data file QLE (except on old QLEVER 1.x files) 

• the identification screen of the material 

• the installation screen of the configuration files. 

 

The history of the loggers is shown as a chart with several columns: 

• Command type: programmed, started, read, process… 
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o For the replace battery, the old values are displayed 

• Date 

• Performed by 

• Command description 

• Symbol 

• Software Version 

2.7 Universal thermocouples configuration 

Prerequisites: 

• Only universal thermocouple logger can be configured. 

Description: 

Each channel of a universal thermocouple logger can be configured with these types:  
B, E, J, K, N, R, T or S. 

Thermocouples configuration are templates to be applied to configure the connection of the 
logger. 

Click on “Logger” menu, “Thermocouples configuration”, or right click on a logger in 
“Managing configuration files” screen. 

 

Displayed for each channel: 

• Channel number and thermocouple. 

• Min and max temperature: measurable temperature range by the chosen 
thermocouple. 

• Gain and resistor values are logger technical information’s. 

 

Create a new thermocouple configuration: 

• Select the logger. 

• For each channel, choose the type of thermocouple. 

• Click on “Save as” to record the configuration as a new configuration. 

• The new configuration is displayed in the list of available configurations. 

 

Modify an existing thermocouple configuration: 

• Select the logger. 

• Select a configuration in the list. 
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• Click on “Apply”. 

• Modify the type of thermocouple of the logger channels 

• Click on: 

o “Save” to record the configuration. 

o “Save as” to record the configuration as a new configuration 

• Click on “Configure” of update the logger. 
 

Choose the same thermocouple’s type at all channels: 

• Select “Apply to all” on a logger channel. 

 

Modify the configuration name: 

• Select a configuration in the list. 

• Click on  to rename the configuration 

 

Delete a configuration: 

• Select a configuration in the list. 

• Click on “–” to remove the selected configuration. 

 

Configure the logger with a thermocouple configuration: 

• Select the logger. 

• Select a thermocouple configuration. 

• Click on “Configure”. 

• Connect the logger (except FullRadio logger). 

• The Configuration screen will update the logger with a new cetx configuration files. 
 The configuration date will be updated. 

• Click on “Configure”. 

• You can connect the thermocouples 

 
Important: 

 “Configure” reset only the adjustment of all THn channels, not the adjustment of the 
internal channels. 

 “Configure” replace the current cetx configuration file (date updated). 

 You can restore an old cetx configuration file, see “Managing configuration files 
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installation” screen. 

 The thermocouple type is saved in the cetx configuration files on each universal 
thermocouple logger. 

 You can display the configured thermocouple type in the “Starting logger” screen 
(see User preferences”. 

 The displayed value is only valid if a thermocouple is not connected. 

 21CFR: Approval and operator can use all functionalities. 

2.8 Timestamp 

 

This window, accessible from Qlever's "Windows" menu, "Timestamp", is used to record 
events that occurs while recording data. For example, the recording of the opening date of 
the door of an equipment in the calculation of the recovery time (see Mapping). 

Advantages: 

• Avoid having to write time on paper. 

• Benefit from the accuracy and accuracy of the time (in relation to that of the 
recorders). 

• Ability to retrieve these timestamps easily and without error from the QLE data file 
(after replay) by clicking on the "date selection" icon to the right of the date in the 
zone dates, dates of the cycles, dates in the setup, ... 

These timestamps are recorded in a file common to all Qlever users: 

• ID: unique identifier of the event. 

• Date and time of the event. 

• Description of the event. 

• “-“ : deleting the selected line in the table 

• Right-click to access a menu of features: 

o Delete All: removes all timestamps from the list. 

o Add: add a new date and time 

o Refresh: refreshes the list of timestamps. 

 

Entering a new timestamp: 
1. If necessary, fill in the description. 

o +1 is used to give a number that is incremented in the description. 

o -1 the opposite. 
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2. Click this button to save a new timestamp (or Enter key). 
 

Settings: 
• Always visible: allows you to keep this window on top of others. 

• Time: QLEVER timestamp measurement can be done: 

o By reading the system clock of the PC. 

o By reading a clock on USB (which brings a better accuracy and a better stability 
because the clock of some PC fluctuates or is resynchronize their clock by the 
network if they are on-line). 
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3 QLE data files 

3.1 QLE Files Management 

The data files created by the QLEVER software include a QLE extension name. 

They are created when the memory of a logger is downloaded or when opening a file earlier 
created with xVACQ software. 

In order to open one or more QLE file located in the TDB, go to “File > open” menu. 

In order to open one or more external QLE file, go to “File > open an external file” menu. 

Besides it is easy to open recent files, just go to “File > Recent file” menu. 

3.2 Data display 

3.2.1 Description 

The window that shows the recorded data within a QLE file consist of three parts. 

1. The top part with different tabs shows:  

• Table with data.  

• Data analysis. 

• Screenshots. 

• Also some specific tabs related to options of the software. 

2. The lower left part with different tabs shows: 

• The graph legend. 

• Zones or cycles. 

3. The lower right part shows the graph. 

3.2.2 Numerical data, analysis… 

3.2.2.1 Data 

The top part shows the data within a table. 

The first two columns show the acquisition date and time, while the next columns show the 
logger values. The title of the column shows the channel number together with the unit. To 
obtain more information just move the mouse over the title of one of the columns to obtain 
the logger serial number and the channel number. You can also find the channel number in 
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the legend and obtain the same information. It is possible to hide the column by clicking on 
the title of the associated column. 

A click on the header of the column of the data would allow you to: 

• Thick: get the line of the curve and the data column thicker 

• Hide: hide the curve of the graph (the data are shaded but will still be used within the 
calculations) 

• Hide all but me: Hide all curves but the selected curve (the data are shaded but will 
still be used within the calculations) 

• Exclude: exclude the channel (the data will not be used in the calculations). Click the 
legend to include the channel again. 

• Modify the color of the curve 

• Configuration: 

o Graphic:  

▪ Set the gridlines for the X & Y axis as well as the color for the 
background of the graph. 

o Personalize curves, set quickly: 

▪ Color 

▪ Exclude/include 

▪ Hide quickly curves  

▪ Thick 

o Data: 

▪ Hide the Date column (for small screen) 

 

When selecting a line form, the table, a vertical reference line mark will be displayed on the 
graph at the same exact sample date. You can then move this reference line mark by moving 
within the table pressing the “↑” and “↓” keys. 

When using the scroll bars on every table, the following information displays: 

• The number of the first visible line in the table. 

• The number of the last visible line in the table. 

• The total number of lines in the table. 

When using right click on a date/hour: 

•  Adding a zone (see Zone) 

•  Selection of a begin/end date for adding quickly a zone for a calculation 
(see Min/Max/Avg) or for defining quickly cycle of the setup mode. 

o CTRL + Click: select automatically the date + hour 
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o CTRL + D: deselect the two dates 

• Zoom 

• Configuration (see Configuration) 

 Values windows allow to show more information. 

3.2.2.2 Data analysis 

Within the main tab statistics, analysis and calculations can be displayed. 

This feature is not available with the Version QLEVER Lite. 

3.2.2.2.1 Min/Max/Avg 

The first tab allows you to make “minimum, maximum and average” type statistics within a 
specific area of the graph. 

A table will show for each selected channel (depending on the setting): 

•  The minimum value with the date/time when this was reached. 

•  The maximum value with the date/time when this was reached. 

•  The average value. 

•  The standard deviation. 

• The maximum – minimum variation 

 

For each unit (depending on the setting): 

• Min. value 

• Max. value 

• The max. range 

• The mean of mean 

• The minimum of the maximum values with the date/time when this was 
reached. 

• The homogeneity or Max. spread in setup mode only 

 

For only one unit (depending on the setting): 

 Time above / Time Below: 

o The time above a threshold with total time, min., max. time above and 
occurrence (number of times the threshold has been > threshold) 

o The time below a threshold with total time, min., max. time below and 
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occurrence (number of times the threshold has been < threshold) 

▪ Comparison operator used: 

• Time above > threshold 

• Time below < threshold 

• This calculation is with data linearization. 

 

For F0/A0/C0/P0: 

• Display or not the F0/A0/C0/P0 formula parameters (default=Yes) 

 

Legend: 

M = max. value, m = min. value for average. 

Red = maxi value, blue = mini value. 

When using the Setup mode, those results would be displayed for every stage of the cycles, if 
calculations or zones are displayed in blue, it means that the dates have been changed 
manually from setup “Cycles” windows. 

This feature is not available with the Version QLEVER Lite. 

3.2.2.2.2 Slope calculation  

The second tab allows you to calculate the slope.  

A table will show for each selected channel: 

• The slope 

• The squared correlation coefficient 

• Slope duration 

• Start and end of date/time for the slope 

Other tabs can also appear according to the options installed with the software. 

When using the Setup mode, the results will be displayed for every stage of cycle. 

This feature is not available with the Version QLEVER Lite. 

3.2.2.3 Screenshots 

This tab allows you to manage the various screen shots made from the graph. 

For each picture, it is possible to: 

• Remove the picture 

• Display and modify its name and add comment or print. 
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• Export as a JPG file. 

• Copy to clipboard. 

• Print this screen shot in the report or not in setup mode. 

In reports, screenshots will be printed according to the capture date (only for 
new captures). 

• The background color of the graph can be configured in the "Configuration" 
screen (right click on the graph). 

3.2.3 Legend, scales and zones/cycles 

The lower left part shows with two tabs the graph legend. The first tab with the description of 
the curves, and a second tab with the description of the zones or cycles. 

3.2.3.1 Legend and scales 

• Graph legend. 

The Legend tab displays the curves legend. 

The display is in the form of a hierarchical tree. The hierarchy starts with the logger serial 
number, the channel number and for every channel the minimum, the maximum and the 
average values within the current zoom of the graph.  
F0, A0… don’t display average. 

 

A click on the specified number in the legend would allow you to: 

• Thick: get the line of the curve and the data column thicker 

• Hide: hide the curve of the graph (the data are shaded but will still be used within the 
calculations) 

• Hide all but me: Hide all curves but the selected curve (the data are shaded but will 
still be used within the calculations) 

• Exclude: exclude the channel (the data will not be used in the calculations). Click the 
legend to include the channel again. 

• Modify the color of the curve 

• Configuration:  

o Graphic:  

▪ Set the gridlines for the X & Y axis as well as the color for the 
background of the graph 

o Personalize curves, set quickly: 

▪ Color 
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▪ Exclude/include 

▪ Hide quickly curves  

▪ Thick 

o Data: 

▪ Hide the Date column (for small screen) 

 

Keyboard shortcuts in the configuration window: 

 

Key Action 

F2 Keep temperature channels and hide other channels 

F3 Keep pressure channels and hide other channels 

F4 Hide all calculated channels to keep only the channels logger 

F5 Do not hide curve 

F6 Hide all curves 

F7 Reverse selection curves hidden 

F9 Keep calculated channels and hide the others 

ENTER Validate 

ESC Cancel 

 

• Logger History 

To check the history of the logger, right click on the name of the logger to obtain a 
complete description of the programming used to create the data and other information 
on the start, read… (cf. 2.6 Loggers History). 

 

• Graph scales 

Under the information tab (or Cycle tab when using the Setup mode), a table shows 
the current graph scales. It is possible to edit these values. 

3.2.3.2 Zones 

The same Information tab also displays the zones created from the graph. A table shows 
different columns: 

•  1st column with a box to check to show or hide the zone. 

•  2nd column with the zone color. 
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•  3rd column is a graphic icon. 

• 4th column includes zone name and more information. 

• 5th column where you click to edit the zone. 

• 6th column allows an automatic zoom on the zone by left clicking for a 10 % wider 
zoom or right clicking for a normal zoom. Available statistics in “Legend” tab can 
be read very quickly. The zoom results are different according to the zone type 
(marker, straight line, etc...).  

 

To create a zone, just click on the zone button or just click the “+” button. A menu will 

appear with different types of zone that can be created or right click on the graph 

To remove a zone just select a zone from the table and click on “–” button. 

When using the Setup mode, the stages of the cycles would be displayed in the same table. 

3.2.4 The graph 

The lower right part of the window shows the graph from the record. 

Below the curve(s) you will find the horizontal time axis and on both vertical sides the physical 
measurement axis. 

On the left graph a tool bar to browse the graph: 

 

Icon Action 

 Cursor mode 

 

Displays information on the selected curves  

Allows to display a cursor and to select the corresponding line of the data table 

Allows to show a contextual menu to create zones on the graph 

 Zoom by selection 

 

To zoom, it is necessary to do a hold on left click on the graph and to move the 
mouse. A selection box appears and it is then possible to make a zoom on the 
selected area. 

To cancel the zoom, do a right click on the graph. 

 Progressive move 

 
Hold on left click on a specific location within the graph a zoom in. 

Hold on right click on a specific location within the graph and zoom out. 

 Graph move 
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Icon Action 

 To move the graph just hold on the left click and move the mouse. 

 Auto scaling 

 
By clicking on this button, the graph is displayed again but using the full scales for 
the showed physical parameters within the visible zone. 

 Zoom reset 

 Restore initial zoom 

 Undo zoom 

 Undo last change zoom 

 Redo zoom 

 Restore the previous zoom 

 Zone button 

 Add fixed marks on the graph 

 Screenshot 

 
By clicking on this button you create a screenshot of the graph which will be saved 
in the “screenshots” tab. 

 Fullscreen/windowed mode 

 
By clicking on this button, the software changes to full screen mode. Click again to 
come back to windowed mode. 

 

Keyboard/mouse Short key Action 

Wheel mouse on the graph Zoom 

CTRL + Wheel mouse on the graph Zoom 

SHIFT + Wheel mouse on the graph Horizontal Move 

CTRL  + SHIFT + Wheel mouse on 
the graph 

Vertical Move 

Press whell mouse on the graph Move 

Space key Graph move Mode 

 Key Move 

Mouse Right click Contextual menu 
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3.3 Data files managements 

3.3.1 Zone creation 

It is possible to create zones from the graph. The purpose is to highlight some areas of the 
graph. Zones are also used to show results of calculations and statistics made from specific 
areas of the graph. 

To create a zone just click on the “zone” tab of the open file then clicks on “+” button under 

the tablet or do a right click on the graph. A contextual menu opens and allows selection of 
the type of zone type to be created. 

 Horizontal zone 

This would be a zone parallel to the time axis and with two physical values as boundaries. It is 
defined by: 

• A name. 

• A physical parameter (Temperature, pressure, …). 

• A minimum and maximum value (as default corresponding to the min. and max. 
values from the current zoom). 

• A color and a hatching style. 

 Vertical zone 

This would be a zone perpendicular to the time axis with two dates as boundaries. It is defined 
by: 

• A name. 

• A start and end dates (as default corresponding to the min. and max. values 
from the current zoom). 

• A color and a hatching style. 

 Rectangular zone 

This would be a zone like a box with two physical values and two dates as boundaries. It is 
defined by: 

• A name. 

• A physical parameter (Temperature, pressure…). 

• A minimum and maximum value (as default corresponding to the min. and 
max. values from the current zoom). 

• A minimum and maximum date (as default corresponding to the min. and 
max. values from the current zoom). 

• A color and a hatching style. 

 Vertical reference mark 
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This would be a vertical line plotted on a specific date. It is defined: 

• A name. 

• A date (as default the date under the mouse click). 

• A color. 

 Horizontal reference mark on a physical value 

This would be a horizontal line plotted on a specific physical value. It is defined by: 

• A name. 

• A physical parameter (Temperature, pressure…). 

• A value (as default the value under the mouse click) 

 

 Marker on a physical value 

This would be a maker on a specific physical value. It is defined by: 

• A name. 

• A location name from the icon  

• A physical parameter (Temperature, pressure…). 

• A value (as default the value under the mouse click) 

• An Icon 

If a channel is thickened, then this channel will be taken into account when later a 
marker will be created. 

 

 The date and time created from the “Timestamp” window are available by clicking on the 
"selection" icon to the right of the date. 

3.3.2 Min./Max./Avg Calculation 

To create or modify a calculation of “Min./Max./Avg” type select the “Data Analysis” tab from 
the open file, then select the “Min./Max./Avg” tab. 

 : Click on button. A window will appear with a table showing existing calculations. Click on 

the “+” button to create and define a new calculation using three new tabs. 

The lower part of the window gets larger, and allows to you to create the calculation with 
four icons: 

 General 

Give a name and a description to this calculation. 

 Channel(s) 
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Select the channel(s) used for the calculation. Right Click to show the quick channel selection 
menu. 

 Zones 

Define the zone on which the calculation will be done. The zone is defined by a start and end 
times. 

The start time could be: 

o The beginning of the all recording. 

o A specific chosen date to be typed in the box. 

o The start time of an existing zone to be selected in the combo box. 

The end date could be: 

o The end of the all recording. 

o A specific chosen date to be typed in the box. 

o The end date of an existing zone to be selected in the combo box 

 Parameters 
 

• Display the time above and below a value 

To add “calculate a time above and below a value”, check the box “time above” 
then indicate the threshold value and its unit. 

• Display the Min. value 

• Display the Max. value 

• Display the max. range 

• Display the mean of mean 

• Display the minimum of the maximum values with the date/time when this 
was reached. 

• Display the homogeneity or Max. spread in setup mode only 

• Display the F0 parameters 

 

Just click on “validate” to validate the creation. 
 

This feature is not available with the Version QLEVER Lite. 

3.3.3 Slope Calculation 

To create or modify a slope calculation select the “data analysis” tab from the open file then 
select the “Slopes” tab. 
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 : Click on button. A window will appear with a table showing existing slope calculations. 

Click on the “+” button to create and define a new slope calculation using three new tabs. 

General 

Give a name and a description to this calculation. 

Channels(s) 

Select the physical parameter and the channel(s) used for the calculation. 

Zones 

Define the zone on which the slope calculation will be done. The zone is defined by a start and 
end times. However, there are two methods when using those two dates. 

o The dates are used to bounder the area where the slopes will be searched. In this 
case the slopes will be found in this area anytime reaching the values defined in 
the Settings tab. 

o The zone is defined by a start and end time. 

The start time could be: 

o The beginning of the all recording. 

o A specific chosen date to be typed in the box. 

o The start time of an existing zone to be selected in the 
combo box. 

The end time can could be: 

o The end of the all recording. 

o A specific chosen date to be typed in the box. 

o The end date of an existing zone to be selected in the 
combo box 

Settings 

If the dates are used to bounder the area where the slopes will be searched, it is necessary to 
also specify a frame between a minimum and maximum physical value inside which the slopes 
will have to be calculated. Also specify the direction of the searched slope. 

The minimum value can be defined in two different ways: 

o By a fixed value. 

o By a zone. In this case, it is the minimum value of the zone that will be used. 

The maximum value can be defined in two different ways: 

o By a fixed value. 

o By a zone. In this case, it is the maximum value of the zone that will be used. 

To choose the direction of the slope check on of the dedicated boxes. 

 Just click on “validate” button to validate the calculation creation. 
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This feature is not available with the Version QLEVER Lite. 

3.3.4 Calculated columns 

It is possible to add columns to the data the file with results of a calculation for each sample. 
To do so, go to “Edit > Calculated columns management” menu. 

A window will appear with a table showing existing calculated column. 

• The 1st column is the name. 

• The 2nd column is the type. 

• The 3rd column shows the summary of the settings. 

To edit or delete a calculated column just select the corresponding line and click on “Edit” or 
“Delete” button. 

Click on the “+” button to create and define a new calculated column. A contextual menu will 

appear, then select the column type that you want to add. Once selecting one type of 
calculation from the menu, a window will appear where you need to type the parameters and 
settings for the calculation. 

 Setup type calculated columns are shaded. They can’t be modified because they belong to 
the measurement report. 

 Not used and excluded channels are not available on the channels list. 

 Caution: in the case of channel exclusion, the calculated channels are recalculated only in 
“setup” mode, not in in “standard” mode. 

 You must Save, close and open the current Qle file to update Excluded channels in the 
logger channel list. 

 Caution: in the 21CFR Secure Mode Audit, the channels carry their column number when 
entering the parameters of the new channel, but this column number may be shifted if you 
insert other types of calculated channels. 

3.3.4.1 F0/A0/C0… type column 

The table on the right allows the selection of the columns on which you wish to make the 
calculation. For each selected column a new column will be created with the parameter setting 
defined on the left part. 

The left part allows you to define such calculation in the following way: 

o A list allows to choose the calculation type: 

o F0: for sterilization, expressed in minute. 

o A0: for disinfection, expressed in second. 

o C0: for cooking, expressed in minute. 
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o P0: for pasteurization, expressed in minute. 

o Define…: allows to modify the label of this calculation type and to choose 
the unit it will have to be displayed. 

o TR: The reference temperature. 

o ZR : Bacterial reduction temperature  

o TI: Temperature threshold for the calculation. 

3.3.4.2 Offset type column 

Add a value to one or more columns to create offset(s). 

Just specify: 

• The name. 

• The value for the subtraction (if this value is negative, it will be added). 

• The physical parameter for the value. 

The calculation will be: VYX −=  with: 

• X = new column value. 

• Y = reference column value. 

• V = value to be subtracted. 

According to the specified physical parameter, only channels with the same physical parameter 
are displayed on the right end table. Check the box to add the calculated column on the desired 
channel(s). 

3.3.4.3 Percentage type column 

Add a column with a percentage results using a reference value. 

Just specify: 

• The name 

• The reference value. 

• The physical parameter for the value. 

Calculation will be: 100
−

=
V

VY
X  with: 

• X = new column value. 

• Y = Value from the channel 

• V = reference value 

According to the specified physical parameter, only channels with the same physical parameter 
are displayed on the right end table. Check the box to add the calculated column on the desired 

i
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channel(s). 

3.3.4.4 Delta (Δ) type column 

Add a column with Δ results, difference between two existing logger columns of the same 
physical parameter. 

Just specify: 

• The name. 

• The physical parameter for the value. 

• The formula 21 VV −  or 12 VV −  with: 

X = value of the new column. 

V1 = the first value. 

V2 = the second value. 

Depending on the physical parameter of the value, the table on the right hand side will only 
show the sensor with the same physical parameter. You only need to check the sensor(s) 
related to the calculated column. For every sensor channel a new calculated column will be 
added. 

All selected channel must be in the same table (see “Edition”, “Merge the table of the 
current file” or check “Merge the table” when you read the data loggers). 

Not available in real time mode. 

3.3.4.5 Saturated vapour temperature calculation (Regnault) type column 

Add a column with temperature values calculated from the pressure of the saturated steam 
thanks to the Regnault table (100 °C à 150 °C). 

Just specify: 

• The name of the calculation. 

Depending on the physical parameter of the value, the table on the right hand side will only 
show the sensor with the same physical parameter. You only need to check the sensor(s) 
related to the calculated column. For every sensor channel a new calculated column will be 
added. 

3.3.4.6 Saturated vapour pressure calculation (Regnault) type column 

Add a column with pressure values calculated from the temperature of the saturated steam 
thanks to the Regnault table (100 °C à 150 °C). 

Ce type de colonne permet de réaliser un calcul de la valeur de la vapeur saturée, c'est-à-dire 
d’une pression en fonction d’une température selon la table de Regnault (100 °C à 150 °C). 

Just specify: 
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• The name of the calculation. 

Depending on the physical parameter of the value, the table on the right hand side will only 
show the sensor with the same physical parameter. You only need to check the sensor(s) 
related to the calculated column. For every sensor channel a new calculated column will be 
added. 

3.3.4.7 Polynomial type column 

Add a value to one or more columns to create polynomial calculation  

Just specify: 

• The name. 

• The value a 

• The value b 

• The physical parameter for the value. 

The calculation will be: baXY +=  with: 

• Y = new column value (same physical parameter as b). 

• X = reference column value. 

Check the box to add the calculated column on the desired channel(s). 

3.3.4.8 Apply the last calculation 

This menu allows you to load the screens containing the parameters of the last calculation 
performed to save time if you use the same formula often. 

3.3.5 Origin change 

Select “Edit > Modify the file’s beginning date” menu. 

It is possible to modify the date and time of origin of a recording by typing information in the 
table on the left part of the window.  

The buttons on the tool bar of the graph also allow: 

 

Icon Action 

 To shift the origin of the curves manually 

 To make a zoom on the graph 

 To move the graph 
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To finish just click on “save” button. A new file is then created. 

3.3.6 File merging 

To use this menu, it is necessary that more than one files are open at the same time. Note that 
all the open files would be used in this merging process. 

Select “Edit > Merge the open files” menu. 

The table on the left shows the files which are used for this merging process. The date and 
time of origin for each file is shown.  

The buttons on the tool bar of the graph also allow: 

 

Icon Action 

 To shift the origin of the curves manually 

 To make a zoom on the graph 

 To move the graph 

 

It is possible to modify the date and time of origin just like explained in the earlier section 

It is possible to merge those tables into one single table (cf. 3.3.7 Table merging). 

Click on “Save” button. A new file is then created. 

Note that the files created with the Setup mode cannot be merged. 

This feature is not available with the Version QLEVER Lite. 

 

3.3.7 Table merging 

When a file includes more than one data table, after a file merging process for instance, it is 
possible to merge those tables into one single table. We would end up with only one time base 
for all the data. If there is no available data at a certain date and time, there would be empty 
boxes. 

Select “Edit > Merge the data of the current files” menu. 

Note that the data tables from files created with the Setup mode cannot be merged. 

This feature is not available with the Version QLEVER Basic. 

3.3.8 Create a new file from the current zoom 

Select “Edit > Create a new file from the current zoom” menu. 
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 Only user F0, A0, C0, … calculated channels (not setup mode) are recalculated. 

 Only a data file created in standard mode. 

This feature is not available with the Version QLEVER Basic. 

3.3.9 Printing 

Select “File > Print” menu to print the file. 

By clicking on “Print” button the standard printing window of Windows opens allowing the 
choice of the printer and the printing format. 

The printing parameter window allows: 

To print the numerical data over a period. By default, the period represents the whole data. 

• Print every lines or one line out of x.  

• To print the graph with background color. 

• To print the graph legend on a separate page. 

• To print the Min./Max./Avg. calculation. 

• To print the comment of the QLE file. 

3.3.10 Export of file 

Select “File > Exporter” menu to export the QLE file as external file. 

3.3.11 Export of data loggers 

Select the menu “File > Export the data” in order to export the data to a spreadsheet. 

▪ Data file 

o Select the start and end dates. As default data from the entire recording will be 
exported. 

▪ Min./Max./Avg. calculations 

 

Configuration of the format of such exported data: 

• Select the separator for the columns. “;” or TAB 

• Select the type of file, CSV ou TXT 

• Choose to separate the milliseconds into a new column (data only) 

• Export to the ValiVacq format 

• Choose to automatically open the file 
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The new created file will be compatible with any spreadsheets 

 Is the QLE file includes several tables, they will be written in a raw. If you want a single table, 
go to “Merge the table of the current file” in “Edition” menu. 

4 Real time and Radio loggers use 

Radio Channel Frequencies (MHz) 

11 2405 

12 2410 

13 2415 

14 2420 

15 2425 

16 2430 

17 2435 

18 2440 

19 2445 

20 2450 

21 2455 

22 2460 

23 2465 

24 2470 

25 2475 

Channels Frequencies 

4.1 Programming and starting 

The radio loggers can be programmed (cf. 2.3 Program the loggers) and started (cf. 2.4 Start 
the loggers) as any logger.  
However, if several radio loggers are used simultaneously, a window will pop up before the 
start of the loggers to specify for the offset to shift the start time between two loggers. You 
have to type in a value multiple of 100 milliseconds. The purpose of this time shift is to prevent 
the loggers from transmitting data simultaneously which could create data loss.  
 
The number of recorders possible for radio reception depends on: 

• The chosen rate of the programming divided by 100 milliseconds (for example: in 1 
second it is possible to pass 10 in the best case). 

• The number of loggers and not the number of channels (a 32-channel thermocouple 
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vacq counts as 1) 

• The environmental conditions where the recorders and the radio receiver are located, 
which influence the quality of radio communication. For example, if the environment 
is disturbed in electrical equipment, or by metal walls, the radio waves will be more 
disturbed, and it will certainly require numerous transmission re-tests. 

• The computer power required to process this data in the case of a large number of 
loggers (computing, displaying). 

4.2 Real time file creation 

After the radio loggers started, click on “Real time” or “File > New… > Real time file” menu. 
 
A window opens and allows the selection of started radio loggers for a real-time monitoring. 
 

• Select the loggers for the real-time monitoring 

o Right click menu: 

▪ Select all, select none 

▪ Select all loggers with the same radio channel 

▪ Delete radio status 

▪ Refresh the list 

• Select a file in which the data will be saved. 

• Click the “next” button. 

The following window lets you add columns which will be calculated in real time at the time 
of the data reception. 

• To add calculated columns, click on “Calculated column management”, the method 
is then the same as described in paragraph 3.3.4. 

• Then click “Validating” to finish, the created file opens 

4.3 Monitoring 

You can monitor the radio loggers thanks to the real-time file created as above. 

If you close the file, the data displayed so far will be lost. If you open the file again, the new 
data will be added. 

When a radio loggers monitoring file is open, a window entitled “Radio” allows:  

• To modify the serial ports connected to the radio receivers. 

• To visualize the loggers which are currently monitored. 

• To monitor the quality of the reception (only for Radio loggers). 

http://www.worldlingo.com/SjGle6L45449yB3Z1izjnkYEdt5kmHTAd/msowin11?service=WorldLingo_FR-EN&lcidFrom=1036&lcidTo=1033&lcidUI=1036&t=70D406D8-975A-2D10-782A-7FE063971040#_toc506
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• To activate/deactivate the sound emitted on every transmission on the USB 
receiver’s data. 

5 Data Files Management System: TDB 

QLEVER uses a secured data file management called TMI Data Base (TDB). It is a secured data 
base used by the software when saving and reading any recordings (cf. 1.2 Directories 
Management). 
IMPORTANT NOTE: the TDB must be installed on NTFS partition. To open a file, go to “File” 

and “Open” or click the  button from the tool bar.  

5.1 Description of the functions of the files management system 

This data management system is similar to the Windows Explorer. 
The TDB and QLEVER can be used on a network meaning that the files could be accessed by 
multiple users. To do so, just specify a directory that can be accessed by every user when 
doing the setting of the directories (cf. 1.2 Directories Management). 
Selecting a file or directory and by right-clicking, you can access various functions just like in 
the Windows Explorer. The same functions are also available from the “Directory” and “File” 
menu on the top. 
According to the type of file (Setup, Process, QLE files, Reports), some specific functions will 
appear at the bottom part of the window. 
Functions related to the directories on the left hand part are: 

• New, Rename, Move or Delete. 

• Properties directory, icon directory and check TDB index 

• Search file 

• Display of the recent files 

• Some directories being part of the QLEVER system cannot be moved, renamed or 
deleted. 

Functions related to the files on the right hand part: 

• Display of the GUID (Globally Unique Identifier). 

• Display the name of the file with Unicode. 

• A file already opened by some other user shows red and it is not possible to open. 

• Display of an icon showing the type of file. 

• Display of an picture showing a curve for a QLE file or report or generally the 
equipment picture for a Setup. 

• Display of some dates and user’s names for creation and modification details. 

• Usual functions with the right-click. 

• Starting a Setup 

• Read a process 

• Approve a measuring report 

• Force and close a file. 
Also, for the QLE file, in the bottom part of the window you can: 
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By selecting a file, rename the file, modify the description and add key word to help the file 
research. 
Click “Save” to record the change. 

5.2 File research by date or keywords 

Find a file becomes easy with the TDB. Type one or more keywords then click the magnifier 
icon. 
For instance, if you need to find files related to the logger with serial number NV034108, 
type NV034108 and click on the magnifier icon. 
For example, if you need to find all the Setup files, type the word “Setup” and click on the 
magnifier icon. 
Further, using the “Recent Files” button, you can list all the files by date of modification, or 
another method is “File > Recent Files” Menu 

5.3 Globally Unique IDentifier (GUID) 

The TDB gives a unique identification to every file. This identification starts with QL for the 
QLE files, RP for the Reports, PP for the process, SP for Setup, etc. 
The label of the column is ID# or GUID# depending on the screen display. 

5.4 Export of file 

5.4.1 Export of QLE file format 

Export is the copy of file(s) from the TDB to the hard drive or external drive like an USB 
memory stick. 
Right-click on one or several files than select “Export” from the menu list. Then choose the 
directory of destination. 
When using the Security (21CFR part 11) mode, you have to create a password for the 
exported file. 
 Brick file don’t have an exportation password. 

5.4.2 Export of VCQ file format (for compatibility only) 

Right-click on one or several QLE files than select “Export VCQ file” from the menu list. Then 
choose the directory of destination.  
Such feature is only available in order to maintain some compatibility with XVacq or 
ValiVACQ. 
 
Only VCQ files can be opened with Xvacq or ValiVacq software. 
Only QLE files, that were created when reading loggers with the box "Create a file for each 
record" checked, include a VCQ file. 
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 This function is available only if “Save the VCQ file” is checked in the TDB Administration. 

5.5 Import of file  

Import to copy from an external drive like the hard drive or USB file to the TDB. 
From the TDB, go to “File > Import”. Select one or more files. 
With the Security (21CFR part 11) mode, you need to type the necessary password to open 
imported files.  
 Brick file don’t have an importation password. 

6 Administration, Backup and Restore of the entire TDB 
database 

6.1 General description 

• When using the security mode, only the administrator use could use such functions. 
Therefore, login using your Administrator account. 

• Not using the security mode every user is an Administrator. 

Go to “Configuration” menu then click “Directory Management”, “TDB Administration”, 
“Data”. 
 
During the database administration jobs such as backup, restore, compressing or reindexing, 
the TDB will be automatically locked during the time for the job to be completed. This in 
order to avoid other users to access the data base. 

6.2 Backup the TDB database 

• Login using your Administrator account 

• Go to “Configuration” menu then click “Directory Management”, 
“TDB Administration”, “Data”. 

• Click “Backup” 

• Select a directory and a password. 

• All data including (QLE files, user’s account, etc.) will be saved. 

• Depending on the size of your TDB, such job could take few minutes or more. During 
such time, other users could not access to any data. 

 
Depending on the size of your TDB, such job could take few minutes or more. During such 
time, other users could not access to any data. 
 
If one of the files in the TDB (TMI Data Base) is larger than 4GB then it will not be possible 
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to perform a backup by Qlever. This is not a limitation of Qlever but a limitation of the 32-bit 
backup system. Back up the database with another utility or with a copy-and-paste operation 
from Windows Explorer (but no user needs to work on it). 

6.3 Restore the TDB database 

• Login using your Administrator account 

• Go to “Configuration” menu then click “Directory Management”, 
“TDB Administration”, “Data”. 

• Click “Restore”. 

• Select the directory chosen for the Backup. 

• Type the password chosen for the Backup. 
 
Depending on the size of your TDB, such job could take few minutes or more. During such 
time, other users could not access to any data. 
 
Important notice: such restore replaces every data (QLE files, user’s account, etc.) with 
the data included in the backup file. 
 

6.4 Reindexing the TDB database  

Such function allows you to compress the database after some time in order to improve 
access time and save some disc space. 

• Login using your Administrator account 

• Go to “Configuration” menu then click “Directory Management”, 
“TDB Administration”, “Data”. 

• Click “Reindexing” for a fast process. 

• Click “Compression” for a long process but with a more efficient compression of the 
files. 

• Click “Check” for a TDB index files check. 

• At the following date 
 

Depending on the size of your TDB, such job could take few minutes or more. During such 
time, other users could not access to any data. 

6.5 Lock the TDB database 

• Login using your Administrator account 

• Go to “Configuration” menu then click “Directory Management”, 
“TDB Administration”, “Data”. 

• Click “Lock” 
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This allows you to manually lock the database access for administration maintenance 
reasons. 

6.6 Unlock the TDB database 

• Login using your Administrator account 

• Go to “Configuration” menu then click “Directory Management”, 
“TDB Administration”, “Data”. 

• Click “Unlock” 
 

This allows you to manually unlock the database access for administration maintenance 
reasons. 
During the database administration jobs such as backup, restore or reindexing, the TDB will 
be automatically locked during the time for the job to be completed. This in order to avoid 
other users to access the data base. 
 
When using the secure mode, only the administrator could unlock the TDB. 

6.7 Logout the users from the TDB database 

▪ Click “Logout all the users” 
 
In case, by mistaken one more computers are left connected to the TDB, the Administrator 
can log the users out from the TDB in order to proceed with a Backup or Restore job. 
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Chapter - 3 Options for QLEVER 

This feature is not available with the Version QLEVER Lite. 

1 Brick option 

1.1 Prerequisites 

• QLEVER license with: 
o Autoclave validation option included 

• At least one temperature data logger 

1.2 Description of the Brick option 

The brick option would add functions to the software to help monitoring the curing process 
of ceramic products in kiln tunnels. 

• As a first step, you need to create one or more reference describing the kiln tunnel, 
the kiln car and the position of the thermocouples. 

• As a second step, you need to link a reference file with a data file. 

1.3 Create or modify a reference Kiln file  

To create a new “kiln” file click “File > New… > Kiln file”. 

To modify a “kiln” file, open it. 

Si the “kiln” file has been associated with a Qle file, click on “Description” button. 

1.3.1 Description of the oven [tab 1] 

In the first tab you would type the information related to the oven. 

• Name, Site, Comment to be specified for the kiln, manufacturing site, process, etc. 

• Picture: It is possible to add a graphic element like a photograph picture or a diagram 
to visualize the kiln. 

This picture will be used in the Tmi Data Base. 

• Kiln parameters: to type the technical information for the kiln. When typing correct 
information, it becomes easy to link the temperature data to specific locations within 
the tunnel. 

• Measurement report: 

o Header for the report 
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o Final evaluation and remarks 

1.3.2 Load description and thermocouples description [tab 2] 

In the second tab you would define the load as well as the thermocouple distribution layout. 

1.3.2.1 Load description  

From this section you would define the load type, the quantity, the unit weight and also to add 
a photograph. These elements are for information only and optional. 

1.3.2.2 Load organization 

From this section you would define the elements distribution in the kiln car. When one of the 
three values is modified, the 4 diagrams in the right-hand side would be automatically updated 
according to those modifications. 

Caution: if the number of elements is important, it is preferable to separate the load into blocs 
made of several elements. 

1.3.2.3 Thermocouples management 

From this section you would define the number of thermocouples that would be used. It is 
possible to type this information later, for example after reading the memory of the logger. 

To specify the number of thermocouples, simply enter the data. The table below will be 
updated. It is also possible to modify the description column and add a comment. 

Then you can position the thermocouples on the 4 theoretical views and/or on the 
photographs. 

1.3.2.3.1 Positioning on the drawing. 

On each kiln car view, tags labeled with a number related to the thermocouple can be moved 
with the mouse except on the 3D view. Just click on the tag and move it to the required 
position. The 3 other views are then updated in real time. 

1.3.2.3.2 Positioning on the photograph 

From the “Positioning on photograph” tab it is possible to add up to two photograph pictures. 
On each of them it is possible to move the tags showing the thermocouples by using the 
mouse. 

1.3.3 Setting up the oven / Kiln tunnel configuration [tab 3] 

This tab allows to position the various elements inside the kiln and to divide the tunnel into 
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various zones. 

In the top of the screen, a comment for le report. 

The kiln is displayed in the upper part of the window. From the blue window you can define 
and move the kiln section. 

1.3.3.1 Kiln elements positioning 

1.3.3.1.1 Add new elements 

To add elements inside the kiln tunnel just select the element from the list then drag and drop 
on the kiln diagram in the lower part. Then release the button to leave the element at the 
required place. 

It is also possible to add several elements at the same time. You have to: 

Select from the combo box on the right the type and number of elements to be added. 

 Define the distance from the first element to the kiln entrance. 

 Define the elements position 

  Define the distance between each element 

  Then click on “add” button. 

1.3.3.1.2 Elements modification 

To modify elements already positioned, it is possible to: 

 Click on a kiln element and move it with a click. 

 Modify, using the table, the distance and the position from the element. 

1.3.3.1.3 Delete Elements 

To remove one or more elements just select them in the middle chart, then click on “Delete” 
button or press the “Delete” key from the keyboard. 

1.3.3.1.4 Elements Icon customization 

It is possible to personalize the icon for kiln elements. 

To do so just: 

 Go in the software installation directory software and find “kiln element” 

 Create images files in PNG format of 26 pixels high by 26 pixels large and name them 
1.png, 2.png, etc. 

 Open the elements.ini file and modify it so there is one line per image: 
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[IMAGES] 
1 = image 1 name 
2 = image 2 name 
…  

1.3.3.2 Zones definition 

To create a zone just click on “Zones” tab and fill the fields in and click the “add” button. 

It is possible to modify them by publishing directly the values in the chart recapitulating the 
existing zones. 

It is also possible to remove a zone by selecting it in the table and press the “Delete” key from 
the keyboard. 

1.3.4 Pushes and incidents management [tab 4] 

This tab allows modification of the push duration when the speed changes or incidents 
occurred during the process. 

To modify only one push just edit the duration, the reason for change or any comment. 

To modify several subsequent pushes just fill the lower part in: 

 New duration of each modified push. 

 he pushes that need modification by defining the first and the last push. 

 By modifying if necessary the reason of the duration change 

 By adding a comment 

Then just click the “Modify” button and the changes are recorded. 

In the bottom, a comment for le report. 

1.4 Associate a Kiln file and a data file 

To link a kiln file and a data file you should do as follows: 

 Open a QLE data file 

 Click on “Edit > Process > Kiln file” menu 

 Choose the kiln file corresponding to the process and validate 

 The two files are then associated. 

The reference kiln file is copied inside the data file and is not modified. It could be used as 
many times as necessary with other data files. 

Once the association is validated: 

o New tab appears in the display window of a QLE file. It is the “brick” tab. 

o The pushes, the kiln elements and the zones are displayed above the graph. 
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Under this tab, two other tabs. 

o “Description” and “Report” button 

1.4.1 Kiln description 

The “Description” button displays the brick reference file parameters. 

Using the table, you can associate the loggers thermocouples with those defined in the brick 
reference file. 

The right-hand side part shows the temperature grade given by the various thermocouples at 
the specific location chosen on the graph or from the data table. 

By clicking the “Open” button, it is possible to open a window showing the current selected 
view of the load. 

1.4.2 Pushes management 

This tab allows modification of the pushes duration using the graph. 

The following steps should be followed: 

 Make a zoom on the required part of the graph 

 Click on the graph at the exact place where the required push must begin 

 Select the push form the table 

 Click the “Apply” button  

 All pushes are automatically shifted to take the modification into account. 

1.5 Dissociate a kiln file from a data file 

Simply open the QLE data file, then click “Edit > Remove the process” menu. 

1.6 Display or print a measurement Report 

Two possible scenarios: 

• Existing Report: Use the “File > Open” menu and select a Report file from the TDB 
and double click or right-click and go to “Open”. 

• The report is to be created. 

Open a QLE data file associated with a kiln file. 

Once you close the preview, you can type a name for the report and save. 

Choose your print out mode: 

• Save as: allow to save the report in the QLEVER TDB without preview and 
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print. 

• Default printer: allow to print on the windows default printer without preview. 

• PDF: allow to export the report to PDF format. 

• Open the preview: allow to see the report before print. 

  

You could choose to print one or every of the following: 

• Parameters 

o Display signature or not 

o Display signature only on the first page 

o The legend 

o A summary table of zones manually added 

o The comment of the QLE file 

• The graph  

• Data of every column: 

o Default Data mode  

• Date and hour column 

• Logger column: 

o Channel colour, serial number, physical unit 

   

o Condensed data on 25 columns with calculation (min., max., avg., max-
avg, avg-min…) 

▪ Choose a physical property for the statistics (temperature, …) 

▪ Adding or not statistics (min., max., avg…) 

▪ Printed data description: 

• Stage start date and stage end date number are printed 

• Date and hour column 

• Logger column: 

o Channel colour, channel number, physical unit 

o Statistics for each line: 

▪ Min. value (optional) 

▪ Max. value (optional) 

▪ Average (optional) 
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▪ Max. – Min. (optional) 

▪ Avg. – Min. (optional) 

▪ Max. – Min. (optional) 

▪ Event e1 and e2 

o Print all lines or one line out of x: 

▪ Hidden data channels are printed in the report. 

▪ Excluded data channels are not printer in the report. 

• Loading plan  

• Picture of the equipment 

• Screen shots (if you do not wish to print a screen shot, go to the “Screen shot” 
tab and uncheck “Print in the report”). 

• Min./Max./Avg. statistics of Data Analysis tab 

o User calculations: calculations manually added from “Data analysis” tab, 
button “Modify”. See “Data analysis” paragraph. 

o Page break between each table: if you want to get your report more 
readable, it is possible to separate each Min./Max./Avg. calculation with a 
page break. 

2 Option Secure mode for QLEVER (21CFR) 

2.1 Prerequisites 

• QLEVER license with: 
o 21CFR secure mode option included 
o An “Administrator” Account. 
o Depending on the case, an LDAP license and a network connection. 

2.2 Description of the option Secure mode (21CFR) 

The secure mode for QLEVER is 21CFR part 11 compliant. 

The secure mode features: 

• User Account Management with access levels 

• Data security and integrity 

• Audit Trail reports 

• Depending on the Qlever license content, reports approbation on the recorded data. 
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2.3 Installation and configuration in Secure Mode 

2.3.1 Create the Administrator account 

When installing the software, the Administrator account should be the first to be created. 

Identification of the Administrator account is unique and cannot be modified: admin 
 

• When installing, QLEVER starts login with an administrator account, you must fill the 
related information in. 

• Then click the “Password” button. Choose and type a password for the Administrator 
account. Click “OK”. 
 
Important notice: 
You should remember your password. 

• Login as the Administrator again (Login is : admin) 

• Type the password you chose. 

• Click OK. 

2.3.2 Parameters for user accounts management 

2.3.2.1 Parameters for user rights and accounts management by QLEVER 

Configuration for all “approval” and “operator” accounts (and "administrators" depending on 
the case): 

• Minimum number characters for the password  

• Enable the duration of the password validity (in days). For instance, you may want 
the users to change password every 30 days. 

Changing a setting affects all users (including Administrators). 

The validation period is equal to the last password change date + the duration of the 
password validity in days. This is why activating this function will require a password 
change as soon as a user logs in the next time. 
Please note that the duration is calculated in days and not in hours, and in date UTC 
format (Universal Time Coordinated). This may introduce time differences from your 
local time but the duration is always correct. 

When password is replaced, the new password cannot be the same as the former one 
The modification of a parameter takes effect as soon as the Administrator clicks on 
"Save". 

• Maximum number of retries for identification. You may want to limit the number of 
retries when attempting to login. After x number of tries, the account would be 
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deactivated. Only the Administrator could activate the Account again. 

• Unique password. You may want to prevent one single password to be chosen by two 
or more accounts. 

• Reset password after reactivation of an account: check the box to activate this 
option. The password is automatically reset and will have to be changed by the user 
when next login.  

• Change of password by the user when first login: check the box to activate this 
option. The user will have to change the password when first login. 
The change of password when first login only applies to the accounts created after 
this option is activated. 

 The modification of a parameter takes effect as soon as the Administrator clicks on 
"Save". 

2.3.2.2 Parameters for user rights and accounts management by LDAP 

Prerequisites: 

• A Qlever LDAP license. 

• An "Administrator" account of Qlever. 

• A Microsoft Windows Active Directory with LDAP server. 

• A network connection to connect to LDAP. 

• An LDAP server already installed, accessible and functional, as well as as 
appropriate (mandatory to perform test of IQOQ protocol and, in any case, to use 
Qlever in LDAP mode): 

o A “Approval” group. 

o A “Operator” group. 

o A “Administrator” group (to create if necessary). 

o The name of the groups can be chosen at your convenience, it will suffice 
to enter it in the parameter screens (value of the attribute). 

o One or more approvers in an "Approval" security group (see below). 

o One or more operators in the "Operator" security group (see below). 

o One or more administrators in the "Administrator" security group (see 
below). 

• The client must ensure that they have a department (internal or external) that has 
the required knowledge to configure and manage LDAP user accounts. 

• The "admin" login is assigned to the Qlever administrator account and should not 
be used for administrator-type accounts managed by LDAP. 
 

The LDAP (Lightweight Directory Access Protocol) in Microsoft Windows Active 
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Directory is a directory access protocol. If this option is enabled under Qlever, it 
means that: 

• Account management settings such as "password validity period activation", 
"maximum number of attempts to login", "password uniqueness", etc ... are 
managed by LDAP. 

• Account management (creation, deletion, modification, activation, 
deactivation, password reset, etc ...) is managed by LDAP. 

• The assignment of account types (Approval and Operator and Administrator) 
is managed by assigning to a "security group" of the LDAP. 

• Qlever's first "Administrator" account is not managed by LDAP and must be 
created under Qlever before configuring Qlever in LDAP mode. 

• Under Qlever, authentication of each user's access by username and 
password is validated by an LDAP connection (except Qlever administrator). 

• LDAP account authentication "Unicode" is not supported by QLEVER. 

• A mode other than Microsoft Windows Active Directory is not supported 
by QLEVER. 

 
LDAP settings under Qlever: 

• LDAP: Enable LDAP mode under Qlever (Default = no). 

• It is recommended to enable LDAP mode on a new TDB because the 
matching of the account ID names between Qlever and LDAP can lead 
to confusion of people names in the Audit (however, the GUID will not 
be the same). 

• Caution: for account security reasons, once LDAP mode is activated: 

o The database is migrated into LDAP mode. 

o It is not possible to disable the LDAP mode afterwards. 

o Attention: in the case of an already existing TDB, Qlever user 
accounts with the same identifying the LDAP will be associated 
in the audit trail. If you do not want this to happen, then you 
need to create a new TDB. 

• Domain: The LDAP domain name. User Authentication will be in the form 
Identifier@domainname 

• Server (LDAP): Name or Ip address of the LDAP server to contact during 
login. 

• Port: LDAP server port (389 by default). 

• Version: version of the contacted LDAP server value 2 or 3 (3 by default). 

• SSL: SSL secure connection management (default = no). 
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• auNegociate: connection via "Generic security service" GSS (default = no). 

• Base DN: dn of the base object for search "sAMAccountName =".  
For example: dc = tmiorion, dc = local. 

"cn" is used to obtain the surname and first name, in addition to 
"givenname" and "sn". 

"telephonenumber" is used to obtain the telephone number. 

"mail" is used to get the email address. 

 

• Approval: The value of the attribute for the Approver account type of the 
"Approval" security group. 

For example: CN = QLEVER_TDB_PROD_APPROVAL 

• Operator: The value of the attribute for the Operator account type of the 
"Operator" security group. 

For example: CN = QLEVER_TDB_PROD_OPERATOR 

• Administrator: The value of the attribute for the Administrator account type 
of the "Administrator" security group. 

For example: CN = QLEVER_TDB_PROD_ADMINISTRATOR  
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2.3.2.3 Parameters for user rights and functionalities by QLEVER 

Audit Configuration 

• Entering the reason for the actions: if checked then the user will be asked to enter a 
comment on the reason for an action (modification, deletion, ...). 

Checking the version of Qlever on the current TDB: 
Optional option that can not be activated to ensure that all workstations are up to 
date and that a forgotten old workstation does not connect. 
Only concerns the current TDB. 
 

• Installed version: current version of Qlever equal to or greater than the minimum 
required version. 

• Minimum version required: minimum version of Qlever mandatory if this version is 
entered. 

• Apply: allows you to apply the current version number as the minimum required 
Qlever version. 

• Test: allows you to test before saving 

• Cancel: allows you to cancel the mandatory minimum version of Qlever. 
 

 Important: this option can only be activated for installed versions equal to or greater 
than version Qlever 2.4.8.0 because older versions do not have the verification procedure 
and therefore can connect to the database. 

 
 
Setup: rights on the Setup for the operator (Setup to be started to create process) 
▪ Create: if checked, the operator can create a Setup file (Setup menu, new) 
▪ Delete: if checked, the operator can delete a Setup file from the file management of 

QLEVER 
▪ Modify: if checked, the operator can modify the content of a Setup file 

However, it is also possible to allow the operator to only modify some items of the Setup: 
▪ Description: if checked the operator can modify the content of the “Description” tab. 
▪ Parameters: if checked the operator can modify the content of the “Parameters” tab. 

o Values of the parameters: if checked the operator can modify the values of 
the parameters in the “Parameters” tab. 

▪ Equipment: if checked the operator can modify the content of the “Equipment” tab. 
▪ Loggers: if checked the operator can modify the content of the “Logger” tab. 
▪ Programming: if checked the operator can modify the content of the “Programming” 

tab. if not checked the operator can’t create a new setup. 
▪ Analysis: if checked the operator can modify the content of the “Analysis” tab. 

Calculations: if checked the operator can modify the calculations and 
formulas within the “Analysis” tab. 
Functionalities and display would differ depending on the QLEVER version and 
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your licence (pharma, autoclave validation, washer-disinfectors, mapping, 
etc.) See below Analysis / F0,A0,C0,P0 only for Pharma. 

▪ Sensor positions: if checked the operator can modify the content of the “Sensor 
positions” tab. 

▪ Report: if checked the operator can modify the content of the “Report” tab. 
▪ Process: if checked the operator can modify the content of the “Process” tab. 

 
Setup: rights on the Setup for the operator (Setup in QLE after read) 
▪ Modify: if checked, the operator can modify the content of a Setup file or use “Save 

as”. 
However, it is also possible to allow the operator to only modify some items of the Setup: 
▪ Description: if checked the operator can modify the content of the “Description” tab. 
▪ Parameters: if checked the operator can modify the content of the “Parameters” tab. 

o Values of the parameters: if checked the operator can modify the values of 
the parameters in the “Parameters” tab. 

▪ Equipment: if checked the operator can modify the content of the “Equipment” tab. 
▪ Loggers: if checked the operator can modify the content of the “Logger” tab and 

exclude a logger in the QLE graph. 
▪ Analysis: if checked the operator can modify the content of the “Analysis” tab. 

o Calculations: if checked the operator can modify the calculations and 
formulas within the “Analysis” tab. 
Functionalities and display would differ depending on the QLEVER version and 
your licence (pharma, autoclave validation, washer-disinfectors, mapping, 
etc.) See below Analysis / F0,A0,C0,P0 only for Pharma. 

▪ Sensor positions: if checked the operator can modify the content of the “Sensor 
positions” tab. 

▪ Report: if checked the operator can modify the content of the “Report” tab. 
 
Setup: rights on functionalities for all accounts: 

 For all Setup: 

▪ Analysis / Humidity calculation: if unchecked, then the humidity 
calculation parameters are not displayed (default is checked). 

o Parameters / Hygrometer tab too. 

▪ Analysis / MKT calculation: if unchecked, then this calculation 
parameters are not displayed (default is checked). 

▪ Analysis / Time above - time below: if unchecked, then this 
calculation parameters are not displayed (default is checked). 

▪ Analysis / saturated steam: if unchecked, then this calculation 
parameters are not displayed (default is checked). 

Only for Pharma setup: 

▪ Process tab: if unchecked, then the process tab is not displayed 
(default is checked). 
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▪ Analysis / F0,A0,C0,P0: if unchecked, then this formula and 
calculation parameters are not displayed (default is checked). 

▪ Analysis / events: if unchecked, then this calculation parameters are 
not displayed (default is checked). 

▪ Analysis / Print in the report: if unchecked, then min, max, avg,… 
calculation parameters are not displayed (default is checked). 

 
Note: Numbers of tabs and display would differ depending on the QLEVER version and your 
licence (pharma, autoclave validation, washer-disinfectors, mapping, etc.) 
 

Calibration: rights on Adjustment for operator: 

▪ Adjustment: if checked the operator can adjust a logger (default is 
unchecked) 

Calibration: rights on Calibration for the approval and operator: 

▪ Degree of polynomial: if checked the approval and operator can 
modify the content of the degree of polynomial in the step analysis 
windows (Only in expert mode calibration, default is checked).  

▪ Max spread: if checked the operator can adjust a logger (default is 
unchecked) a max spread calculation is available (only temperature) 
in the report of the step analysis (Only in expert mode calibration, 
default is unchecked). 

Calibration: rights on step setting for operator: 

▪ New: if checked the operator can create a “step settings” file (default 
is unchecked) 

▪ Modification: if checked the operator can modify a “step settings” 
file (default is unchecked) 

▪ Deleting: if checked the operator can erase a “step settings” file 
(default is unchecked). Identical for the restore functionality. 

 

Files: rights on files and directory management for the operator: 

▪ Directory 

▪ New: if checked the operator can create a new directory (default is 
checked) 

▪ Deleting: if checked the operator can delete a directory (default is 
checked) 

▪ Rename: if checked the operator can modify the directory name 
(default is checked) 

▪ Move: if checked the operator can move a directory (default is 
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checked) 

An approval has all rights to the files. 

 For operator, see also setup rights and cet rights. 

▪ QLE Files 

▪ Deleting: if checked the operator can delete a QLE file (default is 
checked) 

▪ Rename: if checked the operator can modify the QLE file name 
(default is checked) 

▪ Move: if checked the operator can move a QLE file (default is 
checked) 

An approval has all rights to the files 

CET: rights on CET configuration files for the operator: 

▪ Install: if checked the operator can install a new CET file (default is 
unchecked) 

▪ Delete: if checked the operator can delete a CET file (default is 
unchecked) 

▪ Export: if checked the operator can export a CET file (default is 
unchecked) 

▪ Restore: if checked the operator can restore an old CET file (default is 
unchecked) 

Configuration Date and alarm of the CET/CETX 

These parameters allow to configure information symbol to shows the validity of the 
date of every configuration file (for all accounts). 

• Enable (default: unchecked): 

Unchecked: any information symbol, any logger locked 

Checked:  

▪ If Configuration date > x days, then is displayed (default is 180 
days) 

▪ If Configuration date > x days, then is displayed (default is 356 
days) 

• Lock the logger (default: unchecked) : it’s possible to lock 
a logger, only in setup mode and only at the process 

start, if the  date is over. 

 If the end of the recording is greater than the 
configuration date + number of days, then the logger will 
not be locked.  
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 If a logger is locked, then all operations are possible 
except the start (eg stop, replay are allowed) 

 In standard mode, there is no locking of the logger. 

 To unlock a logger, it must update its configuration 
date (adjustment). 

Report: rights on report for the approval and operator: 

▪ “Report approved by/Report not approved”: if the box is unchecked, 
the approval mechanism will be disabled. In other words, the buttons 
“Approve” will not be displayed. Moreover, the reports will not show 
the ‘approved by” or “not approved” (default setting is checked). 

Report: rights on report for the operator: 

▪ “Type of Report”: if the box is checked, the operator can change the 
type of the report. Only for Autoclave validation and Washer 
disinfector (default setting is unchecked). 

 

QLEVER: rights on functionalities for the approval and operator: 

▪ “Programming” in standard mode: if checked it’s possible to 
program loggers in standard mode (default is checked). 

▪ “Start” in standard mode: if checked it’s possible to start loggers in 
standard mode (default is checked). 

▪ “Read” in standard mode: if checked it’s possible to read loggers in 
standard mode (default is checked). 

▪ “Real time”: if checked it’s possible to run a real time with loggers 
(default is checked). 

 

QLEVER: rights on functionalities for the operator only: 

• “Loggers”, “Erase memory”: if checked the operator can erase the 
logger memory (default is checked). 

• “Loggers”, “Thermocouple configuration”: if checked the operator 
can configure a universal thermocouple logger (default is checked). 

• “Directory Management: if checked the operator can modify the 
directory management (default is checked). 
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2.3.3 Account types 

3 types of accounts with QLEVER: 

• Administration 

• Approval 

• Operator 

2.3.3.1 Administrator account 

Once the software is installed, Administrator account would be the very first account 
created. 

The identification of the Administrator cannot be changed: admin 

Functions available for the Administrator account are: 

• Manage the option for the account creation (except in LDAP mode). 

• Create accounts (except in LDAP mode). 

• Delete accounts (except in LDAP mode). 

• Activate or disable accounts (except in LDAP mode). 

• Modify information for the accounts (except in LDAP mode). 

• Reset the password of accounts (except in LDAP mode). 

• Print the list of users. 

• Export the users file. 

• Import the users file. 

• View the software audit trail. Other audit trails related to the loggers would be 
displayed with faint font only. 

• Print the software audit trail. 

• Modify the QLEVER license. 

However, no access to the following functions: 

• Calibration file installation, programming, start, create setup file, read, open files, 
reports. 

2.3.3.2 Approval Account 

Functions available for the Approval accounts: 

• Modify information for own account (except in LDAP mode).  

• Calibration files installation, open files. 
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• Programming, start, read loggers in setup mode. 

• Create, modify, delete a Setup file. 

• Start a Process. 

• View, print or delete reports. 

• View Audit trails. 

• Depending of the configuration by the Administrator 

o Programming, start, read loggers in standard mode. 

o Approve reports. 

2.3.3.3 Operator Account 

Functions available or limitation for the Operator accounts are: 

• Modify information for own account (except in LDAP mode). 

• Programming, start, read loggers in setup mode. 

• Open files. 

• Create a Process. 

• View and print setup Reports. 

• Cannot delete or approve setup reports. 

• Can delete calibration report. 

• No access to audit trails. 

• Depending on the rights granted by the Administrator:  

o Programming, start, read loggers in standard mode. 

o Create, modify, delete Setup files. 

o New, modify, delete, move directory. 

o Install, delete, export, restore calibration files CET. 

o Delete, rename, move a QLE file. 

2.4 Account Management with the Administrator 

2.4.1 Create accounts 

Accounts management with Qlever 

Only the administrator account can create or delete other accounts. 

At least one Approval account should be created when using QLEVER. 
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• Login with the Administrator account. 

• Go to menu “Administrator” and “Users accounts”. 

• Click “New”. 

• Fill the necessary information in. 

Approval level is the default value. 

Both identification and password are the requested information when login.  

• Click “Save”. 

LDAP mode 

Function not applicable in LDAP mode for the all accounts. 

Account management (creation, deletion, modification, activation, deactivation, 
password reset,... ) are managed by LDAP: 

Just add the Microsoft user account in the "Approval" or "Operator" or 
"Administrator" security group of your LDAP. 
 

Maximum number of accounts: 

Maximum number of accounts is 65535 (sum of active, deactivated and delete 
accounts). 

 

2.4.2 Modify accounts 

Accounts management with Qlever 

• Login with the Administrator account. 

• Go to menu “Administrator” and “Users accounts”. 

• Select an account from the list and click “Modify”. 

• “Activate” allows the Administrator to activate an account that was previously 
disabled. 

• “Disable” allows the Administrator to deactivate an account. 

• “Delete” allows the Administrator to delete an account. 

• “Reset Password” allows the Administered the reset the password of an account.  
For instance, a user would forget password, by resetting the password, a new 
password would “calculated” by the system to be given to the user. 

 
Click “Save” to record the change. 
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LDAP mode 

Function not applicable in LDAP mode for the all accounts. 

Account management (creation, deletion, modification, activation, deactivation, 
password reset, etc ...) are managed by LDAP: 

Just modify the Microsoft user account in the "Approval" or "Operator" or 
"Administrator" security group of your LDAP. 

2.4.3 Delete accounts 

Accounts management with Qlever 

• Login with the Administrator account. 

• Go to menu “Administrator” and “Users accounts”. 

• Select an account from the list and click “Delete”. Then confirm. 

Delete is irreversible and the related identification will be no longer available for another 
account to be created (the account is grayed). 

It’s possible to delete: 

• Administrator (but it’s not possible to delete the default admin) 

• Approval 

• Operator 

LDAP mode 

Function not applicable in LDAP mode for the all accounts. 

Account management (creation, deletion, modification, activation, deactivation, 
password reset, etc ...) are managed by LDAP: 

Just remove the Microsoft user account in the "Approval" or "Operator" or 
"Administrator" security group of your LDAP (or erase or disactivate the Microsoft 
user account). 

2.4.4 Print the list with users 

• Login with the Administrator account. 

• Go to menu “Administrator” and “Users accounts”. 

• Click “Print”. 
 In LDAP mode, the list of accounts is grayed out on the screen because the 
accounts are not managed by Qlever 
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2.4.5 See the list of users that are logged into the TDB 

• Log in with an Administrator account. 

• Go to menu “Administrator” then “User Account”. 

• From the »Connected » column, a green signal shows whether a user is currently 
connected onto the TDB. 

• Click the Refresh button or press the F5 key in order to refresh the list. 

 In LDAP mode, the list of accounts is grayed out on the screen because the 
accounts are not managed by Qlever 

2.4.6 Export and import of the user accounts 

2.4.6.1 General remarks 

• Only the Users file can be imported and exported. 

• Only the Administrator can use the import/export function. 

• “Directory management” menu, “TDB Administration” and “Account”. 

2.4.6.2 Export  

• The export function would create a file with a name as follows: “QLEVER_users_year-
month-day_hour-minute-seconde.zip” 

• The file is exported to a directory selected by the Administrator (local, network, USB 
drive, …) 

2.4.6.3 Import 

• The Users file to be imported is located in the directory defined above. 

• A warning would inform the Administrator that all the user accounts including the 
Administrator account would be overwritten with such import process. The 
Administrator password of the imported Users file will be needed. 

• The imported users file would replace the current users file. 

2.5 Login into QLEVER 

• If you already logged as the Administrator, just logout from the menu “Administrator 
> Logout”. 

• If you are already logged as an Operator or Approval, just log out from the menu “My 
Account > Logout”. 



 Qlever User’s manual  

 TMI-Orion  

 

___________________________________________________________________________ 
GDS/Documentation QLEVER EN 2.4.9.0 ed1.160  74/195 

• Type the identification and password in and click OK for login to the actual TDB 

• If you want to log in some other TDB, click the TDB icon to display the available TDB 
and just select the desired TDB. 

When logging out and logging in, the open files would be closed. 

The key symbol icon on the top right of the windows will give access to the same login 
function. 

2.6 Audit trail 

The system can track the actions by recording the following information: 

• Date and time with UTC (Universal Time Code) format. 

• The unique identification of the user. 

• The login of the user. 

• The account type of the user (Administrator, Approval or User). 

• An icon to have a quick view of the type of action (action on the software, the logger 
or a file). 

• Context of the action. 

• An icon for the command type (Modify, Create, Login, Start, Read, etc.). 

• An icon for the object related to the command (User, Logger, Setup file, etc.). 

• Detailed description of the action. 

• The reason for the action when available. 

• The initial value. 

• The value after modification. 

• The computer name. 

 

The color changes are shown in HTML format. 

There are three types of Audit trails: 

• Software Audit trail available to the Administrator account, from the 

“Administrator > Audit” menu (what is software is marked by  symbol and what is 
not software is displayed in gray. 

• Global Audit trail, related to every action, available to the Approval account from the 
“Audit Trail” menu. Only some specific actions related to the qle file would not be 
included and could be found in the QLE file Audit Trail. 
 

• QLE file Audit trail describing every action on a specific QLE data file, available to the 
Approval account from the “Audit Trail >Audi Trail – QLE file” menu. 
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In order to view or print one part of the Audit trail, you should type a start and end date and 
validate. 

At each audit trail impression, a notification is added in the audit trail but will be printed 
only if it is between the start date and the end date. 
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3 Setup mode (Pharma 21CFR) 

3.1 Prerequisites 

• QLEVER license with: 
o Pharma 21CFR secure mode option included  

• At least one temperature data logger 

3.2 Description of the setup option 

• The standard mode is the default and basic method for programming, starting and 
reading the loggers. 

• The Setup mode is a QLEVER option. With this option, the loggers programming, 
starting and reading method would follow a specific protocol and would lead to the 
edition of report. Such protocol is described in a secured Setup file. 

• In 21CFR mode (secure mode), the rights of the accounts of "operator" type can be 
changed by the Administrator. 

3.3 Create or modify a Setup File 

To create a new Setup file just click “Setup > New – Pharma”. 

• A setup is a description of a test that will be done with logger(s) in order to create a 
test report. 

• A setup file does not include the recorded data from the loggers. 

3.3.1 Description tab 

A Setup file will include general information to be specified in the description tab: 

• A name of the file. 

• A description of the file (do not print in the report if empty) 

• Details about the contractor who will handle the validation tests. The name of the 
contractor will be displayed in the header of the report. 

o Print in the report. 

• Details about the location of the test. 

o Print in the report. 

 If contractor and location are not printed, then the section is not printed. 

• Check the “keywords” box if you wish to update the serial number and the type of 
channel (temperature, pressure) used by the search engine (cf. 5.2 File research by 
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date or keywords) 

3.3.2 Process tab 

During the Process when the loggers are recording in a Setup Mode, it is possible to type the 
starting and end dates for the Stages. 

o Time Stamp:  

o Enable this function by checking the “Time Stamp” box. 

o Time:  
The time measurement base for such Time Stamp function could use either: 
o The PC clock. 
o The RTC USB dongle (for better accuracy and stability compared with the 

PC clock since some PC clocks could drift and get synchronized by the 
server). 
 Important note: when starting a process, the USB clock will be 
synchronized with the PC clock. In case you intend to start more than one 
processes, the Time Stamp function will use the last synchronization job. 

 
o Stages 1, 2, 3:  

• Enable or disable Stages 1, 2, or 3 according to the profile of the cycle. 
 

Icon :  
o Click the Icon: 

 in case the end date of a Stage is also the start date of the 
following Stage. 
 in case the end date of a Stage is separated by data acquisitions 

from the start date of the following Stage. 
 

Icon  : To erase all dates. 

 

During a Process, (available from the Read button or the Setup/Process menu),  button 
allows to manually time stamp the current ongoing Stage:  

▪ Start Date of the process (no obligatory entry): 

When the Process starts, click  or type a start date (corresponding to the start date 
for the printing of the data and graph in the “Print: Report” window).  

If empty, then this date is the start measurement date. 

 

▪ Stages date: 

During the Process, click  or type the start date and end date of a Stage. 

 Note that the start and end dates will be adjusted to the nearest logger 
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sample (no linearization). 

 In case a date is prior to the first data or greater the last one, the software will 
adjust the best. 

 

▪ End date of the process (no obligatory entry):  

At the end of the process, click  or type the end date of the Stage (corresponding 
to the end date of the data and graph in the “Print: Report” window) 

 

 To modify a started process, click “Read” in setup mode or click “Setup > Process”, and 
“Modify” button. 

 Once the data are later read with a QLE file, this section will not be available since the 
Process is finished. In case those dates need to be modified, it should be from the “Cycle 
» window. 

 21CFR: This tab can be hidden by the 21CFR Administrator. 

3.3.3 Parameters tab 

In this section, you will define the settings used for the report analysis. 

Ramp and/or equilibration time calculation/elapsed time: 

 V1 and V2 are in the stage 1 

 V3 and V4 are in the stage 2 

V5 and V6 are in the stage 3 

with Vn = V1, V2, V3, V4, V5, V6, for example Vn = V1 and Vn+1 = V2. 

 

▪ Ramp time (V1, V2; V3, V4; V5, V6): check the box to calculate the time difference 
between the moments when all the sensors reached the Vn and the Vn+1 values 
(except if “All sensors” unchecked for V2, V4, V6).  

o Vn and Vn+1 boxes must be previously checked to allow this calculation.  

o The calculation zone is included between the stage limits (start and end). 

Si Vn or the Vn+1 values are out of the stage limit, the calculation cannot be 
calculated. 

o If at least one of the sensors has not reached one of these values, the ramp 
time will not be calculated in the report  

o The reference sensor doesn’t affect the ramp time calculation  

o Such calculation is done in a linearization mode. 

▪ Equilibration time (V1, V2, V3, V4, V5, V6): check the box to calculate the period 
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between the moment when the temperature value Vn is first reached (first sensor to 
reach Vn value) and the moment Vn value is reached in all the load parts (last sensor 
to reach Vn value, except if “All sensors” unchecked for V2, V4, V6). Vn = V1, V2, V3, V4, 
V5, V6 

o Print in the report: The equilibration time can be calculated and display on 
the graph but it’s possible not to print equilibration time in the report. 

o Reference sensor: If a reference sensor is given, then it will be taken into 
account to determine the calculation of the start of the balancing time. 

• Only applies to V1, V3, V5 for the start of the equilibration time. 

• The end of the equilibration time V2, V4, V6 does not take into account 
the reference probe. 

o The calculation zone is included between the stage limits (start and end). 

o If at least one of the sensors has not reached this value, the equilibration time 
will not be calculated in the report, except if “All sensors” unchecked for V2, 
V4, V6. 

o The equilibration time can be calculated on V1 to V6 values. 

o The reference sensor doesn’t affect the equilibration time calculation (except 
the start of the balancing time if "Reference sensor" is checked). 

o This calculation is done in a linearization mode. 

o This calculation is made with temperature values rounded to two decimal 
places (while depending on the case, the graph may show more precision). 

Example of equilibration time in linearization mode. 

▪ Elapsed time (V2, V4, V6): check the box in order to calculate the various durations 
between the date when a first sensor reaches a temperature value V2, V4 or V6 and 
when the other sensors reach the same temperature value (except if “All sensors” 
unchecked for V2, V4, V6). Vn = V2, V4 or V6. 

o Equilibration time must be checked for the elapsed time calculation (you can 
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uncheck “Print in the report” if you don’t want print the equilibration time). 

o In order to enable such calculation, the equilibration time box should be also 
checked.  

o The calculation zone is included between the stage limits (start and end). 

o If a sensor reaches the Vn value before the start date of the stage, its status 
will be “Value not reached”. The Vn time stamp cannot be defined because the 
dating is out of the calculation zone. 

o In case a reference channel is selected, durations will be calculated based on 
this specific sensor reaching Vn. The reference sensor will show an elapsed 
time = 0, those reaching Vn before will show negative duration values and 
those reaching Vn after will show positive duration values.  

• If a reference channel is selected, elapsed time will be automatically 
displayed, because the elapsed time duration may be different to the 
equilibration time duration. 

 

o Such calculation is done in a linearization mode. 

▪ Calculations (ramp time, equilibration time, elapsed time): 

o All sensors (> V2, V4, V6): 

• Only V2, V4, V6 

• Checked (default value): In case one sensor did not reach such Vn 
temperature value, the elapsed time would not be calculated nor 
displayed in the report.  

• Unchecked: the elapsed time would be calculated.  

o Calculations without linearization: if this box is unchecked, the calculation 
will be based on the 
linearization of two values, as 
shown below: 

 

If this box is checked, as 
shown below: 

 

Default is unchecked. 

 
Define for each cycle: 
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▪ Stage 1: 

o Temperature V1 value and the color of the related horizontal line  

o Temperature V2 value and the color of the related horizontal line 

▪ Stage 2: 

o Temperature V3 value and the color of the related horizontal line  

o Temperature V4 value and the color of the related horizontal line  

▪ Stage 3: 

o Temperature V5 value and the color of the related horizontal line  

o Temperature V6 value and the color of the related horizontal line  

 

 

Within this window, the parameters for the analysis of the final report can be typed. 

Type the names for the Cycles and Stages in advance: 

▪ It is possible to type both the names for the Cycles and Stages in advance. Those 
names will later be found in the “Cycle” window of the QLE file. Otherwise default 
names will be created. 

▪ The various Cycles or Stages could not have the same name in order to avoid any 
confusion in the final report. For instance, numbers could be added to the name. 
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▪ Automatically define the Cycle1 Stage1 with the start and end date of the file. 

o If checked, then the following will happen (without the need to the “Define 
Cycle” windows): 

• The start date of Stage 1 will be the start date of the recording and the 
end date of Stage 1 will be the end date of the recording. 

• The other cycles and stages will turn grey 

 Once the data are downloaded, from the QLE file, this Parameter window will not be 
displayed. The information will be found on the “Cycle” window of the QLE file. 

 

3.3.4 Equipment tab 

A Setup file includes information related to the Equipment (typically Autoclave) under test to 
be specified in the Equipment tab: 

• Equipment ID 

• SOP/Protocol (do not print in the report if empty) 

• Description of the load (do not print in the report if empty) 

• Comment (do not print in the report if empty) 

• Picture of the equipment can be added 

3.3.5 Logger tab 

A Setup file includes information related to the TMI dataloggers used for the test. 

Add or remove serial numbers for the loggers to be used for the Setup. This can be using an 
automatic scan of logger(s) connected to the interface or selecting manually specific loggers 
with their calibration files stored in the TDB. 

 

 Used sensor for humidity calculation. To calculate the dew point, and generate the 
calculated humidity channels, you must use: 

• One temperature sensor 

• One humidity sensor 

  See Analysis / Humidity calculation / Include in calculations 

 Warning, if “Humidity calculation” is not checked in Analysis tab, this setup column is 
grayed in the data qle file. 
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For example, for a base pair Tr0 Temperature and humidity Hr0, often at the center of the 
room, it is possible to generate the dew temperature and generate the relative humidity 
calculated channels Hr1 to Hr8 for all other temperature sensors Ts1 to TS8. 

 

  Reference sensor: it’s possible to select a reference sensor by checking the box. This 
reference sensor will be used for various calculations for the test: 

▪ Min. and max. Spread  

▪ Elapsed time (parameters tab) 

 This reference sensor can’t be used for the humidity calculation. 

Not used: option not to use this sensor, ie: 

▪ The sensor will not appear in the data columns or curves QLE 

▪ The sensor will not be taken into account in the calculation of setup 

▪ The sensor will not generate computed columns (unless used in the calculation of 
humidity) 

▪ The sensor will not be notified in the excluded channel list report 

▪ The sensor will not be visible on the loading plan 

▪ The internal channel is automatically unused with a Vacq 

▪ This feature can be activated before starting the setup (if you do not want to use 
a route once the data read back then since QLE data file, it must be excluded) 

 Beyond 70 sensors, the new will be added not visible by default to reduce the graphic 
processing time and not to obstruct the visibility of the loading plan. 
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Enable loggers to be excluded during startup (no checked as default): in the “Starting 
loggers” windows: 

• Display an “Exclude” menu. 

• Enable Qlever to exclude the missing loggers. 

 Excluded loggers will be written in the 21CFR audit trail and the report. 

 

3.3.6 Programming tab 

A program is part of the Setup file. 

▪ Add one or more programs clicking “Programming” (cf. 2.3 How to program the 
loggers) 

▪ Delete a program using the “–” button. 

▪ Edit a program using the  button. 

▪ Link a program to logger(s) using the “+” button. 

▪ Unlink a program from logger(s) using the “–” button. 

A message would warn you whether a logger is not linked to any program. 

3.3.7 Sensor positions view tab 

From this tab, you can describe the position of the sensors inside the chamber using either a 
picture or the 3D view: 

▪ For every sensor you can give a description of the position. 

▪ Check or uncheck the box from the blue tag column to show or hide the sensor in the 
picture or 3D View (a menu by right clicking on the column allows for additional 
options for selection). 

▪ You can click and drag the blue tag showing a sensor within the picture or the 3D 
view. 

▪ Possibility to display only the number of the logger in the loading plans (when the 
quantity of loggers used is large it’s very difficult to identify a specific logger’s 
position on the diagram). 

 If any sensor is visible, then the loading plan will not be printed in the report. 

You may add 9 additional pictures of the cycle parameters. 
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3.3.8 Analysis tab 

The Analysis tab allows you to define both the lethality calculations parameters and the 
conditions for triggered events. 

Results will be displayed both in the report and the data file. 

Two calculations possible: 

• Lethality type calculations are available. 

o F0/A0/C0… type of calculation: enable or disable this calculation (default 
value = yes). 

o For each calculation, you can set a triggered event. 

▪ This calculation is done on the whole cycle (not for each stage). 

▪ Reset value for each cycle 

▪ Channel name is F0[F1] for the formula #1 and F0[F2] for the formula 
#2 

• Or a Mean Kinetic Temperature (MKT) calculation 

o Check the box to perform MKT calculation. 

o Enter ΔH value. 

o Choose MKT unit temperature. 

• Two other temperature triggered events possible. 

o In the report: 

▪ In the data, e1/e2 will be displayed when the event occurs. 

▪ In the Event summary, the value of occurrence in the total number of 
times the event occurs. 

• Temperature calculation of saturated steam (Regnault) 

• Pressure calculation of saturated steam (Regnault) 

• Time above or time below: duration above or below a value of temperature. Choose 
don’t display in case it should not be in the report.  

o Comparison operator used: 

▪ Time above > threshold. 

▪ Time below < threshold. 

o For temperature channels, only. 

o This calculation is made without linearization, so make sure the sample rate 
you select for the programming of the loggers is relevant when it comes to 
validate your equipment and/or your process cycles. 
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o The displayed result is the longest duration only (smaller durations or 
overshoots/undershoots would be excluded). Thus, such calculation is specific 
to the Pharma Setup and different from “Time above” or “Time below” 
calculations found elsewhere in the software. 

o Such calculation is made within each step only. Meaning it is not made 
between two steps or outside steps. 

o In the report, in the “Total” column, we display the sum of every “Time 
above” or “Time below” durations of every defined step. Not the total “Time 
above” or “Time below” of the entire cycle. 

 

     Time above 

• Humidity calculation (a temperature channel and a humidity channel used as a 
reference for calculated humidity channel, specified on “loggers” tab). 

o Temperature: include in calculations or not 

o Humidity: include in calculations or not 

Include in report calculations:  

• If checked, temperature and/or humidity channel is used for the setup 
calculations (Min, Max, Avg and others) 

• If not checked, the temperature and/or humidity channel is not used for 
the setup calculations, and the associated column is grayed out in the qle 
data file. 

 This calculation generates humidity calculated channels. 

• Possibility to print or not in the report: 

o Min. and max. of each stage 

o Average of each stage 

o Max average – Min average of each stage 

o Max. range of each stage 

o Max. spread of each stage 

o Min. spread compared with the reference channel of each stage (printed out 
if a channel was selected) 
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o Max. spread compared with the reference channel of each stage (printed out 
if a channel was selected) 

o F0 or MKT min and max of each stage 

o F0 or MKT average of each stage 

• Do not display the calculated columns until the cycles are defined (not checked by 
default): to avoid calculated columns creation before the cycles are defined. 

 Reduce the computation time 

 21CFR: Some settings can be hidden by the 21CFR Administrator. 

 

3.3.9 Report tab 

Top right part of the report can be chosen to be either: 

▪ Contractor details (logo and address) 

▪ Comment (a text zone for comments or a specific document reference) 

3.3.10 Print a Setup 

Click “Print” to print a description of the Setup. 

3.3.11 Save a Setup 

Click “Save” 

When creating a Setup: 

• Specify a directory inside the TDB for saving the Setup file. 

• Name the file.  

• Click “Ok”. 

3.3.12 Save as…  

Click “Save as” save a copy to a new setup 

• Specify a directory inside the TDB for saving the Setup file. 

• Name the file.  

• Click “Ok”. 
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3.3.13 How restart the calculations of the report results from a QLE 
file 

In the Setup windows, click on “Calculations" to restart the calculations of all the results of 
the report. 

3.4 Open a setup file 

To open a setup file, click “Setup > Open”. 

In case you would like to open and/or edit a Setup file that was previously used to create a 
QLE data file, you should open the QLE data file itself then click the “Setup” button. 

3.5 Start a Setup 

In order to start a Setup, click “Setup > Start”. Select a Setup file from the list and click 
“Start”. 

Starting the logger(s) in a Setup mode is the same process as the Standard mode (cf. 2.4 Start 
the loggers) 

The loggers serial numbers defined in the Setup will need to be connected to the interface 
when starting. The system will scan and check. 

To exclude a logger, select this logger and click right, choose “Exclude”. 

Exclusion of a logger from the study 

To exclude a logger from the study, select this logger and click on the “Exclude” 

button  or click on the right button, then select "Exclude". You can select more 
than one. The exclusion will be reported in the report and the audit trail. 

Only if “Enable loggers to be excluded during startup” in the Loggers tab of the 
Pharma setup is checked. 

Start date 

To avoid interpolation of the data, it is not possible to start "Now" with several 
loggers. 

Options 

Some options such as message display or value display are configurable in user 
preferences. 

Hygrometer 

If a hygrometer is used as a reference for calculated humidity channel a specific 
window will be open to control this equipment. 

 Quit allow to stop the hygrometer data acquisition and close the windows. 
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After starting, the Setup file is copied in a Process file. 

The Process file is independent from the earlier Setup file. 

3.6 Read a Process 

In order to read recorded data from the logger(s) on a Setup mode, click “Setup > Read”. 

Reading the logger(s) on a Setup mode is the same process as the Standard mode (cf. 2.5 
Read the loggers). 

The loggers serial numbers defined in the Setup will need to be connected to the interface 
when reading. The system will scan and check. 

In case one logger could not be read for instance because of low battery, it will be possible to 
exclude this specific logger from the data file. 

 Exclude a logger 
To exclude a logger, select this logger and click right, choose “Exclude” or clic on 
“Exclude” button. 

With FullRadio loggers, it is possible to read running loggers (non-read loggers will be 
automatically excluded from the study). 

If a hygrometer is used as a reference for calculated humidity channel a specific the 
hygrometer data are automatically saved. 

3.7 Delete a Process file 

In order to delete a Process file, click “Setup > Delete Process”. 

From the TDB, select the Process file, do a right click and go to “Delete”. 

Deleting a Process file is irreversable (the file won’t be found in the recycle bin).  

3.8 Cycles definition for the Report 

Open a QLE data file (cf. 3 QLE data files) and select a QLE data file created with the Setup 
mode. 

3.8.1 Add a Cycle 

For every stage of every cycle, select the start and end times.  

Click the “Cycle” button or do a right-click from the graph and go to “Define Cycles”. 

• Type the name of Cycles, the start and end time and color for every stage.  

• Print the graph column: if checked the graph of the stage will be printed (default 
value=yes). Saved only if the stage dates are defined. 
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Then click “Validate”. 

Cycles and stages calculations are without linearization: it’s not possible to set 
a date between two measurement points. 

If the end time of a stage = the start time of the next stage: 

• The data will be common to both stage 

• The data will be taken into account for each calculation of the 
two stages. 

  

The following will appear: 

• On the top of the graph, the stages for every cycle are displayed. 

• In the Cycle tab, the stages of every cycle are displayed. 

• In the Min/Max/Avg tab, the results of various calculations for each stage such as: 

o Minimum, maximum, average and standard deviation calculated on one 
sensor. 
(Note that “m” stands for minimum average and “M” stands for maximum) 

o Minimum value of every above minimum values (min. of min.). 

o Maximum value of every above maximum values (max. of max.). 

o Maximum range between the min. of min. and max. of max. 

o Maximum spread with a reference sensor at a specific time 
(calculated if reference sensor is selected). 

o Minimum spread with a reference sensor at a specific time 
(calculated if reference sensor is selected). 

o Maximum spread between any sensors at a specific time. 

According to “Print in the report” to the Analysis Setup tab. 

3.8.2 Delete a Cycle 

Go to the Cycle tab, select a cycle and click the “–” button. 

3.8.3 Modify a Cycle 

To modify a cycle or a stage, go to the Cycle tab, select a cycle and click on the edit column or 
click the “Cycle” button. 

3.9 Exclude a sensor from the calculations and analysis 

To exclude a sensor, click on the column header of the data table. 
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3.10 Display or print a measurement Report 

Two possible scenarios: 

• Existing Report: Use the “File > Open” menu and select a Report file from the TDB 
and double click or right-click and go to “Open”. 

• The report is to be created. 

Open a QLE data file created with the Setup mode. 

If cycles and stages are already defined, click the “Report” button to preview the 
report. 

Once you close the preview, you can type a name for the report and save. 

Choose your print out mode: 

• Save as: allow to save the report in the QLEVER TDB without preview and 
print. 

• Default printer: allow to print on the windows default printer without preview. 

• PDF: allow to export the report to PDF format. 

• Open the preview: allow to see the report before print. 

  

You could choose to print one or every of the following: 

• Parameters 

o Display signature or not 

o Display signature only on the first page 

o The graph with background color, and: 

▪ Large: large size on a whole page only 

▪ Small + large: small preview in first page + large size on a while 
page 

o The graph of each stage selected in Cycle window 

o The legend 

o Zones: summarizing table including manually added zones. You can print 
details of every zone manually added by the user (“Cycle” tab on the left 
of the graph). Cycles/zones automatically created by the setup are not 
printed out in “Zones”, as they already appear in other report sections. 

• Options 

o Page break between each section of the report 

• The comment of the QLE file 
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• Data of every column: 

o 2 forms of table are available: 

▪ One table: like as the “Data” table in the QLE windows. The 
measured data channels and the calculated channels are in a single 
table. 

▪ Multiple tables: 

• First, the measured channels table (loggers) 

• And, as many table as calculated channel types. 

For example: the loggers channels, the F0 channels, the 
Saturated steam channels 

o Default Data mode  

▪ Printed data description: 

• Only cycles and stages are printed 

• The data between two steps are not printed 

• Stage start date and stage end date number are printed 

• Event column: 

o S = Stage start date (cycle:stage) 

o E = Stage end date (cycle:stage)  

o e1 = event #1 (see setup) 

o e2 =event #2 (see setup) 

o Date and hour column 

o Logger column 

▪ Channel colour, serial number, physical unit, 
channel name   

o Condensed data on 25 columns with calculation (min., max., avg., max-
avg, avg-min…) 

▪ Choose a physical property for the statistics (temperature, …) 

▪ Adding or not statistics (min., max., avg…) 

▪ Printed data description: 

• Stage start date and stage end date number are printed 

• Date and hour column 

• Logger column: 

o Channel colour, channel number, physical unit 

o Statistics for each line: 
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▪ Min. value (optional) 

▪ Max. value (optional) 

▪ Average (optional) 

▪ Max. – Min. (optional) 

▪ Avg. – Min. (optional) 

▪ Max. – Min. (optional) 

▪ Event e1 and e2 

o Print all lines or one line out of x: 

▪ Hidden data channels are printed in the report. 

▪ Excluded data channels are not printer in the report. 

o Print data: 

▪ Cycle/stage 

• Only cycles and stages are printed 

• The data between two steps are not printed 

▪ Start date to End date 

• Not possible to “cut” a cycle/stage 

• The data between two steps are printed 

• The detailed report (average calculation, standard deviation calculation, minimum 
and maximum value calculation for every sample). 

o Printed data description: 

▪ Only cycles and stages are printed 

▪ The data between two stages are not printed 

▪ A table for each physical unit 

o Calculation of 
0

30 FF −  is displayed in the summary report. 

 

• Loading plan in small and/or large size on a whole page. 

• Picture of the equipment 

• Screen shots (if you do not wish to print a screen shot, go to the “Screen shot” 
tab and uncheck “Print in the report”). 

• Min./Max./Avg. statistics of Data Analysis tab 

o Setup calculations automatically generated by the setup. 

o User calculations: calculations manually added from “Data analysis” tab, 
button “Modify”. See “Data analysis” paragraph. 
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o Page break between each table: if you want to get your report more 
readable, it is possible to separate each Min./Max./Avg. calculation with a 
page break. 

• Logger included in the study: 

o Loggers configuration date 

o Loggers firmware version 

 

Only the Approval users can save reports. 

3.11 Approve a Report 

Two possible scenarios: 

• Existing Report: Use the “File > Open” menu and select a Report file from the TDB. 
Then click “Approve” button. 

• The report is to be created. 

Open a QLE data file created with the Setup mode. 

If cycles and stages are already defined, click “Approval” button. A preview of the 
report will show up. 

Once you close the preview, you can type a name for the report and save. You can 
then confirm the approval of the report. 

Approved reports show a V sign on the icon for “Validated”. 

Only the Approval users can approve reports.  
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4 Calibration/Adjustment Temperature Mode 

4.1 Prerequisites 

• For the automated mode, in order to run the calibration hardware with RS232 
interface, the PC should include a minimum number of one or two serial RS232 ports 
with SubD 9 or USB/RS232 convertors. 

• A crossed RS232 cable if the hardware is RS232 

• Microsoft© .NET Framework 3.5 installed 

• QLEVER License key: 
o With manual only calibration option 
o With automated & manual calibration mode 

• For the automated mode, the automatic send of data should be disabled. 

• Only use temperature loggers (don’t use humidity or pressure or another logger) 

• The Internal channels of the TMI loggers (T internal) can’t be adjusted, only “as 
found” and “as left” (but possible in Expert Mode) 

4.2 Description of the Calibration/adjustment option 

With the QLEVER Calibration option, it is possible to automatically generate temperature 
step points with direct communication with the calibration equipment. The values of the 
reference probe for each calibration step would be read for a specified duration through 
direct communication with the calibration instrument (temperature reference probe). The 
temperature values of the reference probe and every starting time and dates for every 
temperature steps are recorded in different files. Typing the data manually by the operator is 
also available in case the calibration hardware equipment is not compatible with direct 
communication. 
With the QLEVER Calibration option, it is also possible to calibrate and adjust the loggers.  
 
The adjustment applies a transfer function between raw values given by a logger (values I bit 
from the converter) and the measured values in temperature. 
The calibration indicates the gap between the reference values within a comparison 
environment like a calibration bath or drywell and the values given by the logger within the 
same comparison environment. 
When used with the Secure Mode option, a calibration audit trail is created. 

4.3 How to install when using the automated mode 

Connect the equipment (bath or drywell) to one of the serial ports of the PC. Connect the 
reference probe to the other serial port of the PC. Special serial cables must be used. 
Follow the instructions given by the manufacturer when installing the equipment or 
reference probe. 
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4.4 Type of equipment and instruments 

• Bath® from Hart: 7321, 7381 and 73xx, 633x, Micro-Bath 6102, 7102, 7103. 
• Bath® from Lauda: RC20, RC25 and Proline series. 
• Hart® Scientific (Fluke) 9172, 917x and Fluke 914x 
• Hart® Micro-bath 6102 (Fluke) 
• Hart® Dry well temperature calibrator 9127 (Fluke). 
• Fluke® 9190A (ultra-cool dry-block calibrator) 
• Jofra® (Bath Mode et Dry-Block Mode) RTC-158, RTC-159 
• Votsch® VT serie (adress 1) 

• Sika® TP Solid, TP premium (micro-bath TPM255S, TP37166E.2, TP17650,… ) 

• Wika® (micro-bath CTB9100) (Choose Sika in the Qlever list) 
 

• Readout from Hart®: 1502A, 1529 and Black Stack 1560 (with the 2560 module). 
• Readout from AOIP®: PHP601 and PHP602 (reference probe on the channel 1/A). 
• Readout from Fluke®: 1521, 1523 and 1524. 
• Jofra® probes. 

 
For Climatic Test Cabinets, Calibration/Adjustment in expert mode is mandatory (cf. 
9.3.1Type of equipment and instruments). 
 
If you want to communicate with an equipment via a RS232 serial port, you have to configure 
communication with suitable options described in section Hardware configuration of 
supported calibration . 
 
Important notice: 

• Only turn the calibration bath on when it contains the heat transfer fluid. 
• For Hart® baths with refrigeration group, properly commute both switches (on/off 

switch and the Cooling switch). 
• The calibration instrument must set with no auto power off (auto shutdown OFF) and 

without stamp data (no automatic data transfer via RS232). 
• For Jofra®, select the type of the set point probe. 
• For Votsch®, the adress is 1 (OP3 = 1 in menu) 
• For SIKA®, use the cable provided by SIKA®. 

4.5 Description of the calibration/adjustment process 

• Temperature Step Setting: 
o Description of the hardware that would be used for the 

calibration/adjustment 
o Selection of the automated mode for the hardware 
o Define the temperature setpoint and the measurement duration 
o Create the DEFPAL file 

• Programming and starting of the dataloggers under test. 
• Temperature Step Generating: 
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o When in the automated mode, the sequence of setpoints would be generated 
automatically. 

o When in the manual mode, the operator would need to type the values 
displayed by the temperature calibration instrument.  

o Create a GENPAL file. 
• Stop and read recordings from the dataloggers. 
• The Step analysis: 

o Analyze the results from the temperature steps 
o Print a calibration report before adjustment 
o Adjust the logger(s) if necessary and print a calibration and adjustment report. 

4.6 Step Settings 

Click “Logger > Calibration > Step Settings” or open or create a new DEFPAL file from the 
Directory Management (TDB). 
 
Description 

• Shows the name of the file DEFPAL 
• Shows the comments like description of the file or the protocol 

 
Hardware 
 
Calibration equipment: 

▪ Type the model name of the calibration equipment (could be a calibration 
bath, drywell, climatic chamber, oven, etc.). Such information will be 
displayed in the calibration report. 

▪ Type the serial number of the calibration equipment. Such information will be 
displayed in the calibration report. 

▪ Type a description allows to record any information that the operator would 
like to flag. 

▪ If automated mode is checked, select the model from the list. This checkbox 
allows to choose between the automated and manual mode. 

▪ Select the COM port number: drop-down menu allows to select the serial port 
the device is connected to. 
▪ Important: Don’t select this port (or another calibration probe or 

equipment) as interfaces in the “Configuration, Communication port 
configuration” menu. 

▪ Attention the communication ports used by the TMI-ORION interfaces 
are grayed out. 

The Cooling mode checkbox is used to optimize the cold unit management for 
FLUKE® or HART SCIENTIFIC® baths. 
When on automated mode, the cold unit of these baths is not triggered above a 
certain threshold.  
If the setpoint temperature of the step to be performed is higher than that of the 
previous step, and the setpoint temperature is very close to the default trigger 



 Qlever User’s manual  

 TMI-Orion  

 

___________________________________________________________________________ 
GDS/Documentation QLEVER EN 2.4.9.0 ed1.160  98/195 

threshold of the bath cold unit, it may take a very long time for the bath to reach 
its setpoint temperature. To solve this problem, a new trigger threshold may be 
set for the cold unit in the Seuil (Threshold) text field. 
 

Calibration standard probe: 
 

▪ Type the model name of the calibration instrument (reference probe). 
▪ Type the serial number for the instrument 
▪ Type some description 
▪ If automated mode is checked, select the model from the list. 
▪ Select the COM port number. 

▪ Important: Don’t select this port (or another calibration probe or 
equipment) as interfaces in the “Configuration, Communication port 
configuration” menu. 

▪ Attention the communication ports used by the TMI-ORION interfaces 
are grayed out. 

▪ Select the channel number if more than one 
▪ Offset ±: Correction value for the standard probe with automated mode only. 

 
Test 
Click Test to test the communication with the equipment and instrument (automated mode 
only). 
 
Steps 
From the Step sheet of the Step Settings Windows, select the number of Steps and type the 
details for each step: 

• Step Numbers is displayed in the list 
• Type the temperature set point 
• Type the duration for the stability 
• Type the duration for the measurement 

The unit for the duration for the stability is minutes. It is the elapsed time before any 
measurement on the temperature step. Once the temperature of the bath or any other 
equipment equals the setoint, the measurement will start after the stability duration. This 
duration allows perfect stability and homogeneity before measurement. Default duration is 
set to 30 minutes 
The unit for the duration of the measurement is minutes. It is the duration for which the 
calibration instrument like the reference probe will be recorded (after stability). Default value 
is 3 minutes. 
When no automated standard probe mode, in case you prefer one single reading of the 
standard probe at one chosen moment, select Measurement date from the list. 
 
“When the process is over, reset the equipment to” text field allows to define the 
temperature at which the calibration bath or oven should be reset at the end of the 
calibration cycle. 
To add or remove steps, modify the number of steps from the list using the selection box on 
the top of the window. 
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Example of a Step Setting: 
 

# Step (°C) 
Stability duration 

(min) 
Measurement duration 

(min) 

1 0 30 3 

2 30 30 3 

3 60 30 3 

4 90 30 3 

5 120 30 3 

6 140 30 3 

 
Configuration 
 
Beginning of the stabilization time  
Once the setpoint temperature is reached, you may wait for the temperature to be stable 
within a defined tolerance band before the stabilization time can start. 
Such process guarantees the measurement reliability (since the equipment temperature 
probe is read, this process is activated in equipment automated mode only). 
e.g.: If an overshoot occurs at a 50 °C plateau, the temperature will slowly decrease in case 
the cooling mode is not activated. If such duration (when temperature is decreasing) is 
longer than the stabilization time, measurements will be made although the temperature is 
not fully stable. This stability test is performed only before the stabilization time. 
 
Parameters: 

• “After” n seconds: time delay before the software starts and checks the 
temperature value is included in the tolerance band. This parameter must 
be set according to the equipment performances. 

• Tolerance ±: after such time delay, the software checks and waits for the 
equipment temperature to be within this tolerance band. 

 
To disable this checking process, type “0” second in the “After” field. 

 
 
Polynomial 

• A table allows the creation of a polynomial correction for the standard probe. Such 
table applies to every Step Settings files (.delpal). 

In case no polynomial correction is needed, do not type in anything. 

o “Serial number” column: type in the serial number of the standard probe. It 
should be the exact same as typed in the “serial number” field for the 
Standard probe in the “Hardware” tab. 
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o “Name » column: type in a name for the polynomial. 
o “Polynomial” column: type in a name for the file that includes such 

polynomial. 

o Modification button : will open the window where the values are typed in 
for the polynomials creation and edition (see further down for details). 

o “Certificate” column: type in the calibration certificate number for the 
standard probe. 

o “Configuration date” is the date of the certificate of the standard probe 
including the “warning” icon. 

o “Description” icon: type in a text for description. 
o “By” column will display the user name 
o “Last modified” column will display the date of the last modification. 

• “+” or “–” buttons would add or delete rows within the table. 
• “Save” button will save the typed in data. 

• Click the Modification button  within the “Polynomial” column in order to create 
and edit Polynomials. 

o The “New” button created a new table. 
o The top table is for typing in the data given by the calibration certificate of the 

standard probe. 
▪ Press the “+” button to add a calibration step point. 
▪ Uncheck the box if the value is positive (true temperature above zero) 
▪ Type in the true value. 
▪ Type in the read value. 
▪ The error is calculated = True value - Read Value (for compatibility 

with XETAL software). 
o The “+” or “–” buttons add or delete a row from the table. 
o You must enter 3 lines with negatives values and 3 lines with positives values. 
o The “Polynomial function calculation” button calculates the polynomial based 

on the above data. 
▪ The first line is the creation date. 
▪ The 3 following lines are the coefficients for the first polynomial (for 

the negative values). 
▪ Line #1 = c 
▪ Line #2 = b 
▪ Line #3 = a in y = ax² + bx + c  

▪ The 3 others are the coefficients for the second polynomial (for the 
positive values). 

 There must be 6 lines, the first 3 are checked (any other combination is 
not possible). 

o The “Import” button would import a TXT file that includes both polynomials 
in an ETA format for compatibility with XETAL software. 

o The “Save” button saves all the typed data within this window. 
o The “Exit” button closes the window. 
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For example: 
 

≤ 0 Read value (°C) True value (°C) Error (°C) 

X -79.998 -80.000 -0.002 

X -54.995 -55.000 -0.005 

X 0.000 0.000 0.000 

 -0.001 0.000 0.001 

 70.006 70.000 -0.006 

 139.976 140.000 0.024 

 

Click Save to save the DEFPAL file. 

4.7 Step Generating  

Prerequisites: 
• A Step Setting DEFPAL file should exist. 
• The dataloggers should be programmed and already started (cf. 2.3 Program the 

loggers). 
o The rate is generally between 5 and 10 seconds. 

• The dataloggers should be placed inside the calibration equipment. 
• Switch the calibration equipment on. If this is a calibration bath, it should only be 

switched on when filled with calibration fluid. Commute the cooling mode switch. 
Switch the temperature instrument on and put it inside the calibration equipment. 

• Make sure the computer is NOT synchronized with an external clock (network, 
internet time server...) during the calibration process. 

• With an automated standard probe, the loggers MUST be started on the computer 
which runs the step generation (otherwise the measurement start dates of the 
loggers and the standard probe will be out-of-sync). 

•  
Automated equipment and the standard probe mode: 

• The QLEVER software can automatically generate the calibration steps. 
• Once the hardware is ready, confirm the start of Step Generation. 
• For every step, the QLEVER Software communicates with both the equipment and 

instrument to generate step, and reach the setpoint temperature. Measurement 
starts when the equipment temperature is stable. 

• The measurement frequency of the standard the standard probe varies from 3 
seconds to 9 seconds depending on the brand and model of connected standard 
probe connected. 

• Every step for such process is displayed real time on the screen. 
• Values measured by the standard probe are displayed real time in the “Standard 

probe” tab. 
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▪ Description of stages :  
o Click on “Logger/Calibration/Step generation” menu, open the step settings 

file DEFPAL and confirm by clicking “Yes”.  
o QLEVER configures the standard probe in automated mode.  
o QLEVER configures the equipment in automated mode.  
o For each step:  

▪ QLEVER sets the equipment to setpoint temperature.  
▪ QLEVER starts the stabilization time countdown.  
▪ QLEVER records values from the automated standard probe during the 

measurement period.  
▪ Once the measurement period is completed, QLEVER calculates the 

mean, min., max. and standard deviation. 
o End of step generation. 

 
Note: When the stabilization time ends, the measurement starts, so both dates must be 
equal. 
 
Automated equipment and manual standard probe mode: 

• For every step, the operator should type the exact start date for the first temperature 
readout together with the average temperature value given from all the values taken 
during the measuring duration. 

• Min., max. and standard deviation values entry is optional. 
• Click “Save” for recording. 
• Description of stages:  

o Click on “Logger/Calibration/Step generation” menu, open the step settings 
file DEFPAL and confirm by clicking “Yes”.  

o QLEVER configures the equipment in automated mode.  
o For each step:  

▪ QLEVER sets the equipment to setpoint temperature.  
▪ QLEVER starts the stabilization time countdown.  
▪ Wait until the stabilization period ends.  
▪ QLEVER displays “Reading in progress”.  
▪ Click “OK” and note the values measured by the manual standard 

probe.  
▪ QLEVER starts the measurement period countdown.  
▪ Once the measurement period is completed, calculate the mean of 

your measured values. Place it in the appropriate step line in QLEVER 
“Standard Probe” tab.  
Min., max. and standard deviation values entry is optional. 

o End of step generation.  
o Click on “Save”. 

 
Manual equipment and automated standard probe: 

• The operator should synchronize the software with the equipment to get the same 
stabilization time. 

• Description of stages :  
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o Click on “Logger/Calibration/Step generation” menu, open the step settings 
file DEFPAL and confirm by clicking “Yes”.  

o QLEVER configures the standard probe in automated mode.  
o For each step :  

▪ QLEVER displays the message “Put the set point of the equipment to 
x °C”  

▪ Set your equipment to the requested set point temperature.  
▪ Go back to QLEVER, then click “Yes”.  
▪ QLEVER starts the stabilization time countdown.  
▪ Once the stabilization period is completed, QLEVER starts recording 

values from the automated standard probe.  
▪ QLEVER records the values during the measurement period.  
▪ Once the measurement period is completed, QLEVER calculates the 

mean, min., max. and standard deviation. 
o End of step generation. 
 

Manual Equipment and Standard Probe mode: 
▪ The operator should monitor the setpoint temperatures and stabilization times of his 

equipment. 
▪ The user MUST note the first measurement exact start date from the computer clock, 

or synchronize the probe time with the computer clock (otherwise the measurement 
start dates of the loggers and the standard probe will be out-of-sync). 

▪ For every step, the operator should type the exact start date for the first temperature 
readout together with the average temperature value given from all the values taken 
during the measuring duration. 

▪ Min., max. and standard deviation values entry is optional. 
▪ Click “Save” for recording. 

▪ Description of stages:  
o Click on “Logger/Calibration/Step generation” menu, open the step settings 

file DEFPAL.  
o QLEVER displays the steps table  
o For each step:  

▪ Set your equipment to the requested setpoint temperature.  
▪ Wait until the stabilization period ends.  
▪ From then and during the measurement period, note the values 

measured by the manual standard probe.  
▪ Once the measurement period is completed, calculate the mean of 

your measured values. Place it in the appropriate step line in QLEVER 
“Standard Probe” tab.  

▪ Min., max. and standard deviation values entry is optional. 
o End of step generation.  
o Click on “Save”. 

 
Save: 
The data is recorded in a Step Generating GENPAL file. The name of the file is just the same 
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as the Steps Setting DEFPAL file that was previously selected. 
The default directory is \Calibration. 

4.8 Steps Analysis  

Calibration and/or Adjustment can be done using the window based on the earlier GENPAL 
Step Generating file. 
Prerequisites: 

• One or more existing GENPAL Step Generating files. 

• When in the automated mode, the dataloggers should have been stopped and with 
data downloaded within a QLE file(s). 

Click “Logger > Calibration > Steps Analysis”. 
For each step: 

• The value for the calibration instrument is the reference value. 

• The value from the channel f the data logger to be calibrated/adjusted is the readout 
value. 

• The error is the difference between both the above values. 

4.8.1 Files 

Open a Step Generating file. 

• Select one or more GENPAL Step Generating files 

• For every file, the table will show the name of the file and the GUID, the name of the 
equipment, the name of the instrument and for every step, the date of the 
measurement, the duration of the measurement as well as the readout. 

• Click “-” to remove a step from the list 
Open a QLE data file 

• Select one file with recordings from datalogger(s), or merge all qle files (before the 
“Steps Analysis” screen, open all QLE files and “Edit” menu, “Merge the open files” 
menu, close all files if opened). 

• For every file, the table will show the name of the datalogger, the name of the file 
and the GUID, the start and end date for recording as well as the date for the 
configuration file for the specific logger. 

• Click “– ” to remove a logger from the list. 

Don’t use qle setup file for the calibration. 
 
Open a CET/CETX configuration file 
It is possible for the operator to type the values from the channels of the datalogger rather 
than using QLE file. 

• Select one or more CET configuration files. 

• For each file, the table will display the name of the datalogger, the name of the file 
and the date of the configuration file for this datalogger. 

• Click “–” to remove a datalogger from the list. 
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Check the box “Report: Creating a single file containing all the data loggers” to create a 
calibration/adjustment report including: 
▪ a max. deviation calculation (max Δ between each channel value and the standard probe 

value). 
▪ An acceptance criteria before adjustment. 
▪ An acceptance criteria after adjustment. 
▪ All loggers data and standard probe values recorded during the measurement time of 

each step.  
 
Checking the “Report: Components of uncertainty” check box will lead to a detailed 
calculation of the expanded calibration uncertainty (U) (only available with the automated 
calibration mode). 
 
Validate and check the files selection when clicking “Next”. 

4.8.2 Steps Analysis table 

For every datalogger, the table will display: 

• The serial number for the dataloggger. 

• The names of the temperature channels. 

• The values of the temperature steps. 

• The date of the readout from the reference sensor. 

• The average value from the readout of the reference sensor. 
o The average is calculated with unrounded values of the reference sensor while 

the measurement time. 

• The average value from the readout of the temperature channel of the datalogger. 
o The average is calculated with unrounded values of the datalogger channel 

while the measurement time. 

• The error that would be the difference between both above values. 

• The minimum, the maximum, the max-min and the standard deviation of the 
reference sensor. 

• The minimum, the maximum, the max-min the standard deviation and the number of 
acquisitions of the temperature channel of the datalogger. 

• If the “Report: Creating a single file containing all the data loggers” box was 
checked: 

o A max deviation calculation (between each channel value and the standard 
probe average value). 

o The max deviation date (logger date). 

• The number of acquisitions during the measurement time. 

• If the “components of uncertainty” box was checked, then: 
(Components of uncertainty” for a detailed calculation of the calibration expanded uncertainty (U)) 

o Type in the value of uncertainty related to the logger (ue). 
o Type in the value of uncertainty related to the standard probe (us). 
o Display a column calculates the standard deviation of the error (uj). 
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o Display the result:  the expanded (calibration) uncertainty (U) calculated as 
follows: 

( ) ( ) ( )222

jse uuukU ++=  

With k = 2; ue = uncertainty related to the logger; us = uncertainty related to 
the standard probe; uj = standard deviation of the error (for each acquisition, 
standard deviation of [ probe value – channel value]). 

• If the “components of uncertainty” box was not checked, then an icon “Apply to all” 
will appear next to the uncertainty (see the bottom of the windows). Such button 
icon will duplicate the value of uncertainty into the entire column “Uncertainty °C”. 
 In this case, this value is the expanded uncertainty (U) of the logger. 

 
From the left: 

• It is possible to select the dataloggers or channels using the box. At this stage, it is 
not possible to remove a temperature step. 
For example: uncheck all not used channels for a thermocouple. 

 
From the bottom part of the window, it is possible to: 

• Type the uncertainty of the dataloggers. 

• Check the box so the software selects the channels of the dataloggers related to the 
chosen value in ± °C. 

• Check the box to allow export of the data to a text file. 

4.8.3 Edit the calibration values 

Click on the column to type or edit the calibration values: 

• Date and time of measurements. 

• Values of the reference sensor readout. 

• Values of the channel of the logger. 

4.8.4 Export the results of the calibration or adjustment 

In order to export the results to a text file when calibration or adjustment, the “Export Data” 
box should be ticked.  
The files will be exported to the directory that can be configured from the menu 
“Configuration > Directory Management > External file”. 
The export format is TXT file. For every step: 
When calibration: 

Logger Name SPACE Channel Name HT HT HT CRLF 
And for each step 

Reference Value HT Channel Value HT Error HT Uncertainty CRLF 
When adjustment: 
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Logger Name SPACE Channel Name HT HT HT CRLF 
And for each step 

Reference Value HT Channel Value HT Error HT Channel Value after adjustment HT 
Error after Adjustment HT Uncertainty CRLF 

4.8.5 Generating calibration report 

• Select the datalogger(s) and channel(s) needed for such calibration report. 

• Click “Create the report” 

• Type or edit the various texts for the header of the reports in the Report Settings 
window (cf. 4.8.5.3 Settings for the calibration report). 

• Click “Next”. 

• Select the folder within the TDB where the reports will be saved. Default folder will 
be “Report\Calibration”. 

• If the “Detail Report” box was checked, the preview of every calibration report will be 
displayed. Every report can be then printed. 

• A new window will appear. 

• If the dataloggers need adjustment, then click “Step Analysis” otherwise, click “Exit”. 

4.8.5.1 Requested step number for adjustment 

To adjust a thermocouple, the requested step number is at least 1 and no more than 3.  
Regarding other type of loggers, the requested step number is at least 4 and no more 
than 8. 

4.8.5.2 Start the adjustment and create a calibration/adjustment report 

Prerequisites: 

• The dataloggers to be adjusted should be connected to the interface. 
In order to adjust: 

• Select the dataloggers that need adjustment (the other dataloggers won’t be display 
anymore). 

• Click “Start Adjustment” in order to calculate the transfer function and display two 
new columns “Adjustment” that include: 

o The new value given from the adjusted channel. 
o The bias (error) after the transfer function is applied. 

• Click “Continue Adjustment” to confirm the adjustment of the checked dataloggers. 

• Type or edit the various texts for the header of the reports in the Report Settings 
window (cf. 4.8.5.3 Settings for the calibration report). 

• Click “Next”. 

• The Adjustment window will appear. 
New configuration files CET can be created so the new transfer function can be calculated 
within every connected datalogger. 
The CET configuration files can be exported. To do so, check the “CET Export” box before 
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clicking “Complete the Adjustment”. The files will be exported to the directory that can be 
configured from the menu “Configuration > Directory Management > External file”. They 
can be later exported from “Configuration > Managing Configuration files”. 
In order to complete the adjustment for every datalogger: 

• Connect the datalogger(s) to the interface. 

• Click “Complete Adjustment”. 

• The calibration/adjustment report will be automatically saved within the 
“Report\Calibration” folder from the TDB or any other chosen directory. 

• Repeat according to the number of loggers and interfaces that you use. 
In order to restore a previous adjustment (cf. 2.1 CET/CETX Configuration files installation). 

4.8.5.3 Settings for the calibration report 

From such window, information for the calibration/adjustment report can be typed for every 
logger. 

• Detailed Report: if checked then an additional page will be printed showing each 
step, the date, the name of the operator and the GUID of the used files. 

• Open Preview: if checked then the preview of the report will be displayed on the 
screen and printing will be possible by clicking on the Printer icon. 

Title: 

• Sub-title always printed except in adjustment. 
Delivered to: 

• Name, address and phone number of the company to whom the report is to be 
delivered. 

• If the operator and service company details are the same, click the arrow button to 
copy the information. 

Operator/Place of Calibration: 

• Name, address and phone number of the service company that performed the 
calibration operation. 

• Picture: logo of the company to displayed on the top of the report next to the name 
and address. 

• Place: name or place of the calibration lab. 

• Room Temperature. 

• Calibration conditions: this is a text describing the conditions of the datalogger 
immersed in the bath. 

• Calibration procedure. 

• Adjustment procedure. 

• Calibration method and comments. 
Click “Next” to continue and save the changes for the following reports. 

4.8.5.4 Printing a calibration/adjustment from a saved report 

• Open the Directory Management 

• Go to the directory “Report\Calibration” or any other folder chosen for saving the 
reports. 
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• Open a report. 

• Click the Printer icon to print the report. 

4.8.5.5 Change the text from a saved report 

• Open the Directory Management 

• Go to the directory “Report\Calibration” or any other folder chosen for saving the 
reports. 

• Select a report. 

• Click the “Modify” button. 

• Make the changes and click “Save”. 

• Click “Print” to preview the report. 

• Click the Printer icon to print the report. 
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5 Autoclave validation (setup) option 

This function is not included in QLEVER Lite. 

5.1 Prerequisites 

• QLEVER license with: 
o Autoclave validation option included 
o 21CFR secure mode option included or not included 

• At least one temperature data logger 

5.2 Description of the autoclave validation setup option 

• The Autoclave validation mode is a QLEVER option in which the starting and reading 
of the data loggers follow a specific protocol that is necessary for the production of a 
validation report. Such report will then be described in an autoclave validation setup 
file. 

• Available Analysis: 

o Vacuum test (must be first in the data file) 

o Holding time 

o Rate of the pressure 

o Vacuum (pressure) 

o Air evacuation 

o Drying duration 

o Heating duration 

• In 21CFR mode (secure mode), the rights of the accounts of "operator" type can be 
changed by the Administrator. 

5.3 Steps for obtaining an autoclave validation report 

• Creation of an autoclave validation setup file 

• Starting of the autoclave validation process 

• Programming and starting of the data loggers 

• Data acquisition inside the equipment 

• Reading of the loggers in Process mode 

• Printing off of the validation report from the QLE data file 
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5.4 Create or modify an autoclave validation setup file 

• To create a new setup, click on “Setup > New – Autoclave validation”. 

• A setup is a description of the measurement to be made by the data loggers in order 
to create a validation report. 

• It does not incorporate the data recorded by the loggers. 

5.4.1 Description tab 

• This section displays the general Setup information: 

• File name and description 

• Name of the entity that will perform the measurements (displayed on top of the 
report) 

o Print in the report. 

• Place where measurements are performed 

o Print in the report. 

• Check the “keywords” box if you want keywords to be automatically updated if the 
data loggers, channel names, etc. are changed (cf. 5.2 File research by date or 
keywords) 

5.4.2 Settings tab 

The “Setting” tab enables you to describe: 

5.4.2.1 Holding time 

• Cycle-specific reference values: 

o Holding time: check this box to calculate the specified and measured holding 
time. You may uncheck this box if, for example, you wish to perform a vacuum 
test only. 

o Sterilization temperature band: the sterilization temperatures must stand 
within the specified temperature value (e.g. 121.10 °C) and the sum of the 
specified temperature value and sterilization temperature band value (e.g. 
121.10 + 3 = 124.10 °C). 

o Equilibration time: maximum time (in seconds) between the moment when 
the specified sterilization temperature is reached in the sterilizer chamber and 
the moment when it is reached throughout the load (when the last sensor 
reaches the specified temperature). E.g. 15 seconds. See also reference sensor. 

Example (calculations with linearization): 
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Non-conformity warning display: highlight the equilibration time in red, in 
the report, if the result value exceeds the above reference value. 

o Specified holding time: time between the moment when a sensor is the last 
to measure a temperature equal to the specified sterilization temperature 
value and the moment when a sensor is the first to measure a temperature 
falling below this value.  

o Specified sterilization temperature: sterilization temperature value to be 
reached during the specified holding time (e.g. 121.10 °C). 

o Stability: maximum temperature difference recorded by a sensor during the 
measured holding time. 

o Homogeneity: maximum temperature difference between the values 
recorded by the sensors, that is continuously calculated during the measured 
holding time. 

o Difference (average temperature): check the box if you want to calculate a 
deviation between average loggers temperature and average Regnault 
temperature (Default value =0.5°C). 

o Do not notify when the measured holding time < to the specified holding 
time: if not checked then when the measured holding time is strictly less than 
the specified holding time then the cell turns red in the report. Default = 
unchecked. 



 Qlever User’s manual  

 TMI-Orion  

 

___________________________________________________________________________ 
GDS/Documentation QLEVER EN 2.4.9.0 ed1.160  113/195 

o Do not display the measured holding time: check the box if you do not want 
the measured holding time to be displayed on the graph and in the validation 
report. Yet it will be calculated. This option is incompatible with "Calculation 
Zone" window "Setting cycles." Default is unchecked. 

o Calculations without linearization: if this box is unchecked, the equilibration 
and holding times calculation will be based on the linearization of two values, 
as shown below: 

 

 

 

 

 

 

 

 

If this box is checked, as shown below: 

 

 

 

 

Default is unchecked. 

o Detailed equilibration time: if checked display equilibration time values for 
every sensor compared with the very first sensor that reaches the sterilization 
temperature or compared with a reference sensor (chosen in the logger tab) 
that reaches the sterilization temperature. Default is unchecked. 

• Cycle - Qualification values: 

o Qualification values: to activate the following fields: 

o Minimum temperature: minimum temperature value reported by all the 
sensors during the measured holding time. This value must be equal to or 
exceed the specified sterilization temperature. 

o Maximum temperature: maximum temperature value reported by all the 
sensors during the measured holding time. This value must stand within the 
specified temperature value (e.g. 121.10 °C) and the sum of the specified 
temperature value and sterilization temperature band value (e.g. 121.10 + 3 = 
124.10 °C). 

o Stability  

o Homogeneity  
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o Holding time: see Specified holding time.  

o Average temperature: average of all the temperature values reported by the 
sensors during the measured holding time. 

o Minimum saturated vapor temperature: minimum temperature value 
calculated from Regnault's table based on the pressure values obtained during 
the measured holding time. 

o Maximum saturated vapor temperature: maximum temperature value 
calculated from Regnault's table based on the pressure values obtained during 
the measured holding time. 

5.4.2.2 Evacuation / HELIX 

o Evacuation: allows to activate an air evacuation test of the autoclave located 
before the heating phase (default value = no). 

o Color: color of the evacuation phase in the graphic. 

o Parameters: 

o Min delta: value in pressure between the min and the max to detect and 
analyze each evacuation pulse, below this value the impulse is ignored. This 
allows to filter some irregularities in pressure, especially at the beginning of 
cycle (default value is 300 mBar). 

o Display: 

o For the EMax marker: 
Display the maximum marker of each evacuation (default value = yes). 

o For the EMin and EMax markers: 
Display the minimum and maximum values of each evacuation (default 
value = yes). 

o Report: 

o  Print in report: allows you to show the calculation on the screen but 
not to print it in the report (default value = yes). 

o Evacuation table: 

o Evacuation number from E1 to E10 (default = 4) 

o  Reference value: this is the minimum value to reach for this pulse 
(default = 300 mBar). 

o Tolerance + : tolerance value above the reference value (default = 50 
mBar) 

o Tolerance - : tolerance value below the reference value (default = 50 
mBar) 

o Example: Reference value = 150 mBar, tolerance + = 50 mBar and 
tolerance - = 10 mBar then :  
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the acceptable tolerance band is 150 + 50 = 200 mBar to 150-10 = 140 
mBar, values included. 

o "+" button: allows you to add a new number after the selected line. 

o "-" button: deletes the selected line. 

 On the graph: 

o The evacuation phase and its duration are displayed. 

o Pressure maximums marked "E Max" appear with a blue marker. 

o The pressure minimums marked "E Min" appear with a green marker if 
the min value is within acceptable the tolerance band, otherwise with a 
red marker if not. 

o The minimum pressure reference values to be reached can be viewed 
but by default, they are not visible so as not to overload the graph. 

In the “Min / Max / Avg” tab of the “data analysis”, a detailed analysis is 
displayed for each air evacuation: 

o Evacuation number from E1 to the evacuation’s number of the 
evacuation table. 

o Value of the minimum pressure with measurement date. 

o Maximum pressure value with measurement date. 

o Pressure difference between the max and min values. 

o Rate of variation of the pressure per second = (max-min) / (date of the 
max - date of the min). 

o Duration: difference in seconds between the max value and the min 
value. 

o If not found, then “not found” is displayed. 

o The EMin Logger with each interval duration EMin. 

o The EMax Logger with each interval duration EMax. 

 

5.4.2.3 Pressure change 

o Rate of pressure change [Average]: 

▪ Determine whether the average pressure change for any 3 seconds 
interval during the sterilization cycle (not only measured holding time) 
exceeds a rate of 1 000 KPa/min (10 bar/min). So, the logger record 
rate must be 1 second or 3 second (2 second is impossible). 

▪ The calculation stops when the first value exceeds the max rate of 
1 000 KPa/min (10 bar/min) in absolute value. 
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▪ Only for the pressure channels (not calculated pressure channel). 

▪ Calculations without linearization. 

▪ The variation in the rate of pressure can be increasing or decreasing 
(i.e. positive if it increases or negative if it decreases). 

▪ Calculated on the cycle (maybe modified by the Cycle windows). 

o Max:  Rate of pressure change [Max]: 

▪ Search the maximal rate of pressure change in the programming rate. 

▪ Display: 

• The maximal rate: red symbol if absolute value > 1 000 KPa/min 
(10 bar/min) else green symbol. 

• Maximal pression and minimum pressure values. 

▪ Only for the pressure channels (not calculated pressure channel). 

▪ Calculations without linearization. 

▪ The variation in the rate of pressure can be increasing or decreasing 
(i.e. positive if it increases or negative if it decreases). 

▪ Calculated on the cycle (maybe modified by the cycle windows). 
 

5.4.2.4 Vacuum 

o Vacuum (under pressure) 

▪ Vacuum search area: 

▪ On the whole cycle (by default). 

▪ Exclusively after the holding time. 
 

▪ Display on the graphic: a marker will be positioned to indicate where is 
the value of the vacuum found. 

▪ Display the value of the channel: The value in pressure will be indicated 
or not. 

▪ Tolerance band: a tolerance band can be defined 

▪ Color of the tolerance band. 

▪ Reference value: this is the minimum value to reach for this 
pulse (default = 70 mBar). 

▪ Tolerance + : tolerance value above the reference value (default 
= 30 mBar) 

▪ Tolerance - : tolerance value below the reference value (default 
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= 30 mBar) 

On the graphic, the vacuum is displayed with a green marker if the 
value is in the tolerance band, otherwise with a red marker if the value 
is out of tolerance. 

5.4.2.5 Vacuum test 

o Vacuum test: enables to activate the following fields. 

o S1 Threshold: minimum acceptable pressure value that the autoclave must 
reach to start the vacuum test (the default value is 70 mBar). 

 Do not mistake S1 for P1 (P1 is the minimal measured pressure 
value, so P1 < S1 is mandatory). 

o t1 t2 time: number of seconds after the minimum pressure is reached. The 
default value is 300 seconds ± 10 s (this value must be a multiple of the 
recording rate). 

o t2 t3 time: vacuum test time (in seconds) after the t1t2 time. The default value 
is 600 seconds ± 10 s (this value must be a multiple of the recording rate). 

In t0, ambient pressure (P0) is measured. 

In t1, minimum pressure value (P1) is reached.  

In t2, the vacuum test starts with the initial pressure value (P2). 

In t3, the test ends with the final pressure value (P3). 

The rate of pressure increases in t2 - t3 interval shall not exceed 1.3 mbar/min. 

 The chosen pressure sensor for the vacuum test (for P0, P1, P2…) is the one that 
measured the lower pressure value P1 (and not the reference sensor in the setup). 

Calculation without linearization. 

 

5.4.2.6 Uncertainty values 

o Uncertainty values: enables to activate the following fields: 

▪ Temperature 

▪ Pressure 

▪ Time 

5.4.2.7 Graphic 

Allow to display on the data logger curve graphic: 

• 0 Bar (depend of the current pressure unit): display a horizontal reference mark to 
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the graphic for the zero pressure. 

• Heating duration: display the heating zone on the graphic (by default: heating begin 
estimated to the begin of equilibration time, but id “Evacuation” is activated then end 
of the evacuation to begin of equilibration time). 

• Drying duration: display the drying (or cooling) zone on the graphic (end of the 
holding time to the ambient pressure). 

• Duration: display the duration in the title of the zone (heading duration, holding 
time…) Default value=yes. 

 

5.4.2.8 Cycle designation 

• Cycle designation: to be entered by the user. 

• Cycle counter: cycle number. Which does not increment each time a new autoclave 
validation process is started. 

• Comment: remark entered by the user. 

 

5.4.3 Equipment tab 

This section enables you to enter the details of the equipment that will be used: 

• Equipment name or number 

• SOP protocol 

• Load description 

• Comment, batch number, chamber volume (in liters) 

• Picture of the equipment 

5.4.4 Logger tab 

This section enables you to describe the data loggers that you will be using. 

Add or remove the available data loggers. This can be done either automatically by browsing 
the plugged data loggers, or manually by designating each desired data logger. 

 Reference sensor:  It is possible to select a reference channel by checking the box. This 
reference sensor will be used for determining the starting point of equilibration time 
calculation. 

Not used: option not to use this sensor, ie: 

• The sensor will not appear in the data columns or curves QLE 
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• The sensor will not be taken into account in the calculation of setup 

• The sensor will not generate computed columns  

• The sensor will not be notified in the excluded channel list report 

• The sensor will not be visible on the loading plan 

• The internal channel is automatically unused with a Vacq 

• This feature can be activated before starting the setup (if you do not want to use 
a route once the data read back then since QLE data file, it must be excluded) 

 

 Beyond 70 sensors, the new will be added not visible by default to reduce the graphic 
processing time and not to obstruct the visibility of the loading plan. 

5.4.5 Programming tab 

This section enables you to describe the programs that you will be using. 

• Click on “Program” to add one or several programs (cf. 2.3 Program the loggers) 

• Click on “–” to remove a program 

• Click on  for quick program change 

• Click on “+” to assign the desired loggers to each program 

• Click on “–” to remove a logger from a program 

A message at the bottom of the screen will inform you in case loggers have not been 
assigned to any program. 

5.4.6 Sensor positions view tab 

This section enables you to indicate where the sensors will be placed inside the equipment: 

•  You may describe the position for each sensor of the list  

• Check or uncheck the box located below the column with a pin in the header, to 
display the sensor on the loading plan (a menu by right clicking on the column allows 
for additional options for selection). 

• Open and choose a loading plan proposed by QLEVER and open a picture that you 
have taken. 

• You may move the pins (that represent the sensors) on the loading plan by left-
clicking and sliding them. 

• Click on the “Printer” button on the loading plan picture to print the loading plan. 

 If any sensor is visible, then the loading plan will not be printed in the report. 

You may add 6 additional pictures of the cycle parameters, plus an additional one in 
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calculator tape format. 

5.4.7 Analysis tab 

This section enables you to describe the calculations that will be used in the report. 

The results of these calculations (on the measured holding time) depend on the type of 
cycles defined. They will be displayed in the data analysis, in the window of the data file QLE 
and in the printed report. 

o F0/A0/C0… type of calculation: enable or disable this calculation (default 
value = yes). 

▪ Two F0 calculation formulas are available (cf. 3.3.4.1 F0/A0/C0… type 
column and Information related to autoclave validation report). 

o Calculation of the water vapor temperature (Regnault)/Sterilizing agent 

▪ Include saturated steam temperature channels (Regnault) in the 
calculations: 

• Minimum temperature, maximum temperature, chamber 
temperature, homogeneity, stability. 

 21CFR: Some settings can be hidden by the 21CFR Administrator. 

5.4.8 Report 

Type of report: depending on the procedure you use, it is possible to choose the type of 
report: 

• Validation of autoclaves (full report) 

• Routine control (fast and condensed report) 

 Available only in 21CFR (authorized for approvers by default and 
operators according to granted administrator rights). 

Conformity: Type whether the report is valid or not. The box “do not display” only appears 
after loggers data are read. It will prevent you from displaying the conformity indication in 
the report. 

Top right part of the report can be chosen to be either: 

▪ Contractor details (logo and address) 

▪ Comment (a text zone for comments or a specific document reference) 

 

Free text field:  

o   Title: Add a title to this text field. 

o   Print in the report: check the box to get the text printed before the loggers data in 
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the report. 

o   Text field: add a text or a results table (e.g. : of chemical indicators). 

 This field may be printed differently in the report if the content was copied and 
pasted from an external file (Word, Excel, ...) 

 

5.4.9 Save an autoclave validation setup file 

Click on “Save”. 

For newly created validation setup files: 

• Select the TDB in which you wish to save the setup file. 

• Name the file.  

Click “OK” 

5.4.10 Save as... 

Click on “Save as” to save a copy of the setup file under a new name. 

• Select the TDB in which you wish to save the setup file. 

• Rename the file.  

Click “OK” 

 This operation cannot be performed with setup files that were opened from a QLE file.  

5.4.11 How to restart the calculations of the validation report 
results from a QLE file 

In the Setup windows, click on “Calculations" to restart the calculations of the holding time 
and all the results of the autoclave validation report. 

5.5 Open an autoclave validation setup file 

To modify a setup file, click on “Setup > Open”. 

If you wish to review or modify a setup file that was used to generate a QLE data file, open a 
data file (cf. 3 QLE data files), select a file that was created in Setup mode, then click on 
“Setup” (on the upper right corner). 

Warning: some modifications will restart the calculations. 
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5.6 Start an autoclave validation setup 

To start a setup, click on “Setup > Start”. 

Select a setup, then click on the “Start” button at the bottom of the Setup window. 

Starting the loggers in Setup mode is the same process as in standard mode (cf. 2.4 Start the 
loggers) 

The presence of the loggers required in the Setup is verified. 

Start date 

To avoid interpolation of the data, it is not possible to start "Now" with several 
loggers. 

Options 

Some options such as message display or value display are configurable in user 
preferences. 

 

After starting, the Setup file is copied in a Process file. 

The Process file becomes independent from the Setup file that was used to create it. 

5.7 Read an autoclave validation process 

To read the data recorded by the logger in setup mode, click on “Setup > Read”, and select 
the process that you have started. 

Reading the data in Setup mode is the same process as in standard mode (cf. 2.5 Read the 
loggers) 

The presence of the loggers connected, missing and required in the Process is verified. 

If a logger was unable to record data (e.g. due to low battery), you will be proposed to 
exclude it from the data file. 

 Exclude a logger 
To exclude a logger, select this logger and click right, choose “Exclude” or clic on “Exclude” 
button. 

 Data File 
As soon as the data file opens, the calculations specific to the report are launched. 

A quick overview of the results is displayed in the Min/Max/Avg tab.  

The specified sterilization temperature, holding time and measured holding time are 
displayed on the graph. 
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5.8 Delete an autoclave validation process file 

To delete a process file, click on “Setup > Delete process”. 

Select the Process file in the TDB, right click and select “Delete”. 

Deleting a Process file is irreversible (the file cannot be found in the recycle bin). 

5.9 Define cycles for the autoclave validation report 

Open a data file (cf. 3 QLE data files) and select a file that was created in the autoclave 
validation setup mode. 

Click on “Cycle”. 

• Cycle start and end dates 

o You may enter the start and end dates of the recorded data for the report 
(both starting and ending dates are included). 

For example, if you want to start later to avoid an overshoot under the specified 
sterilization temperature, the start date will be here: 

 

 

 

• F0/A0... calculation start and end dates 

o Enter start and end dates to perform the F0/A0 calculations over the selected 
period of time (both starting and ending dates are included). 

• Calculation zone start and end dates 

o Enter start and end dates to replace those of the measured holding time that 
were automatically calculated. 

For example, set the start date  
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Then, set the end date before the threshold: 

 

If checked, the measured holding time will be renamed by “Holding time”. 

Note: This option is incompatible with "Do not display the measured holding 
time" (Setup window) 

o Color 

▪ Select a color to modify the color of the holding time displayed on the 
graph. 

o Stability calculation start and end dates 

▪ Enter start and end dates to calculate stability over the selected period 
of time (both starting and ending dates are included). 

o Homogeneity calculation start and end dates 

▪ Enter start and end dates to calculate homogeneity over the selected 
period of time (both starting and ending dates are included). 

o Sterilizing steam calculation start and end dates (Sterilizing agent) 

▪ Enter start and end dates to perform sterilizing stream calculations 
over the selected period of time (both starting and ending dates are 
included). 

• t0 of the vacuum test 

o Enter a date for measuring the ambient pressure (P0). 

 t0 must be on an acquisition measured by a pressure logger. 

• t1 of the vacuum test  

o Enter a date for measuring the minimum pressure (p1). 

 t1 must be on an acquisition measured by a pressure logger. 

• Start and end date of the air evacuation search area 

o By default, the software searches for evacuations between the beginning of the 
file and the beginning of the equilibration time, but you want to restrict this 
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search area then specify a start and end date. The software will find evacuations 
according to your indications. Start and end date may be out of the cycle’s date. 

Icons "zoom" lets you view the start and end of the graph 

5.10 Exclude a sensor from the calculations and analysis 

To exclude a sensor, click on the column header of the data table. 

5.11 Preview or print an autoclave validation report 

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, then select and open the 
file in the Report/Autoclave validation directory. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

Click on “Report”. 

  

 Choose your print out mode: 

• Save as: allow to save the report in the QLEVER TDB without preview and 
print. 

• Default printer: allow to print on the windows default printer without preview. 

• PDF: allow to export the report to PDF format. 

• Open the preview: allow to see the report before print. 

 

You may print the following: 

• Parameters 

o Signature 

o Display signature on the first page only 

o The legend 

o Comment on the QLE file 

• Graph with background color 

o Equilibration time graph 

o Specified holding time graph 

o Measured holding time graph 

o Vacuum test graph 
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• Pictures 

• Data of every column: 

o Default Data mode  

▪ Printed data description: 

• All data in the file are printed unless a cycle was defined. 

• Date and hour column 

• Logger column: 

o Channel colour, serial number, physical unit, channel 
name 

 

o Condensed data on 25 columns with calculation (min., max., avg., max-
average, average-min…) 

▪ Choose a physical property for the statistics (temperature…) 

▪ Adding or not statistics (min., max., avg…) 

▪ Printed data description: 

• All data in the file are printed unless a cycle was defined. 

• Date and hour column 

• Logger column: 

o Channel colour, channel number, physical unit 

o Statistics for each line: 

▪ Min. value (optional) 

▪ Max. value (optional) 

▪ Average (optional) 

▪ Max. – Min. (optional) 

▪ Average – Min. (optional) 

▪ Max. – Min. (optional) 

o Print all lines or one line out of x (except equilibration time and holding 
time) 

▪ Hidden data channels are printed in the report. 

▪ Excluded data channels are not printer in the report. 

• The loading plan in small and/or large size on a whole page 

• Picture of the equipment 

• Program descriptions 
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• List of excluded data loggers (typically the user would use more loggers than 
required to run a validation test just in case some fail or stand out of the 
metrological specifications. Additional loggers would be then excluded from the 
test to avoid any later questions)  

• Screen shots (if you do not wish to print a screen shot, go to the “Screen shot” 
tab and uncheck “Print in the report”). 

• Min/Max/Avg statistics of Data Analysis tab 

o Setup calculations automatically generated by the setup. 

o User calculations: calculations manually added from “Data analysis” tab, 
button “Modify”. See “Data analysis” paragraph. 

o Page break between each table: if you want to get your report more 
readable, it is possible to separate each Min./Max./Avg. calculation with a 
page break. 

• Logger included in the study: 

o Loggers configuration date 

o Loggers firmware version 

 

 Click on “Print”. 

If you wish to save the report when closing the preview, name the file and click “OK”. 

5.12 Information related to autoclave validation report 

 

Colors in the report: 

o Important values are a displayed with a gray background. 

o If a value is out of its reference specification it will be displayed with a red 
background as: 

▪ Vacuum Test. 

▪ Mini and maxi temperature. 

▪ Stability and homogeneity. 

▪ Holding time duration 

▪ Measured holding time duration (if “Do not notify when” is unchecked in 
the setup) 

▪ Equilibration time (if “Non-conformity warning display” is checked in the 
setup). 

▪ Mini and maxi temperature (Regnault). 
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▪ Average temperature. 

▪ Deviation between average loggers temperature and average Regnault 
temperature. 

▪ Rate of pressure change. 

▪ Evacuations. 
 

Calculation of F0 in the report: 

 • Depending on the formula entered in the setup. 

 • Calculated over the entire cycle time (by default, except for manual modification in 
the "Cycle" window) and therefore NOT ON the hold time. 

 • At the end of the F0 calculation time: 

   o F0 Max: is the largest value of F0 among all F0. 

   o F0 Min: is the smallest value of F0 among all F0. 
 

Chamber temperature: lowest value among the average values calculated for each sensor 
(displayed as "m" in the Min/Max/Avg tab) during the measured holding time. 

If pressure loggers were used and if “Calculation of the water vapor temperature (Regnault)” 
was checked in the setup appears the following values in the report: 

▪ Mini. temperature (Regnault): Minimum temperature value among all temperature 
values given from the pressure values converted with the Regnault table during the 
measured holding time. 
The result will in red if “Include in calculation the saturated steam” is checked and if < 
at the specified sterilization temperature. 

▪ Maxi. temperature (Regnault): maximum value among all temperature values given 
from the pressure values converted with the Regnault table, during the measured 
holding time based on the pressure values. The result will in red if “Include in 
calculation the saturated steam” is checked and if > at the specified sterilization 
temperature + sterilization temperature band. 

▪ Average temperature (Regnault): average of each temperature value given from a 
pressure value converted with the Regnault table, during the measured holding time. 

▪ Average temperature (loggers): average of the temperature values recorded by all the 
loggers during the measured holding time. 

▪ Homogeneity: max. spread between reference sensor and temperature value given 
from a pressure value converted with the Regnault table. Displayed only if a reference 
sensor is checked. 

If pressure loggers were used appears the following values in the report: 

▪ Minimal pressure: minimum value among all temperature values recorded by all the 
loggers during the measured holding time. 
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▪ Maximal pressure: maximum value among all temperature values recorded by all the 
loggers during the measured holding time. 

▪ Average pressure: average of the pressure values recorded by all the loggers during the 
measured holding time. 

▪ Vacuum: minimum pressure value recorded by all the sensors over the entire cycle. 

▪ Vacuum test: 

o Difference (P3-P2): is the difference in pressure value measured between P3 
and P2. 

▪ The leak rate must be less than 1.3mBar / min over a period of 10 
minutes. 

▪ In description column: 

• The 1st line gives the result of the pressure leak rate analysis 
over a 10 minutes time interval. 

• The 2nd line appears when the result of the pressure leak rate 
analysis over a time interval of 1 minute is> 1.3mBar / min 
indicating the time of the violation. 

 

For more definitions, go to “Creation of an autoclave validation setup > Settings”. 

5.13 Approve an autoclave validation report 

This function is available in the secure mode option only and only the Approval users can 
approve reports. 

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, select the file in the 
Report directory and click on “Approve”. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

As the cycles have already been defined (cf. 5.9 Define cycles for the autoclave 
validation report), you just need to click on “Approve”. A preview of the report will 
show up to be reviewed or printed off (cf. 3.3.9 Printing). 

If you wish to approve the report when closing the preview, name the file and click 
“OK”. 
Confirm approval of the measurement report. 

Approved reports are represented by an icon with a V.  
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6 Washer-disinfector validation (setup) option 

This function is not included in QLEVER Lite.  

6.1 Prerequisites 

• QLEVER license with 
o Washer-disinfector validation option included 
o 21CFR secure mode option included or not included 

• At least one temperature data logger 

6.2 Description of the washer-disinfector validation setup option 

• The washer-disinfector validation mode is a QLEVER option in which the starting and 
reading of the data loggers follow a specific protocol that is necessary for the 
production of a validation report. Such report will be described in a washer-
disinfector validation setup file. 

• In 21CFR mode (secure mode), the rights of the accounts of "operator" type can be 
changed by the Administrator. 

6.3 Generation process for a washer-disinfector validation report 

• Creation of a new washer-disinfector validation setup 

• Starting of the washer-disinfector validation process 

• Programming and starting of the data loggers 

• Data acquisition inside the equipment 

• Reading of the loggers in Process mode 

• Printing off of the validation report from the QLE data file 

6.4 Create or modify a washer-disinfector validation setup file 

To create a new setup, click on “Setup > New – Washer-disinfector validation”. 

• A setup is a description of the measurement to be made by the data loggers in order 
to create a validation report. 

• It does not incorporate the data recorded by the loggers. 

6.4.1 Description tab 

This section displays the general Setup information: 
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• File name and description. 

• Name of the entity that will perform the measurements (displayed on top of the 
report). 

o Print in the report. 

• Place where measurements are performed. 
o Print in the report. 

• Check the “keywords” box if you want keywords to be automatically updated if the 
data loggers, channel names, etc. are changed (cf. 5.2 File research by date or 
keywords). 

6.4.2 Settings tab 

The “Setting” tab enables you to describe: 

• The number of cycles to be analyzed (up to 3) 

• The number of washing phases (up to 3) The presence of at least one washing phase. 

• Washing phase reference values: 

o Setpoint temperature: setpoint value in temperature to be reached during 
the holding time.  

o Holding time: time between the moment when a sensor is the last to 
measure a temperature exceeding the setpoint temperature and the moment 
when a sensor is the first to measure a temperature falling below this value. 

o Washing temperature band: temperatures must stand within washing 
temperature band. Default value = 0°C to 5 °C. 

For example: 

▪ If the washing temperature band= 54 °C to 58 °C and the setpoint 
temperature = 53 °C then 

▪ Washing temperature band: 1°C to 5 °C 

o Washing pressure band: during a washing phase, the tolerance (min and max 
pressure values) on the measured pressures must be ± x % of the average 
pressure value. 0% for disactivate the comparison. Default value = 20%. 

o Stability: maximum temperature difference recorded by a logger during the 
holding time. 

o Homogeneity: maximum temperature difference between the values 
recorded by the loggers, that is continuously calculated during the holding 
time. 

 

• Disinfection phase reference values: 

o Setpoint temperature: setpoint value in temperature to be reached during 
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the holding time.  

o Holding time: time between the moment when a sensor is the last to 
measure a temperature equal to the setpoint temperature and the moment 
when a sensor is the first to measure a temperature falling below this value. 

o Disinfection temperature band: temperatures must stand within the 
disinfection temperature band. Default value = 0°C to 5 °C. 

For example: 

▪ Si disinfection temperature band: 91 °C to 95 °C and the setpoint 
temperature = 90 °C then 

▪ Disinfection temperature band: 1°C to 5 °C 

o Stability: maximum temperature difference recorded by a logger during the 
holding time. 

o Homogeneity: maximum temperature difference between the values 
recorded by the loggers, that is continuously calculated during the holding 
time. 

• Other cycle parameters: 

o Cycle designation: to be entered by the user. 

o Cycle counter: cycle number. Which does not increment each time a new 
autoclave validation process is started. 

o Comment: remark entered by the user. 

 

• Washing phase qualification values: 

o Qualification values: to activate the following fields: 

o Minimum temperature: minimum temperature value reported by all the 
loggers during the holding time. This value must be equal to or exceed the 
setpoint temperature. 

o Maximum temperature: maximum temperature value reported by all the 
loggers during the holding time. This value must stand within the setpoint 
temperature value and the sum of the setpoint temperature value and the 
washing band value. 

o Average temperature: average of all the temperature values reported by the 
loggers during the holding time. 

o Holding time: see Washing phase holding time  

o Stability: see Washing phase stability  

o Homogeneity: see Washing phase homogeneity 

 

• Disinfection phase qualification values: 
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o Minimum temperature: minimum temperature value reported by all the 
loggers during the holding time. This value must be equal to or exceed the 
setpoint temperature. 

o Maximum temperature: maximum temperature value reported by all the 
loggers during the holding time. This value must stand within the setpoint 
temperature value and the sum of the setpoint temperature value and the 
disinfection band value. 

o Average temperature: average of all the temperature values reported by the 
loggers during the holding time. 

o Holding time: see Disinfection phase holding time  

o Stability: see Disinfection phase stability 

o Homogeneity: see Disinfection phase homogeneity 

 Qualification values = 0 are not printed in the report. 

 

• Uncertainty values 

o Uncertainty values: enables to activate the following fields: 

▪ Temperature 
▪ Pressure 
▪ Time 

6.4.3 Equipment tab 

This section enables you to enter the details of the equipment that will be used: 

• Equipment name or number 

• SOP protocol 

• Load description 

• Comment, batch number, chamber volume in liters 

• Picture of the equipment 

6.4.4 Logger tab 

This section enables you to describe the data loggers that you will be using. 

Add or remove the available data loggers. This can be done either automatically by browsing 
the plugged data loggers, or manually by designating each desired data logger. 

Not used: option not to use this sensor, ie: 

• The sensor will not appear in the data columns or curves QLE 



 Qlever User’s manual  

 TMI-Orion  

 

___________________________________________________________________________ 
GDS/Documentation QLEVER EN 2.4.9.0 ed1.160  134/195 

• The sensor will not be taken into account in the calculation of setup 

• The sensor will not generate computed columns  

• The sensor will not be notified in the excluded channel list report 

• The sensor will not be visible on the loading plan 

• The internal channel is automatically unused with a Vacq 

• This feature can be activated before starting the setup (if you do not want to use 
a route once the data read back then since QLE data file, it must be excluded) 

 

 Beyond 70 sensors, the new will be added not visible by default to reduce the graphic 
processing time and not to obstruct the visibility of the loading plan. 

6.4.5 Programming tab 

This section enables you to describe the programs that you will be using. 

• Click on “Program” to add one or several programs (cf. 2.3 Program the loggers) 

• Click on “–” to remove a program 

• Click on  for quick program change 

• Click on “+” to assign the desired loggers to each program 

• Click on “–” to remove a logger from a program 

A message at the bottom of the screen will inform you in case loggers have not been 
assigned to any program. 

6.4.6 Sensor positions view tab 

This section enables you to indicate where the sensors will be placed inside the equipment: 

• You may describe the position for each sensor of the list. 

• To display the sensor on the loading plan, check or uncheck the box located below 
the column represented by a pin (a menu by right clicking on the column allows for 
additional options for selection). 

• Open and choose a loading plan proposed by QLEVER and open a picture that you 
have taken. 

• You may move the pins (that represent the sensors) on the loading plan by left-
clicking and moving them. 

• Click on the “Printer” button on the loading plan picture to print the loading plan. 

 If no sensor is visible, then the loading plan will not be printed in the report. 

 



 Qlever User’s manual  

 TMI-Orion  

 

___________________________________________________________________________ 
GDS/Documentation QLEVER EN 2.4.9.0 ed1.160  135/195 

You may add 6 additional pictures of the cycle parameters, plus an additional one in 
calculator tape format. 

6.4.7 Analysis tab 

This section enables you to describe the calculations that will be used in the report. 

The results of these calculations depend on the type of cycles defined. They will be displayed 
in the data analysis, in the window of the data file QLE and in the printed report. 

• F0/A0/C0… type of calculation: enable or disable this calculation (default value = 
yes). 

o Up to two A0 calculation formulas are available (calculated on the disinfection 
phase) (cf. 3.3.4.1 F0/A0/C0… type column) 

• Do not display the calculated columns until the cycles are defined (not checked by 
default): to avoid calculated columns creation before the cycles are defined. 

 Reduce the computation time 

 

6.4.8 Report 

Type of report: depending on the procedure you use, it is possible to choose the title of the 
report: 

• Validation report 

• Measurement report 

 In 21CFR (authorized for approvers by default and operators according 
to granted administrator rights). 

 

Conformity: Type whether the report is valid or not. The box “do not display” only appears 
after loggers data are read. It will prevent you from displaying the conformity indication in 
the report. 

Top right part of the report can be chosen to be either: 

▪ Contractor details (logo and address) 

▪ Comment (a text zone for comments or a specific document reference) 

 

Free text field:  

o   Title: Add a title to this text field. 

o   Print in the report: check the box to get the text printed before the loggers data in 
the report. 
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o   Text field: add a text or a results table (e.g. : of chemical indicators). 

 This field may be printed differently in the report if the content was copied and 
pasted from an external file (Word, Excel, ...) 

 

6.4.9 Save a washer-disinfector validation setup file 

Click on “Save”. 

For newly created validation setup files: 

• Select the TDB in which you wish to save the setup file. 

• Name the file.  

Click “OK” 

6.4.10 Save as... 

Click on “Save as” to save a copy of the setup file under a new name. 

• Select the TDB in which you wish to save the setup file. 

• Rename the file.  

Click “OK” 

This operation cannot be performed with setup files that were opened from a QLE file. 

6.4.11 How to restart the calculations of the validation report 
results from a QLE file 

Click on “Calculations" to restart the calculations of the holding time and all the results of 
the washer-disinfector validation report. 

6.5 Open a washer-disinfector validation setup file 

To modify a setup file, click on “Setup > Open”. 

If you wish to review or modify a setup file that was used to generate a QLE data file, open a 
data file (cf. 3 QLE data files), select a file that was created in Setup mode, then click on 
“Setup” (on the upper right corner). 

Warning: some modifications will restart the calculations. 

6.6 Start a washer-disinfector validation setup file 

To start a setup, click on “Setup > Start”. 
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Select a setup, then click on the “Start” button at the bottom of the Setup window. 

Starting the loggers in Setup mode is the same process as in standard mode (cf. 2.4 Start the 
loggers) 

The presence of the loggers required in the Setup is verified. 

Start date 

To avoid interpolation of the data, it is not possible to start "Now" with several 
loggers. 

Options 

Some options such as message display or value display are configurable in user 
preferences. 

 

After starting, the Setup file is copied in a Process file. 

The Process file becomes independent from the Setup file that was used to create it. 

6.7 Read a washer-disinfector validation process 

To read the data recorded by the logger in setup mode, click on “Setup > Read”, and select 
the process that you have started. 

Reading the data in Setup mode is the same process as in standard mode (cf. 2.5 Read the 
loggers) 

The presence of the loggers connected, missing and required in the Process is verified. 

If a logger was unable to record data (e.g. due to low battery), you will be proposed to 
exclude it from the data file. 

 Exclude a logger 
To exclude a logger, select this logger and click right, choose “Exclude” or clic on “Exclude” 
button. 

Data file 
As soon as the data file opens, the calculations specific to the report are launched. 

A quick overview of the results is displayed in the Min/Max/Avg tab.  

The setpoint temperatures and washing and disinfection phases are displayed on the graph. 

6.8 Delete a washer-disinfector validation process 

To delete a process file, click on “Setup > Delete process”. 

Select the Process file in the TDB, right click and select “Delete”. 

Deleting a Process file is irreversible (the file cannot be found in the recycle bin)  
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6.9 Define cycles for the washer-disinfector validation report 

Open a data file (cf. 3 QLE data files) and select a file that was created in the washer-
disinfector validation setup mode. 

Click on “Cycle”. 

• Choose a cycle 

• Cycle start and end dates 

o You may enter the start and end dates of the recorded data for the report 
(both starting and ending dates are included). 

• Select a washing or disinfection phase 

 

• Calculation zone start and end dates 

o Enter start and end dates to replace those of the measured holding time that 
were automatically calculated (both starting and ending dates are included). 

• Stability calculation start and end dates 

o Enter start and end dates to calculate stability over the selected period of 
time (both starting and ending dates are included). 

• Homogeneity calculation start and end dates 

o Enter start and end dates to calculate homogeneity over the selected period 
of time (both starting and ending dates are included). 

Icons "zoom" lets you view the start and end of the graph. 

6.10 Exclude a sensor from the calculations and analysis 

To exclude a sensor, click on the column header of the data table. 

6.11 Preview or print a washer-disinfector validation report 

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, then select and open the 
file in the Report/Washer-disinfector validation directory. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

Click on “Report”. 

  

 Choose your print out mode: 
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• Save as: allow to save the report in the QLEVER TDB without preview and 
print. 

• Default printer: allow to print on the windows default printer without preview. 

• PDF: allow to export the report to PDF format. 

• Open the preview: allow to see the report before print. 

 

You may print the following: 

• Parameters 

o Signature 

o Display signature on the first page only 

o The legend 

o Comment on the QLE file 

• Graph (current view) with background color 

o Holding time (of the washing and disinfection phases) 

• Pictures 

• Data of every column: 

o Default Data mode  

▪ Printed data description: 

• All data in the file are printed unless a cycle was defined. 

• Date and hour column 

• Logger column: 

o Channel color, serial number, physical unit, channel 
name 

  

o Condensed data on 25 columns with calculation (min., max., avg., max-
avg, avg-min…) 

▪ Choose a Physical property for the statistics (temperature, …) 

▪ Adding or not statistics (min., max., avg…) 

▪ Printed data description: 

• All data in the file are printed 

• Phase name, start date, end date and duration 

• Date and hour column 

• Logger column: 
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o Channel color, channel number, physical unit 

o Statistics for each line: 

▪ Min. value (optional) 

▪ Max. value (optional) 

▪ Average (optional) 

▪ Max. – Min. (optional) 

▪ Avg. – Min. (optional) 

▪ Max. – Min. (optional) 

o Print all lines or one line out of x : 

▪ Hidden data channels are printed in the report. 

▪ Excluded data channels are not printer in the report. 

• Loading plan in small and/or large size on a whole page 

• Picture of the equipment 

• Program descriptions 

• List of excluded data loggers (typically the user would use more loggers than 
required to run a validation test just in case some fail or stand out of the 
metrological specifications. Additional loggers would be then excluded from the 
test to avoid any later questions). 

• Screen shots (if you do not wish to print a screen shot, go to the “Screen shot” 
tab and uncheck “Print in the report”). 

• Min. / Max. / Avg. statistics of Data Analysis tab 

o Setup calculations automatically generated by the setup. 

o User calculations: calculations manually added from “Data analysis” tab, 
button “Modify”. See “Data analysis” paragraph. 

o Page break between each table: if you want to get your report more 
readable, it is possible to separate each Min./Max./Avg. calculation with a 
page break. 

• Logger included in the study: 

o Loggers configuration date 

o Loggers firmware version 

 

 Click on “Print”. 

 

If you wish to save the report when closing the preview, name the file and click “OK”. 
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6.12 Information related to washer-disinfector report 

 

Colors in the report: 

o Important values are a displayed with a gray background. 

o If a value is out of its reference specification it will be displayed with a red 
background as: 

▪ Mini and maxi temperature  

▪ Average temperature 

▪ Stability and homogeneity 

▪ Holding time 

▪ Average pressure (if not disactivated) 

Glossery: 

Average pressure: average of the pressure values recorded by all the loggers during the 
measured holding time. 

For more definitions, go to “Creation of a washer-disinfector validation setup > Settings”. 

6.13 How to approve a washer-disinfector validation report 

This function enables you to approve a washer-disinfector validation report. It is available in 
the secure mode option only and only the Approval users can approve reports. 

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, select the file in the 
Report directory and click on “Approve”. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

As the cycles have already been defined (cf. 6.9 Define cycles for the washer-
disinfector validation report), you just need to click on “Approve”. A preview of the 
report will show up to be reviewed or printed off (cf. 3.3.9 Printing). 

If you wish to approve the report when closing the preview, name the file and click 
“OK”. 
Confirm approval of the measurement report. 

Approved reports are represented by an icon with a V. 

  



 Qlever User’s manual  

 TMI-Orion  

 

___________________________________________________________________________ 
GDS/Documentation QLEVER EN 2.4.9.0 ed1.160  142/195 

7 Rotation Setup Option (setup) 

This function is not included in QLEVER Lite. 

7.1 Prerequisites 

• QLEVER license with: 
o Rotation mode option included. 
o 21CFR secure mode option included or not included. 

• At least one “rotation” logger. 

7.2 Description of the Rotation Setup option 

• The Setup Rotation mode is a QLEVER option in which the starting and reading of the 
data loggers follow a specific protocol that is necessary for the production of a test 
report. Such report will then be described in a Rotation Setup file. 

• In 21CFR mode (secure mode), the rights of the accounts of "operator" type can be 
changed by the Administrator. 

7.3 Steps for obtaining a Rotation test report 

• Creation of a rotation setup file 

• Starting of the rotation process 

• Programming and starting of the data loggers 

• Data acquisition inside the equipment 

• Reading of loggers in Process mode 

• Printing out of the measurement report from the QLE data file 

7.4 Create or modify a Rotation setup file 

To create a new setup, click on “Setup > New – Rotation”. 

• A setup is a description of a test that will be done with logger(s) in order to create a 
test report. 

• A setup file does not include the recorded data from the loggers. 

7.4.1 Description tab 

This section displays the general Setup information:  

• File name and description. 
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• Name of the entity that will perform the measurements (displayed on top of the 
report). 

o Print in the report. 

• Place where measurements are performed. 
o Print in the report. 

• Check the “keywords” box if you want keywords to be automatically updated if the 
data loggers, channel names, etc. are changed (cf. 5.2 File research by date or 
keywords). 

7.4.2 Settings tab 

The “Setting” tab enables you to describe: 

o Rotation speed: type the rotation speed of your equipment 

o Cycle designation: to be entered by the user 

o Comment: remarks typed by the user 

7.4.3 Equipment tab 

This section enables you to enter the details of the equipment used for the test: 

• Equipment name or number 

• SOP protocol 

• Load description 

• Comment, batch number 

• Picture of the equipment 

7.4.4 Logger tab 

This section enables you to describe the data loggers used for the test. 

Add or remove the available data loggers. This can be done either by automatically browsing 
the plugged data loggers, or by manually designating each desired data logger. 

  Not used: option not to use this sensor, ie: 

• The sensor will not appear in the data columns or curves QLE 

• The sensor will not be taken into account in the calculation of setup 

• The sensor will not generate computed columns  

• The sensor will not be notified in the excluded channel list report 

• The sensor will not be visible on the loading plan 
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• The internal channel is automatically unused with a Vacq 

• This feature can be activated before starting the setup (if you do not want to use 
a route once the data read back then since QLE data file, it must be excluded) 

 

 Beyond 70 sensors, the new will be added not visible by default to reduce the graphic 
processing time and not to obstruct the visibility of the loading plan. 

7.4.5 Programming tab 

This section enables you to describe the programs used for the test: 

• Click on “Programming” to add one or several programs (cf. 2.3 Program the loggers) 

• Click on “–” to delete a program 

• Click on  for a quick program change 

• Click on “+” to assign the desired loggers to a program 

• Click on “–” to delete a logger from a program 

A message at the bottom of the screen will inform you whether a logger is not linked to any 
program. 

7.4.6 Sensor position view tab 

This section enables you to indicate the location of the sensors inside the equipment: 

• You can describe the position for each sensor of the list. 

• Check or uncheck the box located below the column with a pin in the header, to 
display the sensor on the loading plan. 

• Open and choose a loading plan proposed by QLEVER an open a picture you have 
taken. 

• You can move the pins (that represent the sensors) on the loading plan by left-clicking 
and sliding them. 

• Click on the “Printer” button on the loading plan picture to print the loading plan. 

 If any sensor is visible, then the loading plan will not be printed in the report. 

 

You may add 6 additional pictures of the cycle parameters, plus an additional one in 
calculator tape format. 
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7.4.7 Analysis tab 

This section enables you to describe the calculations that will be used in the report. 

The results of those calculations depend on the type of cycles defined. They will be displayed 
in the data analysis, in the window of the data file QLE and in the printed report. 

• Up to two calculation formulas are available (cf. 3.3.4.1 F0/A0/C0… type column) 

• Calculation of the water vapor temperature (Regnault) 

 21CFR: Some settings can be hidden by the 21CFR Administrator. 

7.4.8 Report tab 

Top right part of the report can be chosen to be either: 

▪ Contractor details (logo and address) 

▪ Comment (a text zone for comments or a specific document reference) 

7.4.9 Save a Rotation setup file  

Click on “Save”. 

For newly created validation setup files: 

• Select the TDB in which you want to save the setup file. 

• Name the file.  

Click on “Ok”. 

7.4.10 Save as…  

Click on “Save as…” to save a copy of the setup file under a new name. 

• Select the TDB in which you want to save the setup file.  

• Rename the file.  

Click on “Ok”. 

This operation cannot be performed with setup files that were opened from a QLE file. 

7.4.11 How to restart the calculations of the measurement report 
results 

Click on “Calculations" to restart the calculations of each spiral and all the results of the 
measurement report. 
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7.5 Open a Rotation setup file 

To open a setup file, click on “Setup > Open”. 

If you wish to review or modify a setup file that was used to generate a QLE data file, open a 
data file (cf. 3 QLE data files), select a file that was created in Setup mode, then click on “Setup” 
(on the upper right corner). 

Warning: some modifications will restart the calculations. 

7.6 Start a Rotation setup  

To start a setup, click on “Setup > Start”. 

Select a setup, then click on the “Start” button at the bottom of the Setup window. 

Starting the loggers in Setup mode is the same process as in standard mode (cf. 2.4 Start the 
loggers) 

The presence of the loggers required in the Setup is verified. 

Start date 

To avoid interpolation of the data, it is not possible to start "Now" with several 
loggers. 

Options 

Some options such as message display or value display are configurable in user 
preferences. 

 

After starting, the Setup file is saved as a Process file. 

The Process file becomes independent from the Setup file that was used to create it. 

7.7 Read a Rotation Process 

To read the data recorded by the logger in setup mode, click on “Setup > Read”, and select 
the process that you have started. 

Reading the data in Setup mode is the same process as in standard mode (cf. 2.5 Read the 
loggers) 

The presence of the loggers connected, missing and required in the Process is verified. 

If a logger was unable to record data (e.g. due to low battery), you will be proposed to 
exclude it from the data file. 

 Exclude a logger 
To exclude a logger, select this logger and click right, choose “Exclude” or clic on “Exclude” 
button. 
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7.8 Delete a Rotation Process file 

To delete a process file, click on “Setup > Delete process”. 

Select the Process file in the TDB, right click and select “Delete”. 

Deleting a Process file is irreversible (the file cannot be found in the recycle bin). 

7.9 Cycles definition for the Rotation test report 

Open a data file (cf. 3 QLE data files) and select a file that was created with the Rotation 
Setup mode. 

Click on “Cycle”. 

For every rotation logger, both dates when entering and leaving every shell must be defined. 

Every rotation logger has a channel “Turn +” and a channel “Turn -” that will differ according 
to how the logger is placed into the equipment. 

To find out which channel counted the turns in the right way, select a logger from the list, 
then click on one of the two buttons for the channels “Turn +” and “Turn -”, and look at the 
graph. 

Mark the start and end dates by using the icons to zoom in the graph. Each shell you print is 
displayed as a yellow hatched area defined by the start and end dates. 

7.10 Exclude a sensor from the calculations and analysis 

To exclude a sensor, click on the column header of the data table. 

7.11 Preview or print a rotation measurement report 

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, then select and open the 
file in the Report/Rotation directory. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

Click on “Report”. 

 

 Choose your print out mode: 

• Save as: allow to save the report in the QLEVER TDB without preview and 
print. 

• Default printer: allow to print on the windows default printer without preview. 
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• PDF: allow to export the report to PDF format. 

• Open the preview: allow to see the report before print. 

 

You may print the following: 

• Parameters 

o Signature 

o Display signature on the first page only 

o The legend 

o Comment on the QLE file 

• Graph with background color 

• Pictures 

• Data displayed in each column 

• Loading plan in small and/or large size on a whole page 

• Picture of the equipment 

• Program descriptions 

• List of excluded data loggers (typically the user would use more loggers than 
required to run a validation test just in case some fail or stand out of the 
metrological specifications. Additional loggers would be then excluded from the 
test to avoid any later questions)  

• Screen shots (if you do not wish to print a screen shot, go to the “Screen shot” 
tab and uncheck “Print in the report”). 

• Logger included in the study: 

o Loggers configuration date 

o Loggers firmware version 

 

 Click on “Print”. 

If you wish to save the report when closing the preview, name the file and click “OK”. 
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8 Mapping Option (setup) 

This function is not included in QLEVER Lite. 

8.1 Prerequisites 

• QLEVER license with: 
o Mapping mode option included. 
o 21CFR secure mode option included or not included. 

• At least one temperature logger. 

• In the case of using a hygrometer, you must: 
o That the workstation is powerful enough to ensure the acquisition of 

hygrometer data reliably and regularly. 
o That the workstation be dedicated to the acquisition of hygrometer data 

during the mapping process. 
o The workstation is on the inverter or the battery is sufficiently charged to go 

to the end of the process. 

8.2 Description of the Mapping setup option 

• The Mapping Setup mode is a QLEVER option in which the starting and reading of the 
data loggers follow a specific protocol that is necessary for the production of a test 
report. Such report will then be described in a Mapping Setup file. 

• In 21CFR mode (secure mode), the rights of the accounts of "operator" type can be 
changed by the Administrator. 

8.3 Steps of Mapping report generation 

• Create a Mapping setup 

• Start the Mapping Process 

• Program and start the loggers  

• Data acquisition inside the equipment  

• Read the loggers in Process mode 

• Print off the Mapping Report from the QLE file. 

8.4 Create or modify a Mapping setup 

• Click on “Setup > New - Mapping”. 

• A setup is a description of a test that will be done with logger(s) in order to create a 
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mapping report. 

• A setup file does not include the recorded data from the loggers. 

8.4.1 Description tab 

This section displays the general Setup information:  

• File name and description  

• Details about the contractor who will handle the validation tests. The name of the 
contractor will be displayed in the header of the report. 

• Details about the location of the test. 
• Check the “keywords” box if you want keywords to be automatically updated if the 

data loggers, channel names, etc. are changed (cf. 5.2 File research by date or 
keywords) 

8.4.2 Settings tab 

This section allows you to describe parameters such as: 

 

8.4.2.1 Temperature Settings 

o Cycles: for every cycle from 1 to 3 (Temperature and humidity) 

▪ Check or uncheck the box to allow the cycle analysis. 

▪ Write the cycle name in the field beside the box. 

▪ Measurement period: cycle minimum measurement period. 

o Temperature settings 

▪ Setpoint Temperature: temperature value set to the controller 
(equipment) in order to obtain the specified temperature during the 
holding time. 

▪ Specified temperature: temperature value that should be obtained 
(desired temperature). Used for the conformity column in the report. 

In the case of a setup saved with an older version of Qlever <2.2.3.0, 
the specified temperature will be equal to the setpoint temperature. 

▪ Maximum permissible error ±:  given with +/- values of limits of the 
max permissible error of specifications. 

• +: upper limit to the specified temperature. 

• -: lower limit to the specified temperature. 

o E.g. +5 °C above and -1 °C below. 

o 999.99 value for disable. 
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▪ Environmental Indicator: equipment related to the control system that 
displays the chamber internal parameters. 

▪ Max. spread: this value will be compared to the measured max. 
spread.  

▪ Stability: this value will be compared to the maximum measured 
stability.  

▪ Homogeneity: this value will be compared to the measured 
homogeneity.  

▪ Maxi temperature: if enable then this value will be compared to the 
measured maximal temperature.  

▪ Temperature indicator: allows you to indicate the position of the 
equipment temperature set point. 

▪ Clean air/Recycled air (rate) 

8.4.2.2 Humidity settings 

▪ Humidity: enable or disable the study. 

▪ Setpoint Humidity: humidity value set to the controller (equipment) in 
order to obtain the specified humidity during the holding time. 

▪ Specified humidity: humidity value that should be obtained (desired 
humidity). Used for the conformity column in the report. 

In the case of a setup saved with an older version of Qlever <2.2.3.0, 
the specified humidity will be equal to the setpoint humidity. 

▪ Maximum permissible error ±:  given with +/- values of limits of the 
max permissible error of specifications. 

• +: upper limit to the specified humidity. 

• -: lower limit to the specified humidity. 

o E.g. +1 %HR above and -1 %HR below. 

o 999.99 value for disable. 

▪ Environmental Indicator: equipment related to the control system that 
displays the chamber internal parameters. 

▪ Max. spread: this value will be compared to the measured max. 
spread.  

▪ Stability: this value will be compared to the maximum measured 
stability.  

▪ Homogeneity: this value will be compared to the measured 
homogeneity.  
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 For other definitions, go to “Preview a mapping setup”. 

 

8.4.2.3 Hygrometer  

H symbol in the loading plan: 

 

With an hygrometer, often at the center of the room, it is possible to generate the dew 
temperature and generate the relative humidity calculated channels Hr1 to Hr8 for all other 
temperature sensors Ts1 to TS8. 

 

▪ Used as reference for the calculated humidity channels: 

• Hygrometer channel are not included in the report calculation. 

• The recording time of the hygrometer will be equal to the 
duration of the logger programming.  

• The recording rate of the hygrometer will be synchronized as 
best as possible depending on the reaction of the device 
(mirror) and therefore be greater or equal to the default value 
of 5 second.  

▪ Type the model name of the hygrometer 
▪ Type the serial number for the instrument 
▪ Type some description 

▪ Value for cjU : calibration expanded uncertainty with k=2 

▪ “Optidew” is the default model for this Qlever version 
▪ Select the COM port number. 

• Important: Don’t select this port (or another calibration probe 
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or equipment) as interfaces in the “Configuration, 
Communication port configuration” menu. 

• Attention the communication ports used by the TMI-ORION 
interfaces are grayed out. 

 
▪ Test: allow testing connection with the hygrometer 
▪ Mirror condition of the Hygrometer 

• Enable: if checked then the mirror condition percentage will be 
compared to the Maximum acceptable at each acquisition. 

• % Maximum acceptable : default value 10% 

• Don’t start if out of the tolerance: if at the start of the process 
the % maximum acceptable is exceeded then the process will 
not start. 
 

8.4.2.4 Duration until reaching recovery 

The mapping module includes: 

• An “Equipment door opening” test to define the recovery time. This test applies to 
temperature (T) and / or hygrometry (H) measurements. 

• A “Power failure” test applied to temperature (T) and / or hygrometry (H) 
measurements. 
 

 It’s advisable to record the dates and times of the events during the recording of the data 
from the window "Timestamp" accessible from the general menu "Windows" of Qlever. 
 Calculation with logger channels and humidity calculated channels. 
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This calculation cannot be combined with the temperature and / or humidity 
mapping cycle study, so fill in the “Temperature” and “Humidity” tab. 
 

• Elements defined manually by the operator: 
 

• Activation or not of the calculation in temperature and / or 
humidity. 

• Value of the setpoint of the equipment in temperature and 
/ or humidity. 

• Minimum and maximum tolerance values in temperature 
and / or humidity. For example, min = 30 ° C and max = 40 ° 
C 

• Description of the type of disturbance (title of the test in 
the report). 

• Beginning date of the test.  
o The date of the beginning’s file is the default value 

• End date of the test 
o The date of the end file is the default value. 

• t1: start time of the disturbance: enter the date or use a 
date that you have located from the graph or the data by a 
marker or other. 

• t2: end of disturbance time:  

• Calculation option with linearization or not. 
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• Percentage of the state of occupancy of the equipment. 

• Results: 
o Maximum duration of the recovery time: if activated 

then the measured duration will be compared to this 
qualification value. If larger then it will be reported in 
red in the report, else in green. If not activated in blue. 
 

• Comparison activated or not (no 
bydefault). 

• Maximum duration until reaching 
recovery t2 t4T in HH: MM: SS in 
temperature. 

• Maximum duration until reaching 
recovery t2 t4H in HH: MM: SS in 
humidity. 

o t1 t3: possibility of displaying the duration "t1 t3T" 
and/or “t1 t3H” in the report (disable by default). 

o Ability to customize the text associated with the 
duration "t1 t3T" and/or “t1 t3H” in the report. 

 
 The date and time created from the “Timestamp” window 
are available by clicking on the "selection" icon to the right of 
the date. 

 
Automatic elements defined by the software: 

 
• t3T: time of the first probe "out of tolerance" in temperature. 

o First logger name in the report 
 
• t4T: return time within the tolerances of all humidity probes. 
• t3H: time of the first probe "out of tolerance" in temperature. 

• First logger name in the report 
 

• t4H: hour of return in the tolerances of all the probes in 
humidity. 
 
The steady state is determined when all probes are in the range 
of tolerance values. 
 t3 or t4 can be manually set or modified by the operator, and 
for t3, the first logger name can be named. 
 
Results in the report and plots on the graph after reading the 
data: 
 
• The period t1 t2, named "duration of disturbance". 
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• The period t2 t4, called "duration until reaching recovery". 
• The recovery time is counted from the end of the voluntary 
disturbance. 
• The recovery time is expressed in minutes.  

 
Logger programming 

• The time interval between two measurements 
must be adapted to the observed phenomenon. 
 
 

If no probe is out of tolerance, the duration until reaching recovery is = 00:00:00. 

8.4.3 Equipment 

This section enables you to enter the details of the equipment used for the test: 

• Equipment ID 

• SOP Protocol 

• Load description 

• Comment  

• Chamber volume  

• Picture of the equipment 

8.4.4 Loggers 

This section enables you to describe the data loggers used for the test. 

• Add or remove the available data loggers. This can be done either automatically by 
browsing the plugged data loggers, or manually by designating each desired data 
logger. 

• Homogeneity calculation requires calibration expanded uncertainty to be mentioned 
for every logger. 

• Calibration expanded uncertainties values cjU with k=2 (default value: any 

modification applies to all loggers in the list): 

o Time 

o Temperature  

o Pressure 

o Relative Humidity  

See “Information related to Mapping report” chapter. 
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 Used sensor for humidity calculation. To calculate the dew point, and generate the 
calculated humidity channels, you must use: 

• One temperature sensor 

• One humidity sensor 

  See Analysis / Humidity calculation / Include in calculations 

 Warning, if “Humidity calculation” is not checked in Analysis tab, this setup column is 
grayed. 

 

For example, for a base pair Tr0 Temperature and humidity Hr0, often at the center of the 
room, it is possible to generate the dew temperature and generate the relative humidity 
calculated channels Hr1 to Hr8 for all other temperature sensors Ts1 to TS8. 

 Not used: option not to use this sensor, ie: 

• The sensor will not appear in the data columns or curves QLE 

• The sensor will not be taken into account in the calculation of setup 

• The sensor will not generate computed columns (unless used in the calculation of 
humidity) 

• The sensor will not be notified in the excluded channel list report 

• The sensor will not be visible on the loading plan 

• The internal channel is automatically unused with a Vacq 

• This feature can be activated before starting the setup (if you do not want to use 
a route once the data read back then since QLE data file, it must be excluded) 

 

 Beyond 70 sensors, the new will be added not visible by default to reduce the graphic 
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processing time and not to obstruct the visibility of the loading plan. 

8.4.5 Programming 

This section enables you to describe the programs that you will be using: 

• Click on “Program” to add one or several programs (cf. 2.3 Program the loggers) 

• Click on “–” to remove a program 

• Click on  for quick program change 

• Click on “+” to assign the desired loggers to each program 

• Click on “–” to remove a logger from a program 

A message at the bottom of the screen will inform you whether a logger is not linked to any 
program. 

8.4.6 Sensor position view tab 

This section enables you to indicate the location of the sensors inside the equipment: 

• You can describe the position for each sensor of the list. 

• Check or uncheck the box located below the column with a pin in the header, to 
display the sensor on the loading plan. 

• Open and choose a loading plan proposed by QLEVER and open a picture you have 
taken. 

• You can move the pins (that represent the sensors) on the loading plan by left-clicking 
and sliding them. 

• Click on the “Printer” button on the loading plan picture to print the loading plan. 

 If any sensor is visible, then the loading plan will not be printed in the report. 

 

You may add 6 additional pictures of the cycle parameters, plus an additional one in 
calculator tape format. 

8.4.7 Analysis tab 

This section enables you to describe the calculations that will be used in the report. 

The results of these calculations depend on the type of cycles. They will be displayed in the 
data analysis, in the window of the data file QLE and in the printed report. 

• Mean Kinetic Temperature (MKT) calculation 

o Check the box to perform MKT calculation 
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o Enter ΔH value 

o Choose MKT unit temperature 

• “Time above” and “time below” calculation in temperature for each cycle: 

o Check the box to perform calculation 

o Enter the threshold value 

o Check the box if you want to check that the total time is between the 
minimum and maximum acceptable time (notified in red in the report):  

▪ Enter the minimal acceptable duration 

▪ Enter the maximal acceptable duration 

 This calculation is with data linearization and is similar to the calculation in 
“Analysis” “Min/Max/Avg”. 

• Humidity calculation (a temperature channel and a humidity channel used as a 
reference for calculated humidity channel, specified on “loggers” tab). 

o Temperature: include in calculations or not 

o Humidity: include in calculations or not 

Include in report calculations:  

• If checked, temperature and/or humidity channel is used for the setup 
calculations (Min, Max, Avg and others) 

• If not checked, the the temperature and/or humidity channel is not used 
for the setup calculations, and the associated column is grayed out in the 
qle data file. 

• If you use a hygrometer: not included in calculations. 

• Do not display the calculated columns until the cycles are defined (not checked by 
default): to avoid calculated columns creation before the cycles are defined. 

 Reduce the computation time 

This option will be deactivated if “Duration until reaching recovery” calculation is 
enabled. 
 

 21CFR: Some settings can be hidden by the 21CFR Administrator. 

8.4.8 Report 

o Cycle designation: cycles name 

o Cycle counter: cycle number. Which does not increment each time a new 
autoclave validation process is started. 

o Conformity: Type whether the report is valid or not. The box “do not display” 
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only appears after loggers data are read. It will prevent you from displaying 
the conformity indication in the report. 

o Top right part of the report can be chosen to be either: 

• Contractor details (logo and address) 

• Comment (a text zone for comments or a specific document 
reference) 

o Comment: entered by the user. 

o For every cycle from 1 to 3: 

▪ Comment: remark entered by the user. To be printed in the report for 
each cycle. 

8.4.9 Save a Mapping setup file 

Click on “Save”. 

For new setup file: 

• Select the TDB folder where you want to save the setup file. 

• Name the file.  

Click on “Ok”. 

8.4.10 Save as… a Mapping setup  

Click on “Save as…” to save a copy of the setup file under a new name. 

• Select the TDB in which you want to save the setup file.  

• Rename the file.  

Click on “Ok”. 

This operation cannot be performed with setup files that were opened from a QLE file. 

8.4.11 How to restart the calculations of the measurement report 
results 

Click on “Calculations" to restart the calculations of the measurement report. 

8.5 Open a Mapping setup file 

Click on “Setup > Open” to open a setup file. 

If you wish to review or modify a setup file that was used to generate a QLE data file, open a 
data file (cf. 3 QLE data files), select a file that was created in Setup mode, then click on “Setup” 
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(on the upper right corner). 

Warning: some modifications will restart the calculations. 

8.6 Start a Mapping Setup 

To start a setup, click on “Setup > Start”. 

Select a setup, then click on the “Start” button at the bottom of the Setup window. 

Starting the loggers in Setup mode is the same process as in standard mode (cf. 2.4 Start the 
loggers) 

The presence of the loggers required in the Setup is verified. 

Start date 

To avoid interpolation of the data, it is not possible to start "Now" with several 
loggers. 

If the acquisition of the data with the hygrometer is activated then the data 
synchronization between the hygrometer and the loggers will only be possible if the 
operator chooses a sufficiently wide start time otherwise the start time will be 
exceeded. 

Options 

Some options such as message display or value display are configurable in user 
preferences. 

 

After starting, the Setup file is copied in a Process file. 

The Process file becomes independent from the Setup file that was used to create it. 

8.7 Read a Mapping Process  

To read the data recorded by the logger in setup mode, click on “Setup > Read”, and select 
the process that you have started. 

Reading the data in Setup mode is the same process as in standard mode (cf. 2.5 Read the 
loggers) 

The presence of the loggers connected, missing and required in the Process is verified. 

If a logger was unable to record data (e.g. due to low battery), you will be proposed to 
exclude it from the data file. 

 Exclude a logger 
To exclude a logger, select this logger and click right, choose “Exclude” or clic on “Exclude” 
button. 

Data file 
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Calculations dedicated to the report issue start as soon as the data file is opened. 

Results can be previewed in the Min/Max/Avg tab.  

The setpoint deviation, the setpoint temperature and the cycle are displayed in the graph.  

8.8 Delete a Mapping Process file 

To delete a process file, click on “Setup > Delete process”. 

Select the Process file in the TDB, right click and select “Delete”. 

Deleting a Process file is irreversible (the file cannot be found in the recycle bin). 

8.9 Cycles definition for the Mapping test report 

Open a data file (cf. 3 QLE data files) and select a file that was created with the Mapping 
Setup mode. 

Click on “Cycle”. 

For every selected cycle in the setup: 

• Check the box to allow the cycle analysis. 

• Cycle start and end dates 

o Enter the start and end dates of the recorded data (both starting and ending 
dates are included). By default, the duration is equal to the setup specified 
duration. 

• Color 

o Select a color for cycle zone boundaries on the graph. 

Icons "zoom" lets you view the start and end of the graph. 

8.10 Exclude a sensor from the calculations and analysis 

To exclude a sensor, click on the column header of the data table. 

8.11 Preview or print a Mapping report  

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, then select and open the 
file in the Report/Mapping directory. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

Click on “Report”. 
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 Choose your print out mode: 

• Save as: allow to save the report in the QLEVER TDB without preview and 
print. 

• Default printer: allow to print on the windows default printer without preview. 

• PDF: allow to export the report to PDF format. 

• Open the preview: allow to see the report before print. 

You may print the following: 

• Parameters 

o Signature 

o Display signature on the first page only 

o Comment on the QLE file 

o The legend 

• Graph with background color 

o Full graph (+10% around the cycles) 

o Graph for each cycle (+10% around each cycles) 

• Pictures 

• Data of every column: 

o Default Data mode  

▪ Printed data description: 

• Only data cycles are printed 

• The data between two cycles are not printed 

• Date and hour column 

• Logger column: 

o Channel color, serial number, physical unit, channel 
name 

o Condensed data on 25 columns with calculation (min., max., avg., max-
avg, avg-min…) 

▪ Choose a Physical property for the statistics (temperature…) 

▪ Adding or not statistics (min., max., avg…) 

▪ Printed data description: 

• Only data cycles are printed 

• The data between two cycles are not printed 

• Title cycle, start date, end date and duration are printed 
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• Date and hour column 

• Logger column: 

o Channel color, channel number, physical unit 

o Statistics for each line: 

▪ Min. value (optional) 

▪ Max. value (optional) 

▪ Average (optional) 

▪ Max. – Min. (optional) 

▪ Avg. – Min. (optional) 

▪ Max. – Min. (optional) 

▪ The hygrometer columns are not taken into 
account in the statistics. 

▪ “H” = Hygrometer 

o Print all lines or one line out of x: 

▪ Hidden data channels are printed in the report. 

▪ Excluded data channels are not printer in the report. 

▪ “H” Hygrometers data channels are printed in the report. 

• Loading plan in small and/or large size on a whole page 

• Picture of the equipment 

• Program descriptions 

• List of excluded data loggers (typically the user would use more loggers than 
required to run a validation test just in case some fail or stand out of the 
metrological specifications. Additional loggers would be then excluded from the 
test to avoid any later questions)  

• Screen shots (if you do not wish to print a screen shot, go to the “Screen shot” 
tab and uncheck “Print in the report”). 

• Min. / Max. / Avg. statistics of Data Analysis tab 

o Setup calculations automatically generated by the setup. 

o User calculations: calculations manually added from “Data analysis” tab, 
button “Modify”. See “Data analysis” paragraph. 

o Page break between each table: if you want to get your report more 
readable, it is possible to separate each Min./Max./Avg. calculation with a 
page break. 

• Logger included in the study: 

o Loggers configuration date 
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o Loggers firmware version 

 

Click on “Print”. 

If you wish to save the report when closing the preview, name the file and click “OK”. 

8.12 Information related to Mapping report 

 

Colors in the report: 

o Important values are a displayed with a gray background. 

o If a value is out of its reference specification it will be displayed with a red 
background as: 

▪ Measured time 

▪ Set point deviation 

▪ Stability and homogeneity 

▪ Time above and time below (temperature only) 

▪ Average column (see conformity below) 

▪ Max temperature if is enable (and see below) 

▪ Maximum duration until reaching recovery if is enable (and see below) 

For each cycle: 

▪ Measurement date: date when measurement was performed. 

▪ Temperature 

o Specified temperature: humidity value that should be obtained (desired 
temperature). Used for the conformity column in the report. 

o Air Temperature: mean of means that are calculated for each temperature 
sensor.  

o Set point deviation = mean of means (air Temperature) – set point 
temperature 

o Indication error: difference between the environment indicator value and the 
mean of means (air Temperature). 

o Mini. Temperature: minimum value of all temperature values. 

o Maxi. Temperature: maximum value of all temperature values. 

o Max. range: Max. of max. – Min. of Min. of the temperature values. 

o Max. spread: maximum temperature difference between the values recorded 
by the loggers, that is continuously calculated during the holding time. 
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o Maximum stability: greater value among stabilities values of each loggers. 

o Stability: maximum temperature difference recorded by a logger during the 
holding time. 

o Homogeneity: difference between the max of means + expanded uncertainty 

mjU and min of mean - expanded uncertainty mjU . 

o Max homogeneity: difference between the max of measured values + 

expanded uncertainty cjU and min of measured - expanded uncertainty cjU . 

o s: standard deviation. 

o MKT: Mean Kinetic Temperature calculation. 

▪ Humidity 

o Specified Humidity: humidity value that should be obtained (desired 
humidity). Used for the conformity column in the report. 

o Air Humidity: mean of means that are calculated for each humidity sensor.  

o Set point deviation = mean of means (air humidity) – set point humidity 

o Indication error: difference between the environment indicator value and the 
mean of means (air humidity). 

o Mini. Temperature: minimum value of all humidity values. 

o Maxi. Temperature: maximum value of all humidity values. 

o Max. range: Max. of max. – Min. of Min. of the humidity values. 

o Max. spread: maximum humidity difference between the values recorded by 
the loggers, that is continuously calculated during the holding time. 

o Maximum stability: greater value among stabilities values of each loggers. 

o Stability: maximum humidity difference recorded by a logger during the 
holding time. 

o Homogeneity: difference between the max of means + expanded uncertainty 

mjU  and min of mean - expanded uncertainty mjU  

o Max homogeneity: difference between the max of measured values + 

expanded uncertainty cjU and min of measured - expanded uncertainty cjU  

o s: standard deviation. 

 

▪ For each measurement unit and logger:  

o A summary including min., max., stability (max-min), mean, standard 
deviation, MKT (Mean Kinetic Temperature), min. and max. dates. 

o Max temperature column in red background if enable and measured 
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temperature is > to the max temperature setup value. 

o Conformity: 

▪ Min <= Average - Expended uncertainty mjU <= Min 

▪ Min <= Average + Expended uncertainty mjU <= Min 

With: 

• Min. = Specified temperature or humidity – Max. Maximal 
permissible error. 

• Max. = Specified temperature or humidity + Min. Maximal 
permissible error. 

▪ Specified temperature/humidity: see setup value. 

▪ Maximum permissible error (MPE): Min. / max. setup values. 

▪ Expended uncertainty with a “non-calculated column” channel 
of a temperature or humidity logger: 

 22
cjjmj uskU +=  

With k = 2; js   = standard deviation; cju   = cjU  / k  

• Expended uncertainty of a humidity channel calculated from 
a temperature and humidity logger with impedance variation: 
see current mapping standard. 

• Expanded uncertainty of a humidity channel calculated from 
a condensation hygrometer: see current mapping standard. 

 

cjU : calibration expanded uncertainty with k=2 (see Setup, 

logger tab). 

▪ Average column in red background if: 

o Avg. - Expended uncertainty mjU  < Specified 

temperature or humidity – Min MPE  

o Avg. + Expended uncertainty mjU > Specified 

temperature or humidity + Max. MPE 
  

▪ For other definitions, go to “Creation of a mapping setup > Settings”. 

8.13 Approve a Mapping report 

This function is available in the secure mode option only and only the Approval users can 
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approve reports. 

There are two possible scenarios: 

• The report file already exists: open the file in “File > Open”, select the file in the 
Report directory and click on “Approve”. 

• The report file is to be created: 

Open a data file (cf. 3 QLE data files) and select a file that was created in setup mode. 

As the cycles have already been defined (cf. 8.9 Cycles definition for the Mapping test 
report), you just need to click on “Approve”. A preview of the report will show up to be 
reviewed or printed off (cf. 3.3.9 Printing). 

If you wish to approve the report when closing the preview, name the file and click "OK”. 
Confirm approval of the measurement report. 

Approved reports are represented by an icon with a “V”. 
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9 Calibration/Adjustment in expert mode 

9.1 Prerequisites 

• For the automated mode, in order to run the calibration hardware with RS232 
interface, the PC should include a minimum number of one or two serial RS232 ports 
with SubD 9 or USB/RS232 convertors. 

• A crossed RS232 cable if the hardware is RS232 

• Microsoft© .NET Framework 3.5 installed or more 

• Command line QLEVER icon: /metrology=1 and /metrology=1 
/caldir=C:\nvacq on the workstation that will read the data files. 

• QLEVER License key: 
o With Expert Mode calibration option 
o TMI-Orion Dongle 

• For the automated mode, the equipment automatic send of data should be 
disabled. 

• Important: If you use temperature and humidity logger, you don’t only adjust the 
temperature! 

• The .cfgcet file corresponding to your logger family. 
 

9.2 Description of the Calibration/adjustment option 

Calibration/Adjustment: 

▪ Temperature 

▪ Humidity 

With the QLEVER Calibration Expert Mode, it is possible to automatically generate 
temperature or humidity step points with direct communication with the calibration 
equipment. The values of the reference probe for each calibration step would be read for a 
specified duration through direct communication with the calibration instrument 
(temperature reference probe). The humidity or temperature values of the reference probe 
and every starting time and dates for every temperature steps are recorded in different files. 
Typing the data manually by the operator is also available in case the calibration hardware 
equipment is not compatible with direct communication. 
With the QLEVER Calibration option, it is also possible to calibrate and adjust the loggers.  
The adjustment applies a transfer function between raw values given by a logger (values I bit 
from the converter) and the measured values in temperature. 
The calibration indicates the gap between the reference values within a comparison 
environment like a calibration bath or drywell and the values given by the logger within the 
same comparison environment. 
When used with the Secure Mode option, a calibration audit trail is created.  
In order to communicate with the QLEVER Software, the calibration must be set to Serial 
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RS232 mode with a suitable communication speed (cf. 1 Hardware configuration of 
supported calibration ). 

9.3 Installation in Expert Mode 

9.3.1 Type of equipment and instruments 

• Bath from Hart®: 7321, 7381 and 73xx, 633x, Micro-Bath 6102, 7102, 7103. 
• Bath from Lauda®: RC20, RC25 and Proline series. 
• Hart® Scientific (Fluke) 9172, 917x and Fluke 914x 
• Hart® Micro-bath 6102 (Fluke) 
• Hart® Dry well temperature calibrator 9127 (Fluke). 
• Fluke® 9190A (ultra-cool dry-block calibrator) 
• Jofra® (Bath Mode et Dry-Block Mode) RTC-158, RTC-159 

• CTS®  
• Votsch® VT serie (address 1) 
• THUNDER SCIENTIFIC® 2500 et 2900 (equipment and probe) 
• Optical Mitchell® (equipment and probe) 

• Votsch® VC serie (address 1)  
• Envirotronics® LH serie (address 1) 
• Cabinet/Optical Mitchell® S904 (Optical in probe and equipment must be selected) 
• Sika® TP Solid, TP premium (micro-bath TPM255S, TP37166E.2, TP17650,… ) 
• Wika® (micro-bath CTB9100) (Choose Sika in the Qlever list) 

 
• Readout from Hart®: 1502A, 1529 and Black Stack 1560 (with the 2560 module). 
• Readout from AOIP®: PHP601 and PHP602 (reference probe on the channel 1/A). 
• Readout from Fluke®: 1521, 1523 and 1524 

• Jofra® probes 

• Optidew Mitchell® Series 97430 and Modbus Series 401,501,… 

• Rotronic® et RotronicNT® Hydrolog probes 

• RH Systems® Dew point mirror 473 probe  
 
If you want to communicate with an equipment via a RS232 serial port, you have to configure 
communication with suitable options described in section Hardware configuration of 
supported calibration . 
 
Important notice: 

• Only turn the calibration bath on when it contains the heat transfer fluid. 
• For Hart baths with refrigeration group, properly commute both switches (on/off 

switch and the Cooling switch). 
• The calibration instrument must set with no auto power off (auto shutdown OFF) and 

without stamp data (no automatic data transfer via RS232). 
• For Jofra®, select the type of the set point probe. 
• For Votsch® or Envirotronic®, the adresse is 1 (OP3 = 1 in menu) 
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• For OPTIDEW® Series 97430 in automated mode: 
o Display *REMOTE MODE* 

• For OPTICAL® (old series) in automated mode: 
o Optical in probe and equipment must be selected with the same port 
o Display *REMOTE MODE* 
o REMOTE COMMS ON 

• For SIKA®, use the cable provided by SIKA®. 

9.3.2 Description of the calibration/adjustment process 

• Temperature Step Setting: 
o Description of the hardware that would be used for the 

calibration/adjustment 
o Selection of the automated mode for the hardware 
o Define the temperature/humidity setpoint and the measurement duration 
o Create the DEFPAL+ file 

• Programming and starting of the dataloggers under test. 
• Temperature Step Generating: 

o When in the automated mode, the sequence of setpoints would be generated 
automatically. 

o When in the manual mode, the operator would need to type the values 
displayed by the temperature/humidity calibration instrument.  

o Create a GENPAL+ file. 
• Stop and read recordings from the dataloggers: 

o As found for the calibration before adjustment 
o Adjustment for the adjustment 
o As left for the calibration alter the adjustment 

• The Step analysis: 
o Analyze the results from the temperature/humidity steps 
o Print a calibration report before adjustment 
o Adjust the logger(s) if necessary and print a calibration and adjustment report. 

9.4 Step Settings in expert mode 

Click “Logger > Calibration > Step Settings (Expert Mode)” or open or create a new DEFPAL+ 
file from the Directory Management (TDB). 
 
Select the calibration Mode: 

• Temperature 
• Humidity 

Description tab 
• Shows the name of the DEFPAL+ file 
• Shows the comments like description of the file or the protocol 

 
Configuration tab 
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Settings: 

o Minimum temperature, maximum temperature, Standard deviation (max.):  

▪ These values are the range of the set points. 

▪ These values would be controlled while step generation process to 
ensure the measurement validity. 

o Relative Humidity (min.), Relative Humidity (max.), Standard deviation (max.): 
same 

Time: 

o Choose the QLEVER measurement time: 

▪ System clock 

▪ External USB clock (better precision) 

 
Beginning of the stabilization time  
Once the setpoint temperature is reached, you may wait for the temperature to be stable 
within a defined tolerance band before the stabilization time can start. 
Such process guarantees the measurement reliability (since the equipment temperature 
probe is read, this process is activated in equipment automated mode only). 
e.g.: If an overshoot occurs at a 50 °C plateau, the temperature will slowly decrease in case 
the cooling mode is not activated. If such duration (when temperature is decreasing) is 
longer than the stabilization time, measurements will be made although the temperature is 
not fully stable. 
 
Parameters: 

• “After” n seconds: time delay before the software starts and checks the 
temperature value is included in the tolerance band. This parameter must 
be set according to the equipment performances. 

• Tolerance ±: after such time delay, the software checks and waits for the 
equipment temperature to be within this tolerance band. 

• Stabilization time phase 
 When it comes to automated calibration equipment, when 
activated, a test is performed during the stabilization time phase. Such 
test verifies that the temperature of the calibration equipment stays 
within the tolerance. In case the value would be outside the tolerance. 
 
o Start over if out of the tolerance: if checked the software would 

start the Beginning of the stabilization time procedure as well as 
the stabilization time that follows. 

 
 To disable this checking process, type “0” second in the “After” field. 
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It is not advisable to use this checking process in Humidity because a climatic chamber takes 
a long time to stabilize in temperature. 
 
Humidity stability control during the measurement time 
The purpose of this parameter is to ensure that the steps analysis found a measuring time to 
comply with a tolerance parameter. If the read value is out of tolerance, then the software 
will repeat at the beginning of the measurement time. 
Parameters:  

• Enable / Disable (disable by default): enable or not this control. 

• Start over if out of the tolerance: if checked, when a value is out of tolerance 
range, then the software will restart the measurement time. 

• Tolerance: maximum tolerance value of the standard probe. 

• Waiting time if out of tolerance (sec): wait time before restart the 
measurement time. 

• Time out (sec): this parameter avoids staying in loop if “the start over if out 
the tolerance” is activated.  

 
Hardware tab 
Calibration equipment: 

▪ Type the model name of the calibration equipment (could be a calibration 
bath, drywell, climatic chamber, oven, etc.). Such information will be 
displayed in the calibration report. 

▪ Type the serial number of the calibration equipment. Such information will be 
displayed in the calibration report. 

▪ Type a description : allows to record any information that the operator would 
like to flag. 

▪ If automated mode is checked, select the model from the list. 
▪ Select the COM port number: drop-down menu allows to select the serial port 

the device is connected to. 
▪ Important: Don’t select this port (or another calibration probe or 

equipment) as interfaces in the “Configuration, Communication port 
configuration” menu. 

▪ Attention the communication ports used by the TMI-ORION interfaces 
are grayed out. 

▪ The Cooling mode checkbox is used to optimize the cold unit management for 
FLUKE or HART SCIENTIFIC baths. 
▪ Threshold: determines the “cooling mode”. Il the Threshold value is 

lower than the value ot the setpoint, then the “cooling mode” is 
“Auto” else “On”. Default value = 50°C. 

When on automated mode, the cold unit of these baths is not triggered above a 
certain threshold.  
If the setpoint temperature of the step to be performed is higher than that of the 
previous step, and the setpoint temperature is very close to the default trigger 
threshold of the bath cold unit, it may take a very long time for the bath to reach 
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its setpoint temperature. To solve this problem, a new trigger threshold may be 
set for the cold unit in the Threshold text field. 

 
Standard probe tab 
Calibration standard probe: 

▪ Type the model name of the calibration instrument (reference probe). 
▪ Type the serial number for the instrument 
▪ Type some description 
▪ If automated mode is checked, select the model from the list. 
▪ Select the COM port number. 

▪ Important: Don’t select this port (or another calibration probe or 
equipment) as interfaces in the “Configuration, Communication port 
configuration” menu. 

▪ Attention the communication ports used by the TMI-ORION interfaces 
are grayed out 

▪ Select the channel number if more than one 
▪ Select the protocol of communication. 

 
Test button 
Click Test to test the communication with the equipment and instrument (automated 
mode only). 

 
Steps 
From the Step sheet of the Step Settings Windows, select the number of Steps and type the 
details for each step: 
Temperature tab 

• Step Numbers is displayed in the list 
• Type the temperature set point 
• Type the duration for the stability 
• Type the duration for the measurement 
• The Type column allows to set the step type. This can be: 

o A calibration before adjustment step: As found 

o An adjustment step: Adjustment  

o A calibration before adjustment step that will also be used for adjustment: As 

found + Adjustment  

o A calibration after adjustment step: As left; 

o A step that allows to reach a lower temperature than that of the first 

calibration after adjustment step, between the adjustment step and the 

calibration after adjustment step: Hysteresis. Note: No measurement will be 

taken with this type of step. 
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The Hysteresis free step number (no sampling) text field is used to define the 

hysteresis step. 

The First verification step text field is used to define the number of the first 

calibration after adjustment step. 

Note: The only possible steps before the hysteresis step are "As found", 

"Adjustment" and "As found + Adjustment" steps. The only possible steps after the 

hysteresis step are "As left" steps. 

“When the process is over, reset the equipment to” text field allows to define the 

temperature at which the calibration bath or oven should be reset at the end of the 

calibration cycle. 

 

Humidity tab 
• Step Numbers is displayed in the list 
• Type the temperature setpoint 
• Type the duration for the stabilization time in temperature 
• Type the humidity setpoint 
• Type the duration for the stabilization time in humidity 

o The stabilization time total= stabilization time in temperature + the 
stabilization time in humidity. 

• Type the duration for the measurement 
• The Type column allows to set the step type. This can be: 

o A calibration before adjustment step: As found 

o An adjustment step: Adjustment  

o Waiting the stability step: to avoid saturation in humidity 

o A calibration after adjustment step: As left 

The total stabilization time = temperature stabilization time + humidity 

stabilization time. 

• “When the process is over, reset the equipment to” text field allows to define the 

temperature and humidity at which the calibration bath or oven should be reset at 

the end of the calibration cycle. 

 

• Stop allows to stop the humidity equipment when the process is over. 
Except in special cases, it is advisable to leave this value unchecked to avoid 
damaging the sensors of the recorders if the door of the equipment remains closed at 
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the end of the process for a long time (Default value = no). 
 
The unit for the duration for the stability is minutes. It is the elapsed time before any 
measurement on the temperature step. Once the temperature of the bath or any other 
equipment equals the set point, the measurement will start after the stability duration. This 
duration allows perfect stability and homogeneity before measurement. Default duration is 
set to 30 minutes 
The unit for the duration of the measurement is minutes. It is the duration for which the 
calibration instrument like the reference probe will be recorded (after stability). Default value 
is 3 minutes. 
When no automated standard probe mode, in case you prefer one single reading of the 
standard probe at one chosen moment, select Measurement date from the list. 
 
To add or remove steps, modify the number of steps from the list using the selection box on 
the top of the window. 
Example of a Step Setting temperature: 
 

# Step (°C) 
Stability 

duration (min) 
Measurement 
duration (min) 

Type 

1 0 30 3 As found + Adjustment 

2 30 30 3 As found + Adjustment 

3 60 30 3 As found + Adjustment 

4 90 30 3 As found + Adjustment 

5 120 30 3 As found + Adjustment 

6 140 30 3 As found + Adjustment 

 

General (TDB) 
Settings 

This tab contains "safety" parameters that allow to stop the calibration cycle. 

• The Time out after (seconds) text field is used to enter the time after which 

the calibration process will stop if the calibration bath or oven cannot reach 

its set point temperature, if the Fin process Time out (Temperature) [End 

process if Time out (Temperature)] checkbox is checked. 
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Configuration CFGCET tab 

  

The CFGCET files contain the parameters required by QLEVER to run the calibration and 

adjustment processes, update the configuration CET files and create the calibration 

certificates in automated mode. 

They are specific to each type of logger. 

They contain the following information:  

▪ Uncertainty by quantity (e.g. 0.10 °C, 3.5 % RH…).  

▪ Maximum acceptable error by quantity.  

= Thue value (standard proble) – Read value (logger) 

▪ Note: A warning appears in the result tables if the logger's error 

exceeds the maximum acceptable error. This warning will not appear 

on the calibration certificate. In setup mode, if error > this value then 

adjusts the logger. 

▪ Maximum acceptable deviation (max-min) on a measurement step (in 

units and points). 

= Max. read value – min. read value 

▪ Note: if the measurement performed by the logger exceeds the 

maximum acceptable variation, the line corresponding to this 

measurement is highlighted in red in the result table. 

▪ Thermocouple (or not). Don’t check if it’s the thermocouple internal channel.  

A table with all the data required by QLEVER to adjust a logger (and update its CET file 

accordingly): 

• The 1st column indicates the CET file method number. 

• The 2nd column indicates its method name. Warning: the name is for information 

only, as when a logger is adjusted, no new CET file is created by the old file is 

amended. This means that the method coefficients only are changed. The original 

method name is retained.  
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• The 3rd column indicates which methods are displayed and their display order (-1 

(for a cetx) ou 254 (for a cet) = non-displayed channel). 

• The 4th column is used to indicate which channels are to be calibrated. Numbering 

starts from 0 (-1 (for a cetx) or 254 (for a cet) = ignore channel). 

• The 5th column is used to indicate which channels are to be adjusted. Numbering 

starts from 0 (-1 (for a cetx) or 254 (for a cet) = ignore channel). 

• The 6th column is used to indicate the channels that will be found by QLEVER in the 

QLE data file. Numbering channel starts with 1, not 0. 

• The 7th column allows to enter the sensor name.  

This is displaying is the report. 

Loggers tab (calibration setup mode) 

The loggers tab is used for enabling the “Calibration Setup”. 

 Temperature Only. 

 Particularly intended for FullRadio recorders. 

 Do not add loggers from different families, for example, picovacqs with nanovacqs, or 

classic FullRadios with “temperature compensated” FullRadios. 

The “Calibration Setup” mode is a QLEVER option that features an automated flow of tasks 

including step settings, starting of the loggers, reading of the loggers. All tasks leading to 

calibration and adjustment jobs. 

The tasks of such Setup mode are: 

➔Step Settings  

➔ Process creation 

➔ Start of the loggers 

➔ Step Generation “As found/Adjustment” 

➔ Stop de loggers  

➔ Reading the loggers  

➔ Saving the data QLE file 

➔ Step analysis for calibration and adjustment if necessary (< Maximum acceptable error) 

➔ Report 

➔ Start of the loggers 

➔ Step Generation “As left” 

➔ Reading the loggers 

➔ Saving the data QLE file 
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➔ Step analysis for “As left” 

➔ Report 

➔ End of Step Generation  

Check “Activate” box so such function can be used. 

Setup Mode Settings 

▪ Start the loggers box checked means that the start of the loggers will be performed 

automatically with the Step Generation. 

▪ Wait the logger start date 

If checked (by default): 

• Start the loggers 

• Wait for the logger start time 

• Equipment configuration 

• Send the first Set point 

• Wait the stabilization time of the equipment 

If not checked: 
• Start the loggers 
• No Wait for the logger start time 
• Equipment configuration 
• Send the first Set point 
• Wait the stabilization time of the equipment and the loggers start time 

▪ Reading of the loggers box checked means that the reading of the loggers will be 

performed automatically with the Step Generation. 

▪ Step analysis box checked means that the Setup will include the Step analysis. 

o As found: means that the Setup will perform calibration with the edition of a 

report. 

o Adjustment: means that the Setup will adjust the logger with error greater 

than the max (in the As found). Error set in the CFGCET file downloaded from 

the field located further down. 

▪ Degree of the polynomial (temperature): in case you would like to use 
a specific degree of polynomial, then you should type a value between 
2 and 4. Otherwise leave the 0 default value and the software will use 
the degree from the previous adjustment job. If is thermocouple, then 
the value must be = 0. 

▪ Always adjust: adjustment whatever error. 
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▪ Incident if > "value": used to determine the case of a "badly inserted 
probe" incident during calibration. 
If the result of the calculation of the error is greater than this "value", 
then the software will notify this anomaly by a message. 
(Default value = 0.5 ° C). 

▪ Probe defective if > "value": used to determine the case of a faulty 
probe or a sensor problem. 
If one of the values of the channel of the logger is> at this "value" then 
the software will notify this anomaly by a message. 
This mechanism will not work with a thermocouple. 
(Default value = 200 ° C). 
 

o As left: means that the Setup will keep the step generation for As Left job 

with edition of a report. 

o Print: allows to set the type of printout for the reports. 

▪ None: no report will be print out (not recommended) 

▪ Default printer: reports will be printed on the default printer. 

▪ Pdf: reports will no printed on pdf format in an external file in QLEVER 

data files directory 

▪ Open preview: reports will be first displayed on a preview window.  

o Check the box “Report: Creating a single file containing all the data loggers” 
to create a calibration/adjustment report including all loggers data and 
standard probe values. And some summary if a detailed report is chosen. 
 This option is only compatible in temperature. 

The table with the list of loggers shows the loggers used for such calibration job. 

▪ Add or remove the available loggers. This could be automatically searching all 

connected loggers or manually by selecting individual loggers.  

Configuration CFGCET 

o Type the name of the CFGCET file corresponding to the family of chosen loggers (se 

General, Configuration CFGCET) 

Programming tab (calibration setup mode) 

This section enables you to describe the programs that you will be using: 
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• Click on “Program” to add one or several programs (cf. 2.3 Program the loggers) 

• Click on “–” to remove a program 

• Click on  for quick program change 

• Click on “+” to assign the desired loggers to each program 

• Click on “–” to remove a logger from a program 

A message at the bottom of the screen will inform you whether a logger is not linked to any 
program. 

Save 

Click Save to save the DEFPAL+ file. 

9.5 Step Generating in expert mode 

Prerequisites: 
• A Step Setting .DEFPAL+ file should exist. 
• If no setup mode, the dataloggers should be programmed and already started (cf. 2.3 

Program the loggers). 
o The rate is generally between 5 and 10 seconds. 

• The dataloggers should be placed inside the calibration equipment. 
• Switch the calibration equipment on. If this is a calibration bath, it should only be 

switched on when filled with calibration fluid. Commute the cooling mode switch. 
Switch the temperature instrument on and put it inside the calibration equipment. 

• Make sure the computer is NOT synchronized with an external clock (network, 
internet time server...) during the calibration process. 

• With an automated standard probe, the loggers MUST be started on the computer 
which runs the step generation (otherwise the measurement start dates of the 
loggers and the standard probe will be out-of-sync). 

In setup mode, you should type the settings report (Steps analysis, Settings tab, Report tab) 
 
Automated equipment and the standard probe mode: 

• The QLEVER software can automatically generate the calibration steps. 
• Once the hardware is ready, confirm the start of Step Generation. 
• For every step, the QLEVER Software communicates with both the equipment and 

instrument to generate step, and reach the set point temperature. Measurement 
starts when the equipment temperature is stable. 

• The measurement frequency of the standard the standard probe varies from 3 
seconds to 9 seconds depending on the brand and model of connected standard 
probe connected. 

• Every step for such process is displayed real time on the screen. 
• Values measured by the standard probe are displayed real time in the “Standard 

probe” tab. 
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▪ Description of stages:  
o Click on “Logger/Calibration/Step generation” menu, open the step settings 

DEFPAL+ file and confirm by clicking “Yes”.  
o QLEVER configures the standard probe in automated mode.  
o QLEVER configures the equipment in automated mode.  
o For each step :  

▪ QLEVER sets the equipment to set point temperature.  
▪ QLEVER starts the stabilization time countdown.  
▪ QLEVER records values from the automated standard probe during the 

measurement period.  
▪ Once the measurement period is completed, QLEVER calculates the 

mean, min., max. and standard deviation. 
o End of step generation. 

 
Note: When the stabilization time ends, the measurement starts, so both dates must be 
equal. 
 
Automated equipment and manual standard probe mode: 

• For every step, the operator should type the exact start date for the first temperature 
readout together with the average temperature value given from all the values taken 
during the measuring duration. 

• Min., max. and standard deviation values entry is optional. 
• Click “Save” for recording. 
• Description of stages:  

o Click on “Logger/Calibration/Step generation” menu, open the step settings 
DEFPAL+ file and confirm by clicking “Yes”.  

o QLEVER configures the equipment in automated mode.  
o For each step :  

▪ QLEVER sets the equipment to setpoint temperature.  
▪ QLEVER starts the stabilization time countdown.  
▪ Wait until the stabilization period ends.  
▪ QLEVER displays “Reading in progress”.  
▪ Click “OK” and note the values measured by the manual standard 

probe.  
▪ QLEVER starts the measurement period countdown.  
▪ Once the measurement period is completed, calculate the mean of 

your measured values. Place it in the appropriate step line in QLEVER 
“Standard Probe” tab.  
Min., max. and standard deviation values entry is optional. 

o End of step generation.  
o Click on “Save”. 

 
Manual equipment and automated standard probe: 

• The operator should synchronize the software with the equipment to get the same 
stabilization time. 

• Description of stages :  
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o Click on “Logger/Calibration/Step generation” menu, open the step settings 
DEFPAL+ file and confirm by clicking “Yes”.  

o QLEVER configures the standard probe in automated mode.  
o For each step :  

▪ QLEVER displays the message “Put the set point of the equipment to 
x °C”  

▪ Set your equipment to the requested set point temperature.  
▪ Go back to QLEVER, then click “Yes”.  
▪ QLEVER starts the stabilization time countdown.  
▪ Once the stabilization period is completed, QLEVER starts recording 

values from the automated standard probe.  
▪ QLEVER records the values during the measurement period.  
▪ Once the measurement period is completed, QLEVER calculates the 

mean, min., max. and standard deviation. 
o End of step generation. 
 

Manual Equipment and Standard Probe mode: 
▪ The operator should monitor the set point temperatures and stabilization times of his 

equipment. 
▪ The user MUST note the first measurement exact start date from the computer clock, 

or synchronize the probe time with the computer clock (otherwise the measurement 
starts dates of the loggers and the standard probe will be out-of-sync). 

▪ For every step, the operator should type the exact start date for the first temperature 
readout together with the average temperature value given from all the values taken 
during the measuring duration. 

▪ Min., max. and standard deviation values entry is optional. 
▪ Click “Save” for recording. 

▪ Description of stages:  
o Click on “Logger/Calibration/Step generation” menu, open the step settings 

DEFPAL+ file.  
o QLEVER displays the steps table  
o For each step:  

▪ Set your equipment to the requested set point temperature.  
▪ Wait until the stabilization period ends.  
▪ From then and during the measurement period, note the values 

measured by the manual standard probe.  
▪ Once the measurement period is completed, calculate the mean of 

your measured values. Place it in the appropriate step line in QLEVER 
“Standard Probe” tab.  

▪ Min., max. and standard deviation values entry is optional. 
o End of step generation.  
o Click on “Save”. 

 
The data is recorded in a Step Generating GENPAL+ file. The name of the file is just the same 
as the Steps Setting DEFPAL+ file that was previously selected. 
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9.6 Steps Analysis in expert mode 

Calibration and/or Adjustment can be done using the window based on the earlier GENPAL+ 
Step Generating file. 
Prerequisites: 

• One or more existing GENPAL+ Step Generating files. 

• When in the automated mode, the dataloggers should have been stopped and with 
data downloaded within a QLE file in as found mode, adjust mode or as left mode. 

• Is not possible to calibrate or adjust different type of loggers in the same time 
because only one CFGCET can be loaded. 

• Excluded QLE channels are not used. 

• Important: If you use temperature and humidity logger, you don’t only adjust the 
temperature! 

• Remote compensated temperature recorders must be read again in “Adjustment 
(thermocouple)” mode (to have the temperatures in values). 

 
Click “Logger > Calibration > Steps Analysis (expert mode)”. 
For each step: 

• The value for the calibration instrument is the reference value. 

• The value from the channel f the data logger to be calibrated/adjusted is the readout 
value. 

• The error is the difference between both the above values. 

9.6.1 Files 

1 Choose a type:  

“As found”, “Adjustment” or “As left”. 
(“All” is only for all preview type) 

 
2 Open a Step Generating file. 

• Select one or more GENPAL+ Step Generating files 

• For every file, the table will show the name of the file and the GUID, the name of the 
equipment, the name of the instrument and for every step, the date of the 
measurement, the duration of the measurement as well as the readout. 

• Click “–” to remove a step from the list 

3 Select the CFGCET file corresponding to the logger(s) to be calibrated. 

If missing, ask to TMI. 
4 Open a QLE data file 

• Select one or more QLE file with recordings from datalogger(s) (Right click on the QLE 
button, open the QLE file in the same directory than the GENPAL+ file). 

• For every file, the table will show the name of the datalogger, the name of the file 
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and the GUID, the start and end date for recording as well as the date for the 
configuration file for the specific logger. 

• Click “–” to remove a logger from the list. 

 In Adjustment, le logger data (pt100,pt1000) are in points (pt). 
5 Report 

• Check the box “Report: Creating a single file containing all the data loggers” to 
create a calibration/adjustment report including all loggers data and standard probe 
values. And some summary if a detailed report is chosen. 

 This option is only compatible in temperature. 
 The default report is only a logger per report. 

 
Validate and check the files selection when clicking “Next”. 

9.6.2 Steps Analysis table in expert mode  

For every datalogger, the table will display: 

• The serial number for the dataloggger. 

• The names of the temperature channels. 

• The values of the temperature steps. 

• The date of the readout from the reference sensor. 

• The average value from the readout of the reference sensor. 
o The average is calculated with unrounded values of the reference sensor while 

the measurement time. 

• The average value from the readout of the temperature channel of the datalogger. 
o The average is calculated with unrounded values of the datalogger channel 

while the measurement time. 

• The error that would be the difference between both above values. 

• The minimum, the maximum, the max-min and the standard deviation of the 
reference sensor. 

• The minimum, the maximum, the max-min the standard deviation and the number of 
acquisitions of the temperature channel of the datalogger. 

• The max spread in temperature (maximum deviation at a given date between the 
value of the channel and the corresponding value of the standard probe). 

o  The value of the channel when this deviation is maximum. 
o  The value of the probe when this deviation is maximum. 
o  Date of the instantaneous difference. 
 In the case where there is no acquisition of the standard probe on the same 
date as that of the channel, the date and the value of the standard probe will be 
interpolated between the value of the previous and next acquisition of the logger.  
Therefore, if you care about this notion of interpolation (or linearization), it is 

preferable that: 
o  The recording rate of the loggers is 1 second per acquisition to reduce the risk 

of interpolation. 
o  The calibration probe must be able to record at a rate of 1 second per 
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acquisition. 
 Only if “Report: Creating a single file containing all the data loggers” is checked. 
 Only in temperature. 
 Only if “Max Spread” is checked in 21CFR secure mode (see Administrator 
operator/approval rights). 

• Polynomial degree. If thermocouple the value is not editable. 
 Only if checked is checked in 21CFR secure mode (see Administrator 
operator/approval rights). 
 
It is possible to select the dataloggers or channels using the box. At this stage, it is not 
possible to remove a temperature step. 

 
From the bottom part of the window, it is possible to: 

• Type the uncertainty of the dataloggers. 

• Check the box so the software selects the channels of the dataloggers related to the 

chosen value in ± °C. This  icon will displayed when the difference between the 
average channel – average probe is greater than the threshold. 

• Check the box to allow export of the data to a text file. 

• Max error is calculated and displayed. 

9.6.3 Edit manually the calibration values 

Click on the column to type or edit the calibration values (not in secure mode): 

• Date and time of measurements. 

• Values of the reference sensor readout. 

• Values of the channel of the logger. 

• Polynomial degree (if thermocouple the value is not editable). 
 

9.6.4 Probe data exportation 

It’s possible to export the standard probe raw data in a file: 

• Select probe tab 

• Right click on the table 

• Export data menu 

• Excel parameters: 

o ; as separator 

o .csv for the extension file 

o Open after saving 

• Click on “Export” button 
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9.7 Generating calibration report 

• Select the datalogger(s) and channel(s) needed for such calibration report. 

• Click “Create the report” 

• Type or edit the various texts for the header of the reports in the Report Settings 
window (cf. 9.9 Settings for the calibration report). 

• Click “Next” 

• Select the folder within the TDB where the reports will be saved. Default folder will 
be “Report\Calibration”. 

• If the “Preview” box was checked, the preview of every calibration report will be 
displayed. Every report can be then printed. 

• If “Detailed Report” box was checked, you can check some parameters (see settings 
for the report” for more explanations). 

• A new window will appear. 

• If the dataloggers need adjustment, then click “Step Analysis” otherwise, click “Exit”. 

9.8 Start the adjustment and create a calibration/adjustment 
report 

Prerequisites: 

• The dataloggers to be adjusted should be connected to the interface. 

• By default, the requested step number for adjustment is equal to the step number. 

• In secure mode, the operator account does not have the rights to adjust. 
In order to adjust: 

• Select the dataloggers that need adjustment (the other dataloggers won’t be display 
anymore). 

• Click “Adjustment” in order to calculate the transfer function and display two new 
columns “Adjustment” that include: 

o The new value given from the adjusted channel. 
o The bias (error) after the transfer function is applied. 

• Click “Continue Adjustment” to confirm the adjustment of the checked dataloggers. 

• Type or edit the various texts for the header of the reports in the Report Settings 
window (cf. 9.9 Settings for the calibration report). 

• Click “Next”. 

• The Adjustment window will appear. 
A no adjustment report will be printed if a logger could not be adjusted for a technical 
raison (eg, low battery, not connected,…) 
 

New configuration files CET can be created so the new transfer function can be calculated 
within every connected datalogger. 
The CET configuration files can be exported. To do so, check the “CET Export” box before 
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clicking “Complete the Adjustment”. The files will be exported to the directory that can be 
configured from the menu “Configuration > Directory Management > External file”. They 
can be later exported from “Configuration > Managing Configuration files”. 
In order to complete the adjustment for every datalogger: 

• Connect the datalogger(s) to the interface. 

• Click “Complete Adjustment”. 

• The calibration/adjustment report will be automatically saved within the 
“Report\Calibration” folder from the TDB or any other chosen directory. 

• Repeat according to the number of loggers and interfaces that you use. 
In order to restore a previous adjustment (cf. 2.1 CET/CETX Configuration files installation). 

9.9 Settings for the calibration report 

Steps analysis, Settings tab, Report tab 
From such window, information for the calibration/adjustment report can be typed for every 
logger. 

• Open Preview: if checked then the preview of the report will be displayed on the 
screen and printing will be possible by clicking on the Printer icon. 

 

• Detailed Report: if checked then an additional page will be printed showing  
o Each step, the date, the name of the operator and the GUID of the used files. 
o Last adjustment date in the first page 

 
▪ For each selected logger: 

▪ Table of average. 
▪ Table of Min. and max.  
 Only if “Report: Creating a single file containing all the data 
loggers” is checked. 

▪ Table of max spread. 
 Only if “Report: Creating a single file containing all the data 
loggers” is checked. 
 Only in temperature. 
 Only if “Max Spread” is checked in 21CFR secure mode. 

 
Comment Display order Explanation of the comment column of the table of temperature max spread 

Faulty probe 1 
 

This error message appears in the report when the value of the 
channel of the logger is > to the value of the field "Faulty probe" 
(entered in the "Step settings" screen, "Logger" tab). 
Displayed only if Setup mode is enabled. 

Incident 2 
 

This error message appears in the As Found, As Left report when the 

error is > to the value of the "Incident" field (entered in the "Step 
settings" screen, "Logger" tab). 
Displayed only if Setup mode is enabled. 

Error > 
+value of 

3 
 

This error message appears in the report where the error is found. 
Same error as in the table of average: the error exceeded the 
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temperatur
e 

adjustment criterion. 

Error > -
value of 

temperatur
e 

4 
 

This error message appears in the report where the error is found. 
Same error as in the table of average: the error exceeded the 
adjustment criterion. 

 

 In the case of a thermocouple, case 1 can not be dissociated from case 2 
because if a thermocouple probe is poorly connected or defective, it will be 
the ambient temperature inside the case that will be measured. 

 
Summery table: 

o Table of max of max spread.  
 Only if “Report: Creating a single file containing all the data 
loggers” is checked. 

o Table of max spread. 
 Only if “Report: Creating a single file containing all the data 
loggers” is checked. 
 Only in temperature. 
 Only if “Max Spread” is checked in 21CFR secure mode. 

 
Switch Contractor or Comment 
Contractor/Place of Calibration: 

• Name, address and phone number of the service company that performed the 
calibration operation. 

Comment: 

• Text of comment 
Logo: 

• Picture: logo of the company to displayed on the top of the report next to the name 
and address. 

Delivered to: 

• Company/Department: Name, address and phone number of the company to whom 
the report is to be delivered. 

• If the operator and service company details are the same, click the arrow button to 
copy the information. 

 If you do not want to print block in the report then do not enter anything in 
"Company/Department" 

• Place: name or place of the calibration lab. 

• Calibration conditions: this is a text describing the conditions of the datalogger 
immersed in the bath. 

• Calibration procedure. 

• Adjustment procedure. 

• Calibration method and comments. 
Empty fields are not printed 
Click “Next” to continue and save the changes for the following reports. 
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In the Error columns, “E” will displayed if the Error is greater than the threshold (see ) 

9.10 Printing a calibration/adjustment from a saved report 

• Open the Directory Management 

• Go to the directory “Report\Calibration” or any other folder chosen for saving the 
reports. 

• Open a report. 

• Click the Printer icon to print the report. 

9.11 Change the text from a saved report 

• Open the Directory Management 

• Go to the directory “Report\Calibration” or any other folder chosen for saving the 
reports. 

• Select a report. 

• Click the “Modify” button. 

• Make the changes and click “Save”. 

• Click “Print” to preview the report. 

• Click the Printer icon to print the report. 
 

9.12 Difference between calibration and calibration expert mode 

 

Functionalities 
QLEVER modules 

Expert Mode  Automated 

Mode  
Manual 

Mode  
Calibration of 

TMI ORION 

Temperature 

loggers 

X X X 

Calibration of 

TMI ORION 

Humidity 

loggers 

X     

Calibration 

equipment 

X X   
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drivers library 

Fully 

Automated 

programming 

and reading 

processes 

X     

Synchronization 

based on 

external clock 

X     

Single and 

multi-loggers 

report 

X X X 

FDA 21 CFR 

Part 21 option 

|secured 

mode)  

X X X 
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Chapter - 4 Appendix 

1 Hardware configuration of supported calibration 
equipment 

Hardware configuration Baud 
rate 

Stop bit Data 
bit 

Parity 

AOIP® (standard probe) 9600 1 8 No 

Fluke® 1502A (standard probe)  2400 1 8 No 

HART® Black Stack 1560 + 2560 (standard 
probe)  

2400 1 8 No 

FLUKE® 1521  2400 1 8 No 

FLUKE® 152x - 1523 and 1524 (Thermometer 
readout)  

9600 1 8 No 

HART® Deep-Well Calibration Bath model 
7341, 7321 and 7381 (Calibration Bath), 9127 

2400 1 8 No 

LAUDA® (bath)  9600 2 8 No 

LAUDA® (bath), TYPE RP3530 (PROLINE)  9600 1 8 No 

HART/FLUKE® Micro-Bath model 6102, 7102 
and 7103 (bath)  

2400 1 8 No 

FLUKE® Well Calibration Bath model 917x 
(bath)  

9600 1 8 No 

Fluke® 9190A (ultra-cool dry-block calibrator) 9600 1 8 No 

CTS® Clima temperature system 
(Adress= 1, CID /ASCII) 

19200 0 8 Odd parity  
Parity bit = 

thrue 

Optidew Mitchell® (Series 97430 et Modbus 
rtu Series 401,501,…) 

9600 1 8 Parity none 
without flow 

control 

VOTSCH® and ENVIROTRONICS® 9600 1 8 Parity none, 
without flow 

control 

THUNDER SCIENTIFIC 2500  
9600 0 8 

Parity none, 
without flow 

control 

THUNDER SCIENTIFIC 2900  
57600 0 8 

Parity none, 
without flow 

control 
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2 Explanation of symbols 

Icon Explanation 

 QLE data file (logger data) 

 Setup Pharma 

 Setup Autoclave validation 

 Setup Washer disinfector validation 

 Setup Mapping 

 Setup Rotation 

 Kiln 

 CET / CETX configuration file or loggers configuration panel 

 Error related to a CET / CETX configuration file 

 
Icon for either a start of the recorders (recording) or a "Process" being 
recorded. 

 

Icon for either a Read of the recorders or read a process. 

If it’s a file of the type "Process": indicates that the data of the recorders of 
this process file were re-read in a data file QLE) or a "Process" being recorded. 

 File opened and locked in reading / writing mode by a user 

 Unlock file 

 RS232 Serial port  

 Serial port (COM / RS232) 

 Serial port (COM / RS232) in error or already used 

 Mono-USB interface, 1 logger 

 Multi-USB interface, up to 6 loggers 

 Multi-USB interface, up to 12 loggers 

 Radio-Frequency interface, wireless 

 Logger / Logger column 

 FullRadio logger 

 Rotation logger 

 FullRadio network 

 Erase memory of selected loggers 

 Full load battery  
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Icon Explanation 

 Low battery 

 User management 

 Audit file of the software or a QLE data file (21 CFR Part 11) 

 Units management 

 Calibration step settings 

 Calibration step generation 

 Calibration step analysis 

 Locked resource or action 

 Computed column / Calculation library 

 Report  

 Approved report 

 Update status of connected loggers 

 Update status of all loggers 

 Stopped logger  

 Stop selected loggers 

 Stop all loggers 

 Start selected loggers 

 Start all loggers 

 Add a logger, a programing, a zone, a file… 

 Remove a logger, a programing, a zone, a file… 

 Error 

 Error 

 In setup mode, exclude a logger  

 Not in use logger’s channel 

 Excluded logger’s channel 

 Information symbol on the logger configuration date 

 Information symbol on the logger configuration date (may be locked in 21CFR) 

 
In Calibration Step Analysis, this symbol is displayed when the error is greater 
than the threshold 

m Minimum (min) 

M Maximum (max) 
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Icon Explanation 

 

Average (agv) arithmetic is the "simply" mean. 

Agv = the sum of the numerical values divided by the number of these 
numerical values. 

s Standard deviation (s or std) 

 Zoom  

 Hygrometer channel 

+++ Indicate that the value is too big 

 Microsoft Windows™ 

 


